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WARRANTY
The Anritsu product(s) listed on the title page is (are) warranted against defects in materials and
workmanship for one year from the date of shipment.
Anritsu’s obligation covers repairing or replacing products which prove to be defective during the
warranty period. Buyers shall prepay transportation charges for equipment returned to Anritsu for
warranty repairs. Obligation is limited to the original purchaser. Anritsu is not liable for consequential
damages.

LIMITATION OF WARRANTY
The foregoing warranty does not apply to Anritsu connectors that have failed due to normal wear. Also,
the warranty does not apply to defects resulting from improper or inadequate maintenance by the
Buyer, unauthorized modification or misuse, or operation outside of the environmental specifications of
the product. No other warranty is expressed or implied, and the remedies provided herein are the
Buyer’s sole and exclusive remedies.

DISCLAIMER OF WARRANTY 
DISCLAIMER OF WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, ANRITSU COMPANY AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE
PRODUCT. THE USER ASSUMES THE ENTIRE RISK OF USING THE PRODUCT. ANY LIABILITY
OF PROVIDER OR MANUFACTURER WILL BE LIMITED EXCLUSIVELY TO PRODUCT
REPLACEMENT.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL ANRITSU COMPANY OR ITS SUPPLIERS BE LIABLE
FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRODUCT, EVEN IF ANRITSU
COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME
STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY
NOT APPLY TO YOU.

TRADEMARK ACKNOWLEDGMENTS
The Bluetooth word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks by
Anritsu is under license.  Other trademarks and trade names are those of their respective owners.
Windows XP and Windows Vista are registered trademarks of Microsoft Corporation.  Acrobat Reader is
a registered trademark of Adobe Corporation.  Windows Visual Basic and Visual Studio are registered
trademarks of Microsoft Corporation.  PESQ related software in this product is protected by copyright
and by European, US, and other patents.  Such software is provided under license from Psytechnics
Limited.

NOTICE
Anritsu Company has prepared this manual for use by Anritsu Company personnel and customers as a
guide for the proper installation, operation and maintenance of Anritsu Company equipment and
computer programs. The drawings, specifications, and information contained herein are the property of
Anritsu Company, and any unauthorized use or disclosure of these drawings, specifications, and
information is prohibited; they shall not be reproduced, copied, or used in whole or in part as the basis
for manufacture or sale of the equipment or software programs without the prior written consent of
Anritsu Company.

UPDATES
Updates, if any, can be downloaded from the Anritsu Website at:
http://www.anritsu.com
For the latest service and sales contact information in your area, please visit:
http://www.anritsu.com/contact.asp

http://www.anritsu.com
http://www.anritsu.com/Contact.asp


BlueAudio - Terms of Product Usage
By using the software, the licensee is agreeing to the following conditions which should be read carefully
prior to use.

Definition of Terms
The software: Computer software and associated files supplied as part of the product.
The media: The CD or DVD on which the software is delivered.
The documentation: All documentation associated with the software, whether printed or in electronic
format.

Copyright
Anritsu Company owns the copyright to the software, which is licensed, not sold.  

License
The software is supplied with a multi-user license and is for use only with the equipment as defined in
the associated documentation.

Company Warranty
The media on which Anritsu Company software is delivered are warranted against defects in materials
and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other
documentation. Anritsu Company will, at its discretion, repair or replace software media that fail to
install onto an approved PC if Anritsu Company receives notice of such defects during the warranty
period.
Anritsu Company warrants that the software will not fail to execute its programming instructions due
to defects in materials and workmanship, for a period of 90 days, when properly installed and used in
accordance with the procedures described in the supporting documentation. Anritsu does not warrant
that the software will operate on PC platforms or operating systems other than those described in the
supporting documentation.  Anritsu Company does not warrant that the operation of the software shall
be uninterrupted or error free.
If Anritsu receives notice of defects or non-conformance during the warranty period, Anritsu will, at its
discretion, repair or replace the affected software. The customer will pay the shipping expenses for
return of such products to Anritsu. This warranty is limited to the original purchaser.
Except as specified herein, Anritsu Company makes no warranties, express or implied, and specifically
disclaims any warranty of merchantability or fitness for a particular purpose.
The customer's right to recover damages caused by fault or negligence on the part of Anritsu Company
shall be limited to the amount originally paid by the customer. Anritsu Company will not be liable for
damages resulting from loss of data or profits, damages resulting from use of products, or incidental or
consequential damages, even if advised of the possibility thereof.
The aforementioned limitation of the liability of Anritsu Company will apply regardless of the form or
action, whether in contract or tort, including negligence. Any action against Anritsu Company must be
brought within one year after the cause of action occurs. Anritsu Company shall not be liable for any
delay in performance due to causes beyond its reasonable control. The warranty provided herein does
not cover damages, defects, malfunctions, or service failures caused by the owner's abuse, misuse or
negligent acts, power failures or surges, fire, flood, accident, actions of third parties, or other events
outside reasonable control.

Trademark Acknowledgments
Adobe Acrobat and Acrobat Reader are trademarks of Adobe Systems Incorporated. db4o and db4objects
are trademarks of Versant Corporation. Microsoft Visual Basic, and Microsoft.Net are trademarks of
Microsoft Corporation in the United States and other countries.





CE Conformity Marking

Anritsu affixes the CE Conformity marking onto its conforming products in accordance with 
Council Directives of The Council Of The European Communities in order to indicate that 
these products conform to the EMC and LVD directive of the European Union (EU).

C-tick Conformity Marking

Anritsu affixes the C-tick marking onto its conforming products in accordance with the 
electromagnetic compliance regulations of Australia and New Zealand in order to indicate 
that these products conform to the EMC regulations of Australia and New Zealand.

Notes On Export Management

This product and its manuals may require an Export License or approval by the government 
of the product country of origin for re-export from your country.

Before you export this product or any of its manuals, please contact Anritsu Company to 
confirm whether or not these items are export-controlled.

When disposing of export-controlled items, the products and manuals need to be broken or 
shredded to such a degree that they cannot be unlawfully used for military purposes.
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Safety Symbols

To prevent the risk of personal injury or loss related to equipment malfunction, Anritsu 
Company uses the following symbols to indicate safety-related information. For your own 
safety, please read the information carefully before operating the equipment.

Symbols Used in Manuals

Safety Symbols Used on Equipment and in Manuals
The following safety symbols are used inside or on the equipment near operation locations to 
provide information about safety items and operation precautions. Ensure that you clearly 
understand the meanings of the symbols and take the necessary precautions before operating 
the equipment. Some or all of the following five symbols may or may not be used on all 
Anritsu equipment. In addition, there may be other labels attached to products that are not 
shown in the diagrams in this manual.

Danger

This indicates a risk from a very dangerous condition or procedure that 
could result in serious injury or death and possible loss related to equipment 
malfunction. Follow all precautions and procedures to minimize this risk.

Warning This indicates a risk from a hazardous condition or procedure that could 
result in light-to-severe injury or loss related to equipment malfunction. 
Follow all precautions and procedures to minimize this risk.

Caution

This indicates a risk from a hazardous procedure that could result in loss 
related to equipment malfunction. Follow all precautions and procedures to 
minimize this risk.

This indicates a prohibited operation. The prohibited operation is indicated 
symbolically in or near the barred circle.

This indicates a compulsory safety precaution. The required operation is 
indicated symbolically in or near the circle.

This indicates a warning or caution. The contents are indicated symbolically 
in or near the triangle.

This indicates a note. The contents are described in the box.

These indicate that the marked part should be recycled.
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For Safety

Warning Always refer to the operation manual when working near locations at 
which the alert mark, shown on the left, is attached. If the operation, 
etc., is performed without heeding the advice in the operation 
manual, there is a risk of personal injury. In addition, the equipment 
performance may be reduced. Moreover, this alert mark is sometimes 
used with other marks and descriptions indicating other dangers.

Warning

When supplying power to this equipment, connect the accessory 
3-pin power cord to a 3-pin grounded power outlet. If a grounded 
3-pin outlet is not available, use a conversion adapter and ground the 
green wire, or connect the frame ground on the rear panel of the 
equipment to ground. If power is supplied without grounding the 
equipment, there is a risk of receiving a severe or fatal electric shock.

Warning

This equipment can not be repaired by the operator. Do not attempt to 
remove the equipment covers or to disassemble internal 
components. Only qualified service technicians with a knowledge of 
electrical fire and shock hazards should service this equipment. 
There are high-voltage parts in this equipment presenting a risk of 
severe injury or fatal electric shock to untrained personnel. In 
addition, there is a risk of damage to precision components.

Warning

Use two or more people to lift and move this equipment, or use an 
equipment cart. There is a risk of back injury if this equipment is lifted 
by one person.

Caution

Electrostatic Discharge (ESD) can damage the highly sensitive 
circuits in the instrument. ESD is most likely to occur as test devices 
are being connected to, or disconnected from, the instrument’s front 
and rear panel ports and connectors. You can protect the instrument 
and test devices by wearing a static-discharge wristband. 
Alternatively, you can ground yourself to discharge any static charge 
by touching the outer chassis of the grounded instrument before 
touching the instrument’s front and rear panel ports and connectors. 
Avoid touching the test port center conductors unless you are 
properly grounded and have eliminated the possibility of static 
discharge.

Repair of damage that is found to be caused by electrostatic 
discharge is not covered under warranty.
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Chapter 1 — General Information

1-1 About this Manual
This manual provides set-up and operational information on the MT8855A Bluetooth Audio 
Test Set and associated BlueAudio user interface software.

Comments on this Manual

Every effort has been made to ensure that this manual is thorough, easy to use, and free from 
errors.  However, to ensure continued improvement, we would welcome your comments on 
this, or any other Anritsu document.

Please contact Anritsu at the address below if you have any comments, good or bad, find any 
errors or omissions, or have any suggestions on how our documentation could be improved 
further.

bluetooth.support@anritsu.com 

Your comments will be logged and reviewed, and whenever possible, will be reflected in a 
subsequent release of the document.

Software Versions

This manual provides details of the operation and functionality of the following firmware / 
software versions:

MT8855A firmware: 1.30

BlueAudio software: 1.30

Follow the procedure below to check the versions of the software in use.

1. Start BlueAudio from the desktop shortcut, or by accessing the Windows programs 
directory and selecting [Anritsu] > [BlueAudio].  

2. Select [Help] > [About BlueAudio] from the BlueAudio menu bar. 

3. Check the MT8855A and BlueAudio version numbers that display in the dialog.

Note
A USB connection with the MT8855A is required in order to display the firmware 
version.  A USB cable is supplied with the instrument.

Note
BlueAudio is supplied as part of the MT8855A product package and can be found 
on the product CD.  Refer to chapter 4 for installation details.
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Notification of Software Release

The MT8855A firmware and BlueAudio software will be updated as new features are added to 
meet market demands.  

To receive automatic notification of each software release, send a blank e-mail with the 
subject heading,  "MT8855A Software Notification Request" to 
bluetooth.support@anritsu.com.  A notification mail will be sent automatically each time new 
software becomes available.

Conventions

The following conventions have been adopted in this manual.

Contacting Anritsu

Anritsu contact information can be accessed from the following link: 

http://www.anritsu.com/Contact.asp

Table 1-1. Notation Conventions

Item Convention

MT8855A The official name of the product detailed in this manual is the 
MT8855A Bluetooth Audio Test Set.  This name has been 
shortened to MT8855A throughout this manual.

DUT The component or product being tested is referred to as the DUT 
(Device Under Test) throughout this manual.

[Anritsu BlueAudio] The titles of BlueAudio windows and dialogs are enclosed in 
square brackets.

"MT8855A Role" Text appearing in windows or dialogs is enclosed in quotation 
marks when used within a body of text.

"Analogue Output" Text appearing on the MT8855A front or rear panels is enclosed 
in quotation marks when used within a body of text.

[Help] > [About BlueAudio] A chevron (>) is used to indicate that the user should select the 
commands or keys in sequence.

The word “select” is used to describe the action of clicking a 
check box to insert a check mark ().
The word “clear” is used to describe the action of clicking a 
selected check box to remove the check mark.

http://www.anritsu.com/Contact.asp
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1-2 Product Description

What is the MT8855A Bluetooth Audio Test Set?

The MT8855A is a test instrument used to perform high-quality audio measurements on 
products using the Bluetooth Advanced Audio Distribution Profile (A2DP), the Headset 
Profile (HSP), or the Hands-Free Profile (HFP).  Module testing is also possible using basic 
SCO/eSCO connections.  The MT8855A is the ideal instrument for design evaluation and 
manufacturing test.  

Typical Bluetooth products that can be tested with the MT8855A include stereo and mono 
headsets, mobile phones, desk speakers, digital media players, car kits, and car consoles.

After establishing a Bluetooth connection with the DUT, the MT8855A’s integrated audio 
generators and analyzers are used to perform measurements that include level, frequency 
response, and harmonic distortion.

MT8855A Features

• 20 Hz to 20 kHz frequency coverage

• Measurement of frequency response, levels, and distortion

• Supports Bluetooth A2DP, Headset, and Hands-Free profiles

• Basic SCO/eSCO connections for module testing

• PC-installed user interface: BlueAudio

• Manual mode for R&D testing

• Auto test mode for production testing

• Audio FFT analyzer

• Integrated audio generator and analyzer

• Direct connection of accessory microphones and speakers

• BlueStart software shows how to use MT8855A class library to develop custom test 
programs

• PESQ and MOS measurements with option 32

Figure 1-1. MT8855A
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What is BlueAudio?

The BlueAudio software can be thought of as the MT8855A’s front panel and is supplied with 
every MT8855A purchased.  BlueAudio is used to configure the MT8855A for testing, specify 
the measurements to be run, and display the measurement results in both graphical and 
numeric form.

BlueAudio Features

• Enables the user to configure the Bluetooth profile, establish a Bluetooth connection, 
configure the MT8855A, and select and define the measurements. 

• Performs both numeric and graphical measurements.

• Provides two modes of operation: “Manual Test”, ideally suited for R&D testing, and 
“Auto Test” for production testing.

• Allows the user to develop a “Test Plan” of multiple test setups that can be saved, 
recalled, modified, and run whenever required.

• Detailed test report available on completion of every test plan.

Note
All data processing and measurements are performed by the MT8855A.  
BlueAudio is a tool to configure the test conditions and read back the 
measurement results for display and analysis.

Figure 1-2. [Anritsu BlueAudio] Main Window
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Optional Accessories

The following items are available as additional cost accessories for the MT8855A.

Table 1-2. Options and Accessories

Number Item

MT8855A-001 Rack mount kit (single) (Refer to Appendix E)

MT8855A-003 Rack mount kit (side-by-side) (Refer to Appendix E)

MT8855A-032 PESQ/MOS measurement option

MT8855A-033 ASTS audio files

MT8855A-332 Retrofit PESQ/MOS measurements

MT8855A-333 Retrofit ASTS audio files

2000-1607-R Standard microphone (including interface cable) (typical frequency 
response calibration data)

2000-1608-R Calibrated microphone (including interface cable) (individually calibrated 
frequency response data)

2000-1612-R Test speaker

2000-1613-R 2.4 GHz antenna and adaptor

MT8855A-098 Standard calibration to ANSI/NCSLI Z540-1 (Certificate of calibration only)

MT8855A-099 Premium calibration to ANSI/NCSLI Z540-1 (Certificate of calibration with 
test report and uncertainty data included)

D41310 Soft carry case



Product Description General Information

1-6 PN: 13000-00280  Rev. D MT8855A Operation Manual



MT8855A Operation Manual PN: 13000-00280  Rev. D 2-1

Chapter 2 — Preparation for Use

2-1 Operating Environment
The MT8855A is designed to function within the temperature range of 5°C to 40°C with a 
maximum humidity of 75% at 40°C, non-condensing. 

2-2 Power Requirements
The MT8855A is operated from an AC power line.  The MT8855A is intended as an 
Installation (Overvoltage) Category II, Insulation Category I device. 

AC Line Power 

The MT8855A operates on AC input power of 85-264 V, 47-63 Hz, 50 VA maximum. The 
MT8855A automatically configures itself to the voltage applied. 

Grounding

The MT8855A must be properly grounded. Failure to ground the instrument could be 
hazardous to operating personnel.  The instrument is properly grounded during AC line 
operation when the plug is connected to a correctly installed three-prong receptacle. 

2-3 Unpacking the Product
1. Inspect the shipping container for signs of damage.  If the container is damaged, or if 

the cushioning material shows signs of stress, notify the carrier and your Anritsu 
Customer Service Center.  Retain the shipping materials for inspection.  

2. Check the contents of the shipment against the list of shipped items (detailed on the 
following page).  Notify your local sales representative or Anritsu Customer Service 
Center if anything appears to be missing or damaged.  Retain all damaged items for 
inspection.

3. Check the instrument for mechanical and electrical operation. If the MT8855A is 
damaged mechanically, notify your local sales representative or Anritsu Customer 
Service Center.  
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Package Contents

The MT8855A is shipped with the following items.  Check that all listed items are present 
and contact Anritsu if they appear to be missing.

2-4 Preparing for Storage
1. Clean the MT8855A prior to storage and pack it using moisture-absorbing desiccant 

crystals.

2. Store the unit in a temperature controlled environment maintained at between 5°C and 
40°C, with a maximum humidity of 75% at 40°C, non-condensing.

Table 2-1. Package Contents

Item Part number Quantity 

Bluetooth Audio Test Set MT8855A 1

Power cord Part number varies.  (Appropriate cable 
shipped for country of order.)

1

Operation manual (hardcopy) 13000-00280 1

Certificate of calibration 1

USB cable for connection to 
PC

2000-1611-R 1

XLR (f) to BNC (f) adaptor for 
line out

553-525-R 2

BNC (m) to phono (f) 553-526-R 4

Product CD containing :- 2300-295 1

BlueAudio software MX885501A 1

Instrument Firmware 69570 1

Audio Tones N/A 1

Operation Manual (pdf) 13000-00280 1

Brochure 11410-00496 1

Data sheet 11410-00507 1

BlueStart software 70499 1

ASTS audio files MT8855A-033 1
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2-5 Preparing for Shipment
1. Wrap the MT8855A to protect the finish.

2. Position the MT8855A in the original shipping container.

3. Insert cushioning material between the MT8855A and the container.  Pack the 
cushioning material tightly but take care to ensure that there is no pressure on the 
Type N RF connector.

4. Seal the container carefully; use shipping tape or an industrial stapler.

5. Return the container to the appropriate Anritsu service center.  The address of your 
local service center can be found at http://www.anritsu.com/Contact.asp.

Note
If the original shipping container is no longer available, use a strong corrugated 
cardboard container that is at least 15 cm larger than the MT8855A.

http://www.anritsu.com/Contact.asp
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Chapter 3 — Instrument Overview

3-1 Front Panel Layout

Figure 3-1. MT8855A Front Panel
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3-2 Rear Panel Layout

Figure 3-2. MT8855A Rear Panel
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Chapter 4 — Installation

4-1 Required Hardware and Operating Environment
The following environment is required to install and run BlueAudio successfully.

• Intel-based PC with Pentium processor or equivalent.

• Microsoft Windows XP or Windows Vista (32-bit) operating systems. 

• English, Chinese, or Japanese language environment.

• CD-ROM drive (if installing BlueAudio from the supplied CD).

• PC display resolution of 1024 x 768 or greater.

4-2 BlueAudio Installation
1. Insert the product CD into the drive on the PC.  The [MT8855A Bluetooth Audio Test 

Set] window displays automatically.

2. Click “BlueAudio” in the contents list.

3. A check is made to verify whether .NET Framework 2.0 is already present on the PC.  If 
detected, the BlueAudio installation begins as shown in step 4.  If not detected, the 
.NET Framework license agreement displays.  Read the license agreement and click “I 
Agree” to run the installation.

4. The BlueAudio setup wizard displays as shown below.  Click [Next>].

Figure 4-1. BlueAudio Setup Wizard
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5. The “Licence Agreement” dialog displays.  Read the agreement and if you agree to the 
conditions select “I Agree” and click [Next>].

6. A dialog displays asking the user to specify the folder to which BlueAudio will be 
installed.  By default, BlueAudio is installed to C:\Program Files\BlueAudio.  Click 
[Next>] to install to the default directory, or click [Browse…] to specify a different 
location for installation.

Figure 4-2. Licence Agreement

Figure 4-3. Install Location
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7. Click [Next>] at the “Confirm Installation” dialog to start the installation.

8. The progress of the installation is shown in the dialog below.

Figure 4-4. Confirm Installation

Figure 4-5. Installing BlueAudio
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9. The dialog shown below displays when the installation is complete. 

Figure 4-6. Installation Complete
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4-3 USB Driver Installation
BlueAudio communicates with the MT8855A by means of a standard USB connection.  The 
MT8855A USB driver must be installed on the PC to enable communication.

1. Install BlueAudio as detailed in section 4-2.

2. Insert one end of the USB cable into the connector on the rear of the MT8855A 
(connector C in figure 3-2).

3. Power on the MT8855A and insert the other end of the USB cable into the PC.  Windows 
detects the connection and displays the New Hardware Wizard.  

4. Click “Install from a list or specific location” and click [Next].

5. A dialog displays for selection of search and installation options.  Browse to the location 
of the “MT8855A.inf” file generated during BlueAudio installation.  By default this file 
is installed to C:\Program Files\BlueAudio\Driver.  Click [Next].

6. The wizard locates the driver and begins the installation.

7. A Windows verification message displays.  Click [Continue Anyway].

8. The USB driver is installed and a message displays when installation is complete.

Note
The USB driver installation is specific to the selected USB port on the PC.  Users 
will need to repeat the driver installation if the MT8855A is subsequently 
connected to any other USB port on the PC.
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Chapter 5 — BlueAudio Overview

5-1 The Main Window
Start BlueAudio by double-clicking the “BlueAudio” icon generated on the desktop during 
installation, or by accessing the Windows programs directory and selecting [Anritsu] > 
[BlueAudio].

The main [Anritsu BlueAudio] window displays.  The main window is split into a number of 
component areas labelled  to  in the figure below.  Each area is described over the 
following pages.

Figure 5-1. [Anritsu BlueAudio] Main Windows
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A: [Manual Test] Tabbed Page

The [Manual Test] tab is ideal for R&D testing during new product development.  It allows 
the user to select the system mode and then define and execute any combination of 
measurements (six numeric measurements, three graphical measurements, and FFT) that 
share a common Bluetooth profile and MT8855A role setting.  Measurements can be executed 
once or in a continuous loop.

Chapters 9 to 18 of this manual explain how to use [Manual Test] to perform measurements 
in a number of different test scenarios.  Each chapter explains how to configure the 
equipment, how to run the tests, and how to interpret the results.

Figure 5-2. [Manual Test] Tabbed Page
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B: [Auto Test] Tabbed Page 

The [Auto Test] tab is primarily targeted at production testing.  It is used to configure, save, 
and run a “test plan” of multiple groups of measurements known as “test cases”.  Each 
component test case within the plan can be configured with any combination of up to six 
numeric measurements.  The Bluetooth profile can be configured independently for each test 
case, allowing the user to run measurements while automatically switching profiles as 
required.  Any of the component test cases or measurements within the test plan can be 
turned on or off as required before execution. 

A full explanation of how to configure and execute an auto test plan is provided in chapter 17.

Figure 5-3. [Auto Test] Tabbed Page



The Main Window BlueAudio Overview

5-4 PN: 13000-00280  Rev. D MT8855A Operation Manual

C: Control Buttons

BlueAudio provides two buttons that can be used to commence testing.

The [Run Once] button runs the selected measurements once before stopping and displaying 
the results.

The [Run Continuous] button runs the selected measurements in a continuous loop until 
stopped when the user clicks [Stop].

D: Graphical Results Display Area

The graphical results display area is used when graphical measurements are run from the 
[Manual Test] tab.  The area houses four results traces, one for each of the three graphical 
measurements (Frequency response, THD+N vs Level, and THD+N vs Frequency), and one 
for FFT.  When more than one trace is enabled, the traces are updated in turn.

Figure 5-4. Control Buttons

Figure 5-5. Graphical Results Display Area

Note
When the user clicks the [Auto Test] tab, the graphical measurements display area 
is replaced with the [Auto Test Output] window for the display of auto test status 
information. Refer to section 17-3 for further details.
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E: Numeric Results Display Area 

The numeric measurements display area is used when measurements are initiated from the 
[Manual Test] tab.  The area houses six display frames, one for each of the numeric 
measurements: Multiple Frequency Level Test, THD+N, THD, SINAD, Stereo Separation, 
and Stereo Phase.

F: Tool Bar

The tool bar at the top of the window provides easy access to some of the more frequently used 
menu commands.

Figure 5-6. Numeric Results Display Area

Note
When the user clicks the [Auto Test] tab, the numeric measurements display area 
is replaced with the [Auto Test Output] window for the display of auto test status 
information. Refer to section 17-3 for further details.

Figure 5-7. Tool Bar
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G: Status Bar

The status bar at the bottom of the main window provides information about the active test 
set and the current status of instrument and measurements.  The status bar is split into five 
areas as shown in the representation below.

Figure 5-8. Status Bar

Note

There are two “Audio Path” states: “None” and “Active”.

Audio Path “None” is used to show that a Bluetooth protocol connection has been 
established but that the audio path is not active.  As an audio path is not active,  
measurements cannot be made in this state for profiles other than A2DP.  If the 
profile is A2DP measurements can be made, as starting the measurement causes 
the audio path to become active.

Audio path “Active” is used to show that there is an active audio path.  Audio 
measurements can be made in this state.
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Chapter 6 — System Modes

6-1 Understanding System Modes
The BlueAudio [Manual Test] tab, introduced briefly in chapter 5, allows the user to select 
from three different modes of operation: Bluetooth audio measurement mode, Bluetooth pass 
through mode, and analogue audio measurement mode.  An overview of each mode is given 
below.

Bluetooth Audio Measurements

The device is tested with a Bluetooth connection between the DUT and the MT8855A, and 
using the built-in audio generator and analyzer.

Using the MT8855A to make Bluetooth audio measurements is explained in detail in chapters 
9 to 16 of this manual.

Figure 6-1. System Mode Selection

Figure 6-2. Bluetooth Audio Measurements
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Bluetooth Pass Through Measurements

In this mode, the MT8855A is used to establish a Bluetooth connection to the DUT, but an 
external analyzer and generator are used to supply the signal and measure the audio 
performance.

Using the MT8855A in pass through mode is explained in detail in chapter 17.

Analogue Audio Measurements

In this mode, the MT8855A serves as a standard audio generator and analyzer with no 
Bluetooth connection to the DUT.

Using the MT8855A to make analogue audio measurements is explained in detail in chapter 
18.

Figure 6-3. Bluetooth Pass Through Measurements

Figure 6-4. Analogue Audio Measurements
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Chapter 7 — Bluetooth Profiles and 
MT8855A Roles

7-1 Audio Testing Methodology
As explained briefly in chapter 5, Bluetooth audio tests can be configured and executed on the 
MT8855A in two ways:

• By using the settings on the BlueAudio [Manual Test] tab to define and execute 
measurements sharing a common Bluetooth profile and a common MT8855A role 
setting.

• By using the settings on the BlueAudio [Audio Test] tab to define and execute a “test 
plan” of one or multiple “test cases” that do not necessarily share a common Bluetooth 
profile or MT8855A role setting.

In both cases, the MT8855A is configured for measurements by selecting the Bluetooth profile 
and role to match the equipment configuration. 

7-2  Understanding Bluetooth Profiles
A Bluetooth profile is an application layer specification defining a minimum set of 
requirements that a Bluetooth device must support in order to communicate with another 
Bluetooth device.

Numerous profiles have now been adopted by the Bluetooth Special Interest Group (SIG), 
each targeted at a specific product grouping or usage.  To use a wireless headset, for example, 
requires a different profile to that used to transfer picture files or send data to a printer.

Any given Bluetooth product may support any number of Bluetooth profiles but, in order to 
connect to another Bluetooth product, both transmitting and receiving devices must use the 
same profile. A Bluetooth headset, for example, will only work with a Bluetooth enabled 
mobile phone if both phone and headset support either the Headset profile (HSP) or the 
Hands-Free profile (HFP).

Each Bluetooth profile also includes information on dependencies with other profiles, 
recommended user interface formats, and details of the particular parts of the Bluetooth 
protocol stack that it uses. 

Three of the Bluetooth profiles deal specifically with the transfer of audio content (voice or 
music) over a Bluetooth connection; these profiles are explained below.  In addition to the 
three profiles, testing can also be performed after establishing a basic SCO/eSCO connection.

A2DP

A2DP, or Advanced Audio Distribution Profile, is used when streaming stereo-quality audio 
content from one device to another over a Bluetooth connection.  A typical usage scenario is 
the streaming of music from a media player to a wireless headset.

Note
The A2DP profile is not available when “System Mode” is set “Bluetooth Pass 
Through”.
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HSP

HSP, or Headset Profile, was designed to enable a Bluetooth headset to communicate with a 
PC or other Bluetooth enabled device such as a mobile phone.  The Headset Profile supports 
simultaneous two-way (full-duplex) audio, but it does not support stereo audio.

HFP

HFP, or Hands-Free Profile describes how a headset or two-way wireless speaker is used with 
a mobile phone. A common use of HFP is in car kits that allow the driver to accept a call via 
the audio system or installed speaker, without the need to touch the phone.

SCO/eSCO Only

SCO/eSCO Only ((Extended) Synchronous Connection-Oriented links) is used to establish a 
Bluetooth connection to the DUT without establishing a connection at the profile level.  No 
profile is used but a basic connection to the DUT is established up to the HCI level.

Note

The HSP and HFP profiles offer identical audio performance but differ slightly in 
functionality.  HSP was introduced first but was superseded by HFP that offered 
greater functionality such as voice recognition and battery level monitoring.  Most 
Bluetooth headsets now default to HFP and there would be no reason for users to 
run tests on both profiles unless HFP was not supported by the device in question.
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7-3 Bluetooth Profiles Within BlueAudio
The Bluetooth profile is selected in the BlueAudio [Bluetooth Profile] dialog.  Full 
explanations of the settings required for each type of testing are provided in chapters 9 to 18.  
The purpose of the information provided in this section is to familiarize the user with the 
settings and their meanings.

1. Start BlueAudio by double-clicking the “BlueAudio” icon generated on the desktop 
during installation, or by accessing the Windows programs directory and selecting 
[Anritsu] > [BlueAudio].

2. Set “System Mode” to “Bluetooth Audio Measurements”.

3. Click [Configure Profile] on the [Manual Test] tab to display the [Bluetooth Profile] 
dialog shown below.

Selecting any of the Bluetooth profiles (A2DP, HSP, HFP, or SCO/eSCO Only) gives the 
user access to two “MT8855A Role” settings.  The setting combinations are shown in 
the table below.  

Section 6.4 provides a number of examples to further explain each profile and its 
associated role settings.

Figure 7-1. [Bluetooth Profile] Dialog

Table 7-1. Bluetooth Profiles and Associated MT8855A Roles

Bluetooth Profile MT8855A Role

A2DP
• Sink

• Source

HSP and HFP
• Device

• Audio Gateway

SCO/eSCO Only
• Analyzer

• Generator
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7-4 Profile and Role Examples

Example 1: A2DP

Example 1 represents music being streamed from a media player to a stereo Bluetooth 
headset. As the originator of the digital audio stream, the media player represents the 
“Source” (specified in the [Bluetooth Profile] dialog).  As the recipient of the audio stream, the 
headset represents the “Sink”. 

Example 2: A2DP and HSP

Example 2 shows a scenario with two Bluetooth enabled products supporting multiple profiles 
and able to switch between profiles as required.

In step 1, music is streamed from a phone to a multi-mode Bluetooth speaker.  At this time, 
the phone is the originator of the audio stream and is therefore the “Source”.  As the recipient 
of the audio stream, the speaker is the “Sink”.  Data is being conveyed in only one direction at 
this time. 

Figure 7-2. Example 1: A2DP Sink and Source

Figure 7-3. Example 2, Step 1: AD2P and HSP 
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In step 2, the user receives an incoming call and presses a button on the speaker to stop the 
music and accept the call.  When the button is pressed, the Bluetooth profile changes to HFP 
or HSP for two-way (full-duplex) communication.  The phone acts as the router relaying the 
incoming signal from the cellular network to the speaker and is therefore the “audio 
gateway”.  Acting as the remote audio input (microphone) and output (speaker) mechanism 
for the audio gateway, the speaker serves as the “Device”.

In step 3 below, the call ends and the user presses the button on the speaker again to 
complete the call.  When the button is pressed, the Bluetooth profile reverts to A2DP and 
music is once again streamed in from the phone.  As before, the phone, as the originator of the 
audio stream, represents the “Source”; the speaker, as the recipient of the audio stream, 
represents the “Sink”. 

Figure 7-4. Example 2, Step 2: AD2P and HSP 

Figure 7-5. Example 2, Step 3: AD2P and HSP 
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Example 3:HSP / HFP

In example 3, an audio signal is being channeled in both directions between a Bluetooth 
enabled phone and a simple mono headset.  Both phone and headset would typically support 
the HSP and HFP profiles, although they would have to use the same profile to communicate.  
In this scenario, the phone serves as the audio gateway by relaying the incoming signal to the 
headset.  Acting as the remote audio input and output mechanism for the audio Gateway, the 
headset serves as the “Device”.

Example 4: SCO/eSCO Only

When testing using a basic SCO/eSCO connection, no profile is active.  In this case the 
MT8855A is used to establish the SCO/eSCO connection to the DUT.  The audio generator 
and analyzer can be used to transmit or receive audio over the Bluetooth connection.

Figure 7-6. Example 3: HSP / HFP

Figure 7-7. Example 4: SCO/eSCO Only
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Chapter 8 — Measurement Overview

The purpose of this chapter is to familiarize the user with the meaning and significance of the 
main audio measurements that can be performed using the MT8855A / BlueAudio.

8-1 Multiple Frequency Level Test
In the multiple frequency level test, the MT8855A measures the audio frequency response of 
the DUT.  Measurements are made at five user-defined frequencies that can be played in 
sequence (“Sequential”) or simultaneously (“Multitone”).  

If the audio is input through one of the front panel connectors (Line or Microphone), the 
signal is digitized by an ADC and fed to the audio signal analyzer.  This is shown in the figure 
below.

Note

The “Multitone” setting has the advantage of being less susceptible to noise 
cancelling algorithms.  

Due to the characteristics of the CVSD codec, the results for the Multitone 
measurement may differ from those of Sequential measurements.

Figure 8-1. Audio Measurement - Analogue
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A single tone can be measured in Volts (typically millivolts) and one tone frequency defined as 
the reference level against which all other frequencies are measured.  In this case, the 
reference tone has units of Volts (mV) and all other frequencies have levels with units of dB 
relative to the absolute value of the reference signal (dBr).

If the audio signal is encoded onto the RF input (as shown in the figure above), it is not 
possible to measure the audio tone level in absolute terms

In this situation, the RF is decoded and the audio signal level is defined in terms of Full Scale 
Deflection (FSD) of the codec in the MT8855A Bluetooth module.  As before, one frequency can 
be defined as the reference frequency and the signal level at all other frequencies measured 
against that frequency.

Figure 8-2. Audio Measurement - RF
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8-2 Total Harmonic Distortion (THD)
Total Harmonic Distortion is a measurement of additional, undesired signals with 
frequencies that are integer multiples (harmonics) of the input signal. 

In the figure above, V1 represents the fundamental signal at 997 Hz. Undesired harmonics 
can be seen at subsequent multiples (f2 to f5).

Harmonics are introduced by non-linearities in the codec or audio circuitry, such as amplifiers 
and filters.

Total harmonic distortion is calculated by dividing the square root of the voltage squares of 
each harmonic (V2, V3, V4, V5) by the voltage at the fundamental (V1).  This can be 
expressed using the formula below.

The number of harmonics sampled in the calculation can be set automatically within 
BlueAudio or can be specified as required by the user.

Figure 8-3. Total Harmonic Distortion
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8-3 Total Harmonic Distortion Plus Noise (THD+N)
For devices with good distortion properties it may be desirable to add the effects of noise to 
the total harmonic distortion measurement to provide a single figure of merit.  THD+N is 
commonly used for this purpose.

The THD+N measurement provides a means of ascertaining the combined effects of 
undesired harmonics and noise on the output signal.  The measurement calculates the ratio 
between the output signal level and the input signal level.  THD+N is calculated using the 
formula below.  THD+N can also be expressed as a percentage.

Figure 8-4. Total Harmonic Distortion Plus Noise
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8-4 Signal to Noise and Distortion (SINAD)
Signal to Noise and Distortion (SINAD) provides another means of comparing the ratio of the 
energy of the input signal to the sum of the energy found in noise and harmonic distortion. 
SINAD provides a convenient measure of the dominance of the desired signal as compared to 
the undesired noise and distortion. SINAD is calculated using the formula below.

 

For historical reasons different industry segments favour the use of the SINAD measurement 
while others may favour THD+N. 

8-5 Stereo Phase
In the stereo phase measurement, a specific tone with equal phase is applied to the left and 
right channel of a DUT.  The stereo phase is calculated by subtracting the phase of the left 
channel from the phase of the right channel. Stereo phase is shown in the figure below by the 
phase angle “SP”.  A stereo phase shift of this nature is likely to be caused by filters in the 
audio path, or by physical differences of the length of the electrical path.

On other occasions the path may appear reflected through 180 degrees as shown in the figure 
below.  This is likely to be caused by incorrect polarity of the audio connectors.

Figure 8-5. Stereo Phase

Figure 8-6. Stereo Phase Caused by Incorrect Connections
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8-6 Stereo Separation
Stereo separation describes signal leakage from one channel to another.  Under ideal 
circumstances, if a signal is fed through the DUT on one channel only, this would appear at 
the output from the DUT, as shown in the figure below.

Occasionally, cross-talk (leakage) may result in a situation such as that shown below.

The amount of stereo separation is calculated using the formula shown below.

Figure 8-7. No Stereo Separation Between Left and Right Channels

Figure 8-8. Stereo Separation from Left to Right Channel
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8-7 PESQ
PESQ (Perceptual Evaluation of Speech Quality) is an automated method of performing an 
end-to-end speech quality assessment for a network. It is also an ITU recommendation: ITU 
P.862. A PESQ algorithm, developed by KPN of the Netherlands and British 
Telecommunications and now licensed by Psytechnics (UK) and OPTICOM (Germany), is 
used to compare a reference audio signal with the corresponding degraded signal. The 
resultant value (-0.5 to 4.5) provides an indication of audio quality as perceived by the user. 
Anritsu offers Artificial Speech-like Test Stimulus files (option MT8855A-033 ASTS audio 
files) that can be used as reference audio signals. Alternatively, the ITU offers freely 
downloadable files from their website, or users can create customized reference test files. The 
advantage of ASTS files is that they have been specially developed to include a full range of 
speech sounds (phonics) in a short period of time. This results in a test that completes in a 
short period with comprehensive coverage of common speech sounds.

The PESQ measurement is an automated and objective assessment of end-to-end speech 
clarity. The ITU provide an algorithm that converts a PESQ score into a Mean Opinion Score 
(MOS). The MOS score was often used before the development of the PESQ algorithm to 
indicate speech clarity. MOS scores are based on subjective results assessed by a group of 
people performing listening tests.     

8-8 Frequency Response
The frequency response curve is generated by sweeping a CW tone between a lower and upper 
frequency limit.  The resultant trace displays the amplitude level response of the system 
under test to the frequency range covered.  Typically the level axis has units of dBr.  The 
reference frequency level is defined as being 0 dBr and all other levels are displayed as gain 
or loss relative to the level at the reference frequency.

8-9 THD+N vs Level
THD+N is commonly used to measure the quality of audio systems.  The THD+N Vs Level 
graph shows the variation of audio quality against the level of the input.  In this graph, all 
measurements are made at the defined reference frequency.  The level of the reference 
frequency is swept over a selected range and the THD+N is measured for each level.

Figure 8-9. PESQ Measurement Algorithm

Note Refer to section 20-16 for details of how to perform PESQ measurements.
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8-10 THD+N vs Frequency
This graph shows the audio quality variations of the system at different frequencies.  In this 
graph the tone frequency (at a given level) is swept across the specified frequency range and 
THD+N is measured for each frequency.

8-11 FFT
The FFT displays the audio spectrum of the received audio signal from the DUT.  Harmonic 
and distortion components can be seen relative to the fundamental audio tone.  The overall 
noise floor is also displayed.

FFT has three modes:

• Both: The FFT is updated for each frequency measured during frequency response,  
THD+N vs level, and THD+N vs frequency measurements.  The FFT is also updated at 
the reference frequency during numeric measurements.

• Numerical: The FFT is only displayed for the frequency set as the numeric 
measurement reference frequency.

• Graphical: The FFT is updated for each frequency measured during graphical response 
measurements but not for numeric measurements.

Chapters 9 to 18 of this manual describe in detail how to configure and run measurements for 
a number of different purposes and DUTs.
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Chapter 9 — Testing a Mono Headset: 
Microphone Input

9-1 Test Overview
A mono headset is a full duplex device allowing audio to pass in both directions at the same 
time. 

The test described in this chapter is used to confirm that an analogue signal can be sent to a 
mono headset, routed through the microphone and codec, and transmitted over an RF 
Bluetooth link (using either the Hands-free or Headset profile) to the MT8855A without 
distortion.

Refer to chapter 9 for details of testing in the opposite direction (audio path of a mono headset 
from RF input to analogue output).

9-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 17.

Figure 9-1. Testing a Mono Headset: Microphone Input
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3. Configure the Bluetooth profile and MT8855A role.

a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” to “HFP”, or to “HSP” if “HFP” is not supported.  (Refer to chapter 6 
for an explanation of the Bluetooth profiles.)

e. Set “MT8855A Role” to “Audio Gateway”.  (Refer to chapter 6 for an explanation 
of the MT8855A role settings.) 

f. Select or clear the "Use Ring" check box as required.  If the check box is cleared 
(the default setting), the incoming call is accepted automatically without the user 
needing to press the call accept button on the headset.  If the check box is 
selected, the user will need to press the call accept button on the headset to 
accept the call.  Selecting the check box would only be required by users 
specifically wishing to test the functionality of the button on the headset.

g. Set “DUT Test Item“ to “Microphone”.  (As we are testing the analogue signal 
transmitted from the MT8855A to the headset microphone.)

h. Select the required “SCO Connection”.  The MT8855A defaults to SCO using HV3 
packets.  The packet type can be changed by clearing the “Use Defaults” check 
box, clicking [Advanced] and selecting a different setting.  All SCO packet types 
are defined in Appendix D.

Note

The following points should be observed to ensure that satisfactory measurement 
results are obtained:

• The DUT should be positioned in a shielded acoustic box.

• The MT8855A should be positioned away from sources of strong magnetic 
fields, power supplies, and CRT displays.

Figure 9-2. [Bluetooth Profile] Dialog Configured for Mono Headset Microphone Testing
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i. Click [OK] when complete.

4. Configure a Bluetooth connection between the MT8855A and the DUT.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the 
documentation supplied with the product.

b. Click  to open the dialog shown below.

c. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

Figure 9-3. [Bluetooth Connection] Dialog

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment.  
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d. Select or clear the "Allow DUT Initiated Connections" check box as required.  
After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

e. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

f. Enter the “Passkey”.  Connection with the DUT will be rejected unless the correct 
passkey specified.  The passkey is typically “0000” but this may differ depending 
on the DUT in question.  Refer to the documentation supplied with the product.

g. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5dBm; for cable connections the output 
power is nominally -40 dBm.

h. Click [OK] to close the [Connection Setup] dialog.

i. Establish the Bluetooth connection.

• If “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If “Address Source was set to a “Inquiry” or “Inquiry + Name”, the button 
beneath [Configure Connection] displays as . Click this 
button to display an [Inquiry Results] dialog, select the required DUT and 
click [Connect].

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Note
As the mono headset does not have an interface from which a Bluetooth 
connection can be established, the initial connection must always be made from 
the MT8855A.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

Figure 9-4. Testing a Mono Headset: Microphone Input

Figure 9-5. [MT8855A] Dialog for Mono Headset Microphone to Audio Gateway Testing
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b. Set “Analogue Output” to “Speaker”.  (As seen in the configuration diagram, the 
left channel speaker output is in use.)

c. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A.  Select “Received Bluetooth Audio” to 
hear the audio signal relayed over Bluetooth from the headset.  Select “Analogue 
Audio Output” to hear the signal sent from the MT8855A to the DUT.

d. Set the monitor “Level” setting to the required volume.

e. Apply speaker correction if required by the speaker in use.  Select “Apply 
Speaker Correction” and click [Speaker Calibration] to display the dialog below.  
Correction is used to compensate for the frequency response of the speaker, 
normalized to the reference frequency.  The level result measurement accuracy 
will be improved if test speaker response calibration data is used.  
Refer to sections 20-10, 20-11, and 20-16 for details.

f. Browse to an existing calibration file or create a new table by adding rows and 
values as required.

Note

When monitoring the signal from a microphone, it may be better to use a headset 
to avoid audible feedback.

To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.

Figure 9-6. Speaker Calibration
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g. Click [OK] to close the [Speaker Calibration] dialog.

h. Click [OK] close the [MT8855A] dialog.

6. Configure measurements.

a. Click  on the [Manual Test] tab to open the dialog shown 
below.

b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997 Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

c. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Four measurements display numeric results only, and three display graphical 
results. 

Figure 9-7. [Measurement] Dialog
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When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

d. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.

e. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.   

f. Repeat steps (d) to (e) for each measurement to be run.

g. Perform PESQ calibration if PESQ measurements are to be run.  Refer to section 
20-16 for details.

h. Click [OK] when complete to close the [Configure Measurements] dialog.

7. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

Figure 9-8. [Limits] Tab
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9-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

9-4 Viewing Test Results
Measurement results display at the right side of the BlueAudio interface.  Graphical 
measurements display at the top and numeric results display in the [Numeric Results] 
window.

9-5 Understanding Test Results

Frequency Response and Multiple Frequency Level Test.

It is standard practice to set the reference frequency to 997 Hz for these tests.  When using 
the Headset or Hands-free profile that mandates the CVSD codec, a typical device interfaced 
to the MT8855A Line audio connectors with cables, will show that other tones within the 
range 300 Hz to 3 kHz are ± 3 dB of the reference tone.

When performing this test using test microphones and speakers, the low frequency response 
is likely to be limited to >500 Hz by the small physical size of the speaker.  This frequency 
response will also be affected by the mechanical coupling between the speaker and the 
microphone.  For the best low frequency response, the headset speaker should be acoustically 
coupled with the microphone directly opposite using a custom test fixture.  If the speaker is 
radiating into open space, low frequency response will be lost.  It is common to see large 
variations in the multiple frequency level test or frequency response curves when using 
microphones and speakers in the test setup.  The flatness of the response can be modified by 
adjusting the distance between the speaker and microphone and by the mechanics of the test 
fixture used to couple the sound between speaker and microphone.

THD+N

For a standard reference tone of 997 Hz, this test will typically show a THD+N measurement 
of > -17 dB when interfaced to the MT8855A Line audio connectors with cables.  Actual 
performance depends on the performance of the audio signal path, amplifiers, and ADC/DAC 
devices.

When using a microphone and speaker in the test configuration, the THD+N performance of a 
typical mono headset using the CVSD codec will be -10 to -20 dB.  It is important to shield the 
test microphone from background noise in the test environment as this will significantly 
degrade the THD+N measurement result.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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THD

For a standard reference tone of 997 Hz, when interfaced to the MT8855A Line audio 
connectors with cables, this test will typically show a THD measurement result of 5 dB better 
than for THD+N.  If the DUT is operating at close to maximum signal level for a CVSD codec, 
the CVSD codec exhibits non-linear behavior.  Under these conditions THD+N and THD will 
give similar results because the 3rd harmonic distortion will dominate the measurement 
result.  Actual performance depends on the performance of the audio signal path including 
amplifiers, and ADC/DAC devices.  The result is expected to be better than THD+N as noise 
is not included in the result.  For this reason, use of the THD measurement alone should be 
treated with caution, as devices exhibiting good THD performance may still exhibit 
compromised audio performance if the noise performance is poor.

THD is degraded if the DUT has poor linearity.  Noise can be added to the audio signal path 
through noisy amplifies or poor schematic layout resulting in the pick up of unwanted signals 
on the audio paths.

When using a microphone and speaker in the test configuration, the THD performance of a 
typical mono headset using the CVSD codec will be 15 to 20 dB.  Background noise in the test 
environment will not degrade the THD measurement result as significantly as is the case for 
the THD+N measurement.

PESQ

PESQ scores lie in the range -0.5 (worst) to +4.5 (best).  

When testing a device using cable connections (from RF test port to RF connector, and from 
the device to the test set audio line input and output), a typical PESQ score would be >4.0. 

The score may be reduced if the digital signal level of the audio connection is set to 0 dBFS 
and the device is optimized for lower digital audio levels.  In this case, reduce the digital 
signal level of the audio sent over the Bluetooth connection and repeat the test.

When testing a device using over-the-air connections (from the MT8855A to the device 
antenna, and acoustic coupling using accessory microphones and speakers to interface to a 
fully assembled headset), a typical PESQ score would be between 2.7 to 3.7. 

The score may be reduced under any of the following conditions:

• If interference from other RF sources results in dropped packets in the Bluetooth 
connection.

• If background noise is picked up by the device or test system microphone.

• If there is frequency response and distortions introduced by the device and test system 
microphones and speakers.

• If the digital signal level is set above the level that the test device is optimized to 
receive.

THD+N vs Level

This test is designed for use during product design evaluation.  It graphically displays the 
usable signal level range of a DUT.  For small signal levels, the THD+N will be limited by 
system noise, and for large signal levels the result will be limited by saturation of the DUT 
input stages.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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THD+N vs Frequency

This test is designed for use during product design evaluation.  It graphically displays the 
distortion within the DUT across a range of audio frequencies.  The frequency range is limited 
to 300 Hz to 1 kHz so that an acceptable number of harmonics can be measured.  At 997 Hz, 
when testing a CVSD device, the number of harmonics measured is limited by the CVSD 
codec to 3.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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Chapter 10 — Testing a Mono 
Headset: Headset Speaker Output 

10-1 Test Overview
A mono headset is a full duplex device allowing audio to pass in both directions at the same 
time.  

The test described in this chapter is used to confirm that an audio signal, transmitted by a 
MT8855A running the Hands-free or Headset profile, can be sent to a mono headset, routed 
through the codec and amplifier, and output from the speaker without distortion.  The output 
audio tone is picked up by a calibrated microphone and fed back to the MT8855A audio 
analyzer.

Refer to chapter 8 for details of testing in the opposite direction (audio path of a mono headset 
microphone input through to the RF output).

10-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 17.

Figure 10-1. Testing a Mono Headset: Headset Speaker Output
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3. Configure the Bluetooth profile and MT8855A role.

a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” to “HFP”, or to “HSP” if “HFP” is not supported.  (Refer to chapter 6 
for an explanation of the Bluetooth profiles.)

e. Set “MT8855A Role” to “Audio Gateway”.  (Refer to chapter 6 for an explanation 
of the MT8855A role settings.) 

f. Select or clear the "Use Ring" check box as required.  If the check box is cleared 
(the default setting), the incoming call is accepted automatically without the user 
needing to press the call accept button on the headset.  If the check box is 
selected, the user will need to press the call accept button on the headset to 
accept the call.  Selecting the check box would only be required by users 
specifically wishing to test the functionality of the button on the headset.

g. Set “DUT Test Item“ to “One Speaker”.  (As we are testing a mono device, rather 
than A2DP headset, there is only one speaker.)

h. Select the required “SCO Connection”.  The MT8855A defaults to SCO using HV3 
packets.  The packet type can be changed by clearing the “Use Defaults” check 
box, clicking [Advanced] and selecting a different setting.  All SCO packet types 
are defined in Appendix D.

Note

The following points should be observed to ensure that satisfactory measurement 
results are obtained:

• The DUT should be positioned in a shielded acoustic box.

• The MT8855A should be positioned away from sources of strong magnetic 
fields, power supplies, and CRT displays.

Figure 10-2. [Bluetooth Profile] Dialog for Mono Headset Speaker Testing
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i. Click [OK] when complete.

4. Configure a Bluetooth connection between the MT8855A and the DUT.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the 
documentation supplied with the product.

b. Click  to open the dialog shown below.

c. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

Figure 10-3. [Bluetooth Connection] Dialog

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment.  
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d. Select or clear the "Allow DUT Initiated Connections" check box as required.  
After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

e. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

f. Enter the “Passkey”.  Connection with the DUT will be rejected unless the correct 
passkey specified.  The passkey is typically “0000” but this may differ depending 
on the DUT in question.  Refer to the documentation supplied with the product.

g. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5 dBm; for cable connections the output 
power is nominally -40 dBm.

h. Click [OK] to close the [Connection Setup] dialog.

i. Establish the Bluetooth connection.

• If “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If “Address Source was set to a “Inquiry” or “Inquiry + Name”, the button 
beneath [Configure Connection] displays as . Click this 
button to display an [Inquiry Results] dialog, select the required DUT and 
click [Connect].

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Note
As the mono headset does not have an interface from which a Bluetooth 
connection can be established, the initial connection must always be made from 
the MT8855A.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

Figure 10-4. Testing a Mono Headset: Headset Speaker Output

Figure 10-5. [MT8855A] dialog for mono headset microphone testing



Preparing to Test Testing a Mono Headset: Headset Speaker Output

10-6 PN: 13000-00280  Rev. D MT8855A Operation Manual

b. Set “Analogue Input” to “Mic”.  (As seen in the configuration diagram on the 
previous page, the microphone cable feeds into the left channel microphone input 
socket.  The left channel is always used for testing mono devices.)

c. Select “Phantom Power On” if required by the microphone in use.  Phantom 
power is a 48 V DC supply used to power capacitor-based microphones.  Select 
“Phantom Power On”  whenever the external microphone connected to the 
microphone input of MT8855A requires DC power.  If selected, the phantom 
power indicator on the BlueAudio status bar changes from red to green.

d. Set “Range” to “Auto”.

The “Auto” setting is suitable for all normal signals under test.  If the signal 
under test has excessive noise the auto range algorithm on the MT8855A may 
fail.  In this case use of the manual range is required.  Refer to section 18-13 for a 
list of the manual range settings.

e. Set the “Bluetooth Digital Output”.

Use the slider to set the Bluetooth digital output to the maximum signal level 
that the device under test is designed to receive.  This will typically be a value 
between -3 and -12 dBFS. 

f. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A.  Select “Analogue Audio Input” to 
hear the signal picked up by the microphone.  Select “Transmitted Bluetooth 
Audio” to hear the signal relayed over the Bluetooth connection from the 
MT8855A to the DUT.

g. Set the monitor “Level” setting to the required volume.

Note
Both of the Anritsu microphones available as optional accessories (2000-1607-R 
and 2000-1608-R) require the use of phantom power.

Note

When monitoring the signal from a microphone, it may be better to use a headset 
to avoid audible feedback.

To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.
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h. Apply microphone correction if required by the microphone in use.  Select “Apply 
Microphone Correction” and click [Microphone Calibration] to display the dialog 
below.  Correction is used to compensate for the frequency response of the 
speaker, normalized to the reference frequency.  Anritsu microphones are 
supplied with a calibration curve (see Table 1-2 on page 1-5 for details).    

i. Browse to an existing calibration file or create a new table by adding rows and 
values as required.

j. Click [OK] to close the [Microphone Calibration] dialog.

k. Click [OK] close the [MT8855A] dialog.

Figure 10-6. Microphone Calibration
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6. Configure measurements.

a. Click  on the [Manual Test] tab to open the dialog shown 
below.

b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

c. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Four measurements display numeric results only, and three display graphical 
results. 

When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

Figure 10-7. [Measurement] Dialog
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d. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.

e. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.

f. Repeat steps (d) to (e) for each of the measurements to be run.

g. Perform PESQ calibration if PESQ measurements are to be run.  Refer to section 
20-16 for details.

h. Click [OK] when complete to close the [Configure Measurements] dialog.

7. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

Figure 10-8. [Limits] Tab
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10-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

10-4 Viewing Test Results
Measurement results display at the right side of the BlueAudio interface.  Graphical 
measurements display at the top and numeric results display in the [Numeric Results] 
window.

10-5 Understanding Test Results

Frequency Response and Multiple Frequency Level Test.

It is standard practice to set the reference frequency to 997 Hz for these tests.  When using 
the Headset or Hands-free profile that mandates the CVSD codec, a typical device interfaced 
to the MT8855A Line audio connectors with cables, will show that other tones within the 
range 300 Hz to 3 kHz are ±3 dB of the reference tone.

When performing this test using test microphones and speakers, the low frequency response 
is likely to be limited to >500 Hz by the small physical size of the speaker.  This frequency 
response will also be affected by the mechanical coupling between the speaker and the 
microphone.  For the best low frequency response, the headset speaker should be acoustically 
coupled with the microphone directly opposite using a custom test fixture.  If the speaker is 
radiating into open space, low frequency response will be lost.  It is common to see large 
variations in the multiple frequency level test or frequency response curves when using 
microphones and speakers in the test setup.  The flatness of the response can be modified by 
adjusting the distance between the speaker and microphone and by the mechanics of the test 
fixture used to couple the sound between speaker and microphone.

THD+N

For a standard reference tone of 997 Hz, this test will typically show a THD+N measurement 
of > -17 dB when interfaced to the MT8855A Line audio connectors with cables.  Actual 
performance depends on the performance of the audio signal path, amplifiers, and ADC/DAC 
devices.

When using a microphone and speaker in the test configuration, the THD+N performance of a 
typical mono headset using the CVSD codec will be -10 to -20 dB.  It is important to shield the 
test microphone from background noise in the test environment as this will significantly 
degrade the THD+N measurement result.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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THD

For a standard reference tone of 997 Hz, when interfaced to the MT8855A Line audio 
connectors with cables, this test will typically show a THD measurement result of 5 dB better 
than for THD+N.  If the DUT is operating at close to maximum signal level for a CVSD codec, 
the CVSD codec exhibits non-linear behaviour.  Under these conditions THD+N and THD will 
give similar results because the 3rd harmonic distortion will dominate the measurement 
result.  Actual performance depends on the performance of the audio signal path including 
amplifiers, and ADC/DAC devices.  The result is expected to be better than THD+N as noise 
is not included in the result.  For this reason, use of the THD measurement alone should be 
treated with caution, as devices exhibiting good THD performance may still exhibit 
compromised audio performance if the noise performance is poor.

THD is degraded if the DUT has poor linearity.  Noise can be added to the audio signal path 
through noisy amplifies or poor schematic layout resulting in the pick up of unwanted signals 
on the audio paths.

When using a microphone and speaker in the test configuration, the THD performance of a 
typical mono headset using the CVSD codec will be 15 to 20 dB.  Background noise in the test 
environment will not degrade the THD measurement result as significantly as is the case for 
the THD+N measurement.

PESQ

PESQ scores lie in the range -0.5 (worst) to +4.5 (best).  

When testing a device using cable connections (from RF test port to RF connector, and from 
the device to the test set audio line input and output), a typical PESQ score would be >4.0. 

The score may be reduced if the digital signal level of the audio connection is set to 0 dBFS 
and the device is optimized for lower digital audio levels.  In this case, reduce the digital 
signal level of the audio sent over the Bluetooth connection and repeat the test.

When testing a device using over-the-air connections (from the MT8855A to the device 
antenna, and acoustic coupling using accessory microphones and speakers to interface to a 
fully assembled headset), a typical PESQ score would be between 2.7 to 3.7. 

The score may be reduced under any of the following conditions:

• If interference from other RF sources results in dropped packets in the Bluetooth 
connection.

• If background noise is picked up by the device or test system microphone.

• If there is frequency response and distortions introduced by the device and test system 
microphones and speakers.

• If the digital signal level is set above the level that the test device is optimized to 
receive.

THD+N vs Level

This test is designed for use during product design evaluation.  It graphically displays the 
usable signal level range of a DUT.  For small signal levels, the THD+N will be limited by 
system noise, and for large signal levels the result will be limited by saturation of the DUT 
input stages.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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THD+N vs Frequency

This test is designed for use during product design evaluation.  It graphically displays the 
distortion within the DUT across a range of audio frequencies.  The frequency range is limited 
to 300 Hz to 1 kHz so that an acceptable number of harmonics can be measured.  At 997 Hz, 
when testing a CVSD device, the number of harmonics measured is limited by the CVSD 
codec to 3.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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Chapter 11 — Testing Audio Gateway: 
Audio Output

11-1 Test Overview
The test described in this chapter is used to confirm that an audio signal can be sent by an 
audio gateway to the MT8855A running the Hands-free or Headset profile without distortion.

11-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

c. Establish a connection with the phone from the cellular network from which 
audio will be routed.

3. Configure the Bluetooth profile and MT8855A role.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 17.

Figure 11-1. Testing Audio Gateway: Audio Output

Note
To ensure that satisfactory measurement results are obtained, the MT8855A 
should be positioned away from sources of strong magnetic fields, power supplies, 
and CRT displays.
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a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” to “HFP”, or to “HSP” if “HFP” is not supported.  (Refer to chapter 6 
for an explanation of the Bluetooth profiles.)

e. Set “MT8855A Role” to “Device”.  (Refer to chapter 6 for an explanation of the 
MT8855A role settings.) 

f. Set “MT8855A Function“ to “Analyzer”.  (The MT8855A is being used to analyze 
the incoming Bluetooth signal.)

g. Select the required “SCO Connection”.  The MT8855A defaults to SCO using HV3 
packets.  The packet type can be changed by clearing the “Use Defaults” check 
box, clicking [Advanced] and selecting a different setting.  All SCO packet types 
are defined in Appendix D.

h. Click [OK] when complete.

Figure 11-2. [Bluetooth Profile] Dialog for Mono Headset Microphone Testing
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4. Configure a Bluetooth connection between the MT8855A and the DUT.

The connection can be initiated from the DUT or the MT8855A.

To initiate the connection from the DUT

a. Click  to open the dialog shown below.

b. At the DUT, set the passkey to match that specified in the dialog above.

c. Select the “Allow DUT Initiated Connections” check box.

After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

d. Refer to the DUT manufacturer’s instructions for details of how to initiate a 
connection.

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Figure 11-3. [Bluetooth Connection] Dialog
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To initiate the connection from the MT8855A.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the DUT 
manufacturer’s instructions for details.

b. Click  to open the dialog shown below.

c. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

d. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

Figure 11-4. [Bluetooth Connection] Dialog

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment. 
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e. Enter the “Passkey” to match that of the DUT.  Connection with the DUT will be 
rejected unless the correct passkey specified.  The passkey is typically “0000” but 
this may differ depending on the DUT in question.  Refer to the documentation 
supplied with the product.

f. Clear the "Allow DUT Initiated Connections" check box as required. 

g. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5dBm; for cable connections the output 
power is nominally -40 dBm.

h. Click [OK] to close the [Connection Setup] dialog.

i. Establish the Bluetooth connection.

• If the “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If the “Address Source was set to a “Inquiry” or “Inquiry + Name”, the 
button beneath [Configure Connection] displays as . 
Click this button to display an [Inquiry Results] dialog, select the required 
DUT and click [Connect].

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

Figure 11-5. Testing Audio Gateway: Audio Output
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a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

b. Set “Analogue Output” to “Off”. (As seen in the configuration diagram on the 
previous page, the audio signal is fed in from a cellular network or test set and 
there are no audio output feeds from the MT8855A.)

Two other “Analogue Output” settings can be used if outputting an audio test 
signal directly from the MT8855A:

Figure 11-6. [MT8855A] Dialog for Audio Gateway Testing
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Set “Analogue Output” to “Line” if configuring to send an audio tone from the 
MT8855A to the handset that will be used to establish the cellular connection 
with the phone under test.  This test scenario is illustrated in the figure below.

Set “Analogue Output” to “Speaker” if configuring to use a speaker to send an 
audio tone from the MT8855A to the microphone on the handset that will be used 
to establish the cellular connection with the phone under test.  This test scenario 
is illustrated in the figure below.

c. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A.  Select “Received Bluetooth Audio” to 
hear the RF signal from the audio gateway.  The other settings are not applicable 
to this test.

Figure 11-7. Analogue Output: Line

Figure 11-8. Analogue Output: Speaker
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d. Set the monitor “Level” setting to the required volume.

6. Configure measurements.

a. Click  on the [Manual Test] tab to open the dialog shown 
below.

b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997 Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

Note
To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.

Figure 11-9. [Measurement] Dialog
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c. Set the “Measurement Resolution”.

"Measurement Resolution" refers to the resolution of the FFT.  The “Normal” 
setting captures 4 kilobytes of data and the “High” setting captures 8kbytes of 
data.  The extra resolution resulting from the “High” setting enables THD+N, 
THD, SINAD, stereo separation, and stereo phase measurements to be made 
from 
150 Hz to 20 kHz.  At the “Normal” setting the lowest frequency these 
measurements can be made at is 300 Hz.  The "Measurement Resolution" setting 
does not have any effect on the multiple frequency level test or the frequency 
response graph.

d. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Six measurements display numeric results only, and three display graphical 
results. 

When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

e. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.
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f. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.

g. Repeat steps (d) to (f) for each measurement to be run.

h. Click [OK] when complete to close the [Configure Measurements] dialog.

7. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

8. Call the phone under test from the cellular network or GSM tester.

11-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

Figure 11-10. [Limits] Tab
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11-4 Viewing Test Results
Measurement results display at the right side of the BlueAudio interface.  Graphical 
measurements display at the top and all numeric results display in the [Numeric Results] 
window.

11-5 Understanding Test Results

Frequency Response and Multiple Frequency Level Test.

It is standard practice to set the reference frequency to 997 Hz for these tests.  When using 
the Headset or Hands-free profile that mandates the CVSD codec, a typical device interfaced 
to the MT8855A Line audio connectors with cables, will show that other tones within the 
range 300 Hz to 3 kHz are ±3 dB of the reference tone.

When performing this test using test microphones and speakers, the low frequency response 
is likely to be limited to >500 Hz by the small physical size of the speaker.  This frequency 
response will also be affected by the mechanical coupling between the speaker and the 
microphone.  For the best low frequency response, the headset speaker should be acoustically 
coupled with the microphone directly opposite using a custom test fixture.  If the speaker is 
radiating into open space, low frequency response will be lost.  It is common to see large 
variations in the multiple frequency level test or frequency response curves when using 
microphones and speakers in the test setup.  The flatness of the response can be modified by 
adjusting the distance between the speaker and microphone and by the mechanics of the test 
fixture used to couple the sound between speaker and microphone.

THD+N 

For a standard reference tone of 997 Hz, this test will typically show a THD+N measurement 
of > -17 dB when interfaced to the MT8855A Line audio connectors with cables.  Actual 
performance depends on the performance of the audio signal path, amplifiers, and ADC/DAC 
devices.

When using a microphone and speaker in the test configuration, the THD+N performance of a 
typical mono headset using the CVSD codec will be -10 to -20 dB.  It is important to shield the 
test microphone from background noise in the test environment as this will significantly 
degrade the THD+N measurement result.

THD

For a standard reference tone of 997 Hz, when interfaced to the MT8855A Line audio 
connectors with cables, this test will typically show a THD measurement result of 5 dB better 
than for THD+N.  If the DUT is operating at close to maximum signal level for a CVSD codec, 
the CVSD codec exhibits non-linear behavior.  Under these conditions THD+N and THD will 
give similar results because the 3rd harmonic distortion will dominate the measurement 
result.  Actual performance depends on the performance of the audio signal path including 
amplifiers, and ADC/DAC devices.  The result is expected to be better than THD+N as noise 
is not included in the result.  For this reason, use of the THD measurement alone should be 
treated with caution, as devices exhibiting good THD performance may still exhibit 
compromised audio performance if the noise performance is poor.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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THD is degraded if the DUT has poor linearity.  Noise can be added to the audio signal path 
through noisy amplifies or poor schematic layout resulting in the pick up of unwanted signals 
on the audio paths.

When using a microphone and speaker in the test configuration, the THD performance of a 
typical mono headset using the CVSD codec will be 15 to 20 dB.  Background noise in the test 
environment will not degrade the THD measurement result as significantly as is the case for 
the THD+N measurement.

THD+N vs Level

This test is designed for use during product design evaluation.  It graphically displays the 
usable signal level range of a DUT.  For small signal levels, the THD+N will be limited by 
system noise, and for large signal levels the result will be limited by saturation of the DUT 
input stages.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.

THD+N vs Frequency

This test is designed for use during product design evaluation.  It graphically displays the 
distortion within the DUT across a range of audio frequencies.  The frequency range is limited 
to 300 Hz to 1 kHz so that an acceptable number of harmonics can be measured.  At 997 Hz, 
when testing a CVSD device, the number of harmonics measured is limited by the CVSD 
codec to 3.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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Chapter 12 — Testing Audio Gateway: 
Audio Input

12-1 Test Overview
The test described in this chapter is used to confirm that an audio signal running the Hands-
free or Headset profile can be sent from the MT8855A to an audio gateway without distortion.

12-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

c. Establish a connection from the phone to the cellular network to which audio will 
be routed.

3. Configure the Bluetooth profile and MT8855A role.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 17.

Figure 12-1. Testing Audio Gateway: Audio Input

Note
To ensure that satisfactory measurement results are obtained, the MT8855A 
should be positioned away from sources of strong magnetic fields, power supplies, 
and CRT displays.



Preparing to Test Testing Audio Gateway: Audio Input

12-2 PN: 13000-00280  Rev. D MT8855A Operation Manual

a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” to “HFP”, or to “HSP” if “HFP” is not supported.  (Refer to chapter 6 
for an explanation of the Bluetooth profiles.)

e. Set “MT8855A Role” to “Device”.  (Refer to chapter 6 for an explanation of the 
MT8855A role settings.) 

f. Set “MT8855A Function“ to “Generator”.  (The MT8855A is being used to 
generate the Bluetooth signal being sent to the audio gateway.)

g. Select the required “SCO Connection”.  The MT8855A defaults to SCO using HV3 
packets.  The packet type can be changed by clearing the “Use Defaults” check 
box, clicking [Advanced] and selecting a different setting.  All SCO packet types 
are defined in Appendix D.

h. Click [OK] when complete.

Figure 12-2. [Bluetooth Profile] Dialog for Audio Gateway Receiver Testing
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4. Configure a Bluetooth connection between the MT8855A and the DUT.

The connection can be initiated from either the DUT or the MT8855A.

To initiate the connection from the DUT.

a. Click  to open the dialog shown below.

b. At the DUT, set the passkey to match that specified in the dialog above.

c. Select the “Allow DUT Initiated Connections” check box.

d. Refer to the DUT manufacturer’s instructions for details of how to initiate a 
connection.

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Figure 12-3. [Bluetooth Connection] Dialog
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To initiate the connection from the MT8855A.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the DUT 
manufacturer’s instructions for details.

b. Click  to open the dialog shown below.

c. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

d. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

e. Enter the “Passkey”.  Connection with the DUT will be rejected unless the correct 
passkey specified.  The passkey is typically “0000” but this may differ depending 
on the DUT in question.  Refer to the documentation supplied with the product.

Figure 12-4. [Bluetooth Connection] Dialog

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment. 
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f. Select or clear the "Allow DUT Initiated Connections" check box as required.  
After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

g. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5 dBm; for cable connections the output 
power is nominally -40 dBm.

h. Click [OK] to close the [Connection Setup] dialog.

i. Establish the Bluetooth connection.

• If “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If “Address Source was set to a “Inquiry” or “Inquiry + Name”, the button 
beneath [Configure Connection] displays as . Click this 
button to display an [Inquiry Results] dialog, select the required DUT and 
click [Connect].

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

Figure 12-5. Testing Audio Gateway: Audio Input

Figure 12-6. [MT8855A] Dialog for Audio Gateway Receiver Testing



Testing Audio Gateway: Audio Input Preparing to Test

MT8855A Operation Manual PN: 13000-00280  Rev. D 12-7

b. Set “Analogue Input” to “Off”. (As seen in the configuration diagram on the 
previous page, there are no analogue input feeds to the MT8855A.)

Two other “Analogue Input” settings can be used if outputting audio from the 
cellular network or test set directly to the MT8855A:

Set “Analogue Input” to “Line” if configuring to send an audio tone over the 
cellular network from the DUT to the handset and relayed back to the MT8855A.  
This test scenario is illustrated in the figure below.

Set “Analogue Input” to “Microphone” if if configuring to use a microphone to pick 
up an audio tone sent over the cellular network from the DUT to the handset. 
This test scenario is illustrated in the figure below.

c. Set “Range” to “Auto”.

The “Auto” setting is suitable for all normal signals under test.  If the signal 
under test has excessive noise the auto range algorithm on the MT8855A may 
fail.  In this case use of the manual range is required.  Refer to section 18-13 for a 
list of the manual range settings.

Figure 12-7. Analogue Input: Line

Figure 12-8. Analogue Input: Microphone
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d. Set the "Bluetooth Digital Output".

Use the slider to set the Bluetooth digital output to the maximum signal level 
that the device under test is designed to receive.  This will typically be a value 
between -3 and -12 dBFS.

e. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A. In this particular case, select 
“Transmitted Bluetooth Audio”.

f. Set the monitor “Level” setting to the required volume.

6. Configure measurements.

a. Click  on the [Manual Test] tab to open the dialog shown 
below.

b. Specify the “Reference Frequency”.

Note
To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.

Figure 12-9. [Measurement] Dialog
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The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997Hz is selected in relation to the standard sampling 
frequencies of 44.1 kHz and 48 kHz of the SBC codec so that sampling in 
successive cycles occurs at different phases of the audio tone. 

It ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

c. Set the “Measurement Resolution”.

"Measurement Resolution" refers to the resolution of the FFT.  The “Normal” 
setting captures 4kbytes of data and the “High” setting captures 8kbytes of data.  
The extra resolution resulting from the “High” setting enables THD+N, THD, 
SINAD, stereo separation, and stereo phase measurements to be made from 
150 Hz to 20 kHz.  At the “Normal” setting the lowest frequency these 
measurements can be made at is 300 Hz.  The "Measurement Resolution" setting 
does not have any effect on the multiple frequency level test or the frequency 
response graph.

d. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Six measurements display numeric results only, and three display graphical 
results. 

When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

e. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.
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f. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.

g. Repeat steps (d) to (f) for each of the measurements to be run.

h. Click [OK] when complete to close the [Configure Measurements] dialog.

7. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

8. Call the phone under test from the cellular network or GSM tester.

12-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

Figure 12-10.[Limits] Tab
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12-4 Viewing Test Results
Measurement results display at the right side of the BlueAudio interface.  Graphical 
measurements display at the top and all numeric results display in the [Numeric Results] 
window.

12-5 Understanding Test Results

Frequency Response and Multiple Frequency Level Test.

It is standard practice to set the reference frequency to 997 Hz for these tests.  When using 
the Headset or Hands-free profile that mandates the CVSD codec, a typical device interfaced 
to the MT8855A Line audio connectors with cables, will show that other tones within the 
range 300 Hz to 3 kHz are ± 3 dB of the reference tone.

When performing this test using test microphones and speakers, the low frequency response 
is likely to be limited to >500 Hz by the small physical size of the speaker.  This frequency 
response will also be affected by the mechanical coupling between the speaker and the 
microphone.  For the best low frequency response, the headset speaker should be acoustically 
coupled with the microphone directly opposite using a custom test fixture.  If the speaker is 
radiating into open space, low frequency response will be lost.  It is common to see large 
variations in the multiple frequency level test or frequency response curves when using 
microphones and speakers in the test setup.  The flatness of the response can be modified by 
adjusting the distance between the speaker and microphone and by the mechanics of the test 
fixture used to couple the sound between speaker and microphone.

THD+N

For a standard reference tone of 997Hz, this test will typically show a THD+N measurement 
of > -17 dB when interfaced to the MT8855A Line audio connectors with cables.  Actual 
performance depends on the performance of the audio signal path, amplifiers, and ADC/DAC 
devices.

When using a microphone and speaker in the test configuration, the THD+N performance of a 
typical mono headset using the CVSD codec will be -10 to -20 dB.  It is important to shield the 
test microphone from background noise in the test environment as this will significantly 
degrade the THD+N measurement result.

THD

For a standard reference tone of 997 Hz, when interfaced to the MT8855A Line audio 
connectors with cables, this test will typically show a THD measurement result of 5 dB better 
than for THD+N.  If the DUT is operating at close to maximum signal level for a CVSD codec, 
the CVSD codec exhibits non-linear behaviour.  Under these conditions THD+N and THD will 
give similar results because the 3rd harmonic distortion will dominate the measurement 
result.  Actual performance depends on the performance of the audio signal path including 
amplifiers, and ADC/DAC devices.  The result is expected to be better than THD+N as noise 
is not included in the result.  For this reason, use of the THD measurement alone should be 
treated with caution, as devices exhibiting good THD performance may still exhibit 
compromised audio performance if the noise performance is poor.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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THD is degraded if the DUT has poor linearity.  Noise can be added to the audio signal path 
through noisy amplifies or poor schematic layout resulting in the pick up of unwanted signals 
on the audio paths.

When using a microphone and speaker in the test configuration, the THD performance of a 
typical mono headset using the CVSD codec will be 15 to 20 dB.  Background noise in the test 
environment will not degrade the THD measurement result as significantly as is the case for 
the THD+N measurement.

THD+N vs Level

This test is designed for use during product design evaluation.  It graphically displays the 
usable signal level range of a DUT.  For small signal levels, the THD+N will be limited by 
system noise, and for large signal levels the result will be limited by saturation of the DUT 
input stages.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.

THD+N vs Frequency

This test is designed for use during product design evaluation.  It graphically displays the 
distortion within the DUT across a range of audio frequencies.  The frequency range is limited 
to 300 Hz to 1 kHz so that an acceptable number of harmonics can be measured.  At 997 Hz, 
when testing a CVSD device, the number of harmonics measured is limited by the CVSD 
codec to 3.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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Chapter 13 — Testing an A2DP Sink

13-1 Test Overview
The test described in this chapter is used to confirm that an audio signal, transmitted by a 
MT8855A running the A2DP profile, can be sent to an A2DP sink and routed back to the 
MT8855A over an analogue connection without distortion.

13-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 17.

Figure 13-1. Testing an A2DP Sink

Note

The following points should be observed to ensure that satisfactory measurement 
results are obtained:

• The DUT should be positioned in a shielded acoustic box.

• The MT8855A should be positioned away from sources of strong magnetic 
fields, power supplies, and CRT displays.
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3. Configure the Bluetooth profile and MT8855A role.

a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” to “A2DP”.  (Refer to chapter 6 for an explanation of the Bluetooth 
profiles.)

e. Set “MT8855A Role” to “Source”.  (Refer to chapter 6 for an explanation of the 
MT8855A role settings.) 

f. Set the “SBC Codec Sampling Frequency” to a sampling rate supported by the 
DUT.  The sampling frequency can be set by the A2DP source.  The A2DP sink 
must align with the source setting.  Most commercial A2DP products default to a 
44.1 kHz sampling frequency.

g. Click [OK] when complete.

Figure 13-2. [Bluetooth Profile] Dialog for A2DP Testing
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4. Configure a Bluetooth connection between the MT8855A and the DUT.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the 
documentation supplied with the product.

b. Click  to open the dialog shown below.

c. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

d. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

e. Enter the “Passkey”.  Connection with the DUT will be rejected unless the correct 
passkey specified.  The passkey is typically “0000” but this may differ depending 
on the DUT in question.  Refer to the documentation supplied with the product.

Figure 13-3. [Bluetooth Connection] Dialog

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment. 
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f. Select or clear the "Allow DUT Initiated Connections" check box as required.  
After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

g. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5dBm; for cable connections the output 
power is nominally -40dBm.

h. Click [OK] to close the [Connection Setup] dialog.

i. Establish the Bluetooth connection.

• If “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If “Address Source was set to a “Inquiry” or “Inquiry + Name”, the button 
beneath [Configure Connection] displays as . Click this 
button to display an [Inquiry Results] dialog, select the required DUT and 
click [Connect].

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Note
As the A2DP sink (commonly a Bluetooth stereo headset, or multi-mode speaker) 
does not have an interface from which a Bluetooth connection can be established, 
the initial connection must always be made from the MT8855A.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

Figure 13-4. Testing an A2DP Sink

Figure 13-5. [MT8855A] dialog for A2DP Sink Testing



Preparing to Test Testing an A2DP Sink

13-6 PN: 13000-00280  Rev. D MT8855A Operation Manual

b. Set “Analogue Input” to “Mic”.  (As seen in the configuration diagram on the 
previous page, the microphone cables feed into the left and right channel 
microphone input socket.

c. Select “Phantom Power On” if required by the microphone in use.  Phantom 
power is a 48 V DC supply used to power capacitor-based microphones.  Select 
“Phantom Power On”  whenever the external microphone connected to the 
microphone input of MT8855A requires DC power.  If selected, the phantom 
power indicator on the BlueAudio status bar changes from red to green.

d. Set “Range” to “Auto”.

The “Auto” setting is suitable for all normal signals under test.  If the signal 
under test has excessive noise the auto range algorithm on the MT8855A may 
fail.  In this case use of the manual range is required.  Refer to section 18-13 for a 
list of the manual range settings.

e. Set the "Bluetooth Digital Output".

Use the slider to set the Bluetooth digital output to the maximum signal level 
that the device under test is designed to receive.  This will typically be a value 
between -3 and -12 dBFS. 

f. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A.  Select “Analogue Audio Input” to 
hear the signal picked up by the microphone.  Select “Transmitted Bluetooth 
Audio” to hear the signal relayed over the Bluetooth connection from the 
MT8855A to the DUT.

g. Set the monitor “Level” setting to the required volume.

Note
Both of the Anritsu microphones available as optional accessories (2000-1607-R 
and 2000-1608-R) require the use of phantom power.

Note

When monitoring the signal from a microphone, it may be better to use a headset 
to avoid audible feedback.

To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.
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h. Apply microphone correction if required by the microphone in use.  Select “Apply 
Microphone Correction” and click [Microphone Calibration] to display the dialog 
below.  Correction is used to compensate for the frequency response of the 
microphone, normalized to the reference frequency.  Anritsu microphones are 
supplied with a calibration curve (see Table 1-2 on page 1-5 for details).

i. Browse to an existing calibration file or create a new table by adding rows and 
values as required.

j. Click [OK] to close the [Microphone Calibration] dialog.

k. Click [OK] close the [MT8855A] dialog.

6. Configure measurements.

Figure 13-6. Microphone Calibration
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a. Click  on the [Manual Test] tab to open the dialog shown 
below.

b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997 Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

Figure 13-7. [Measurement] Dialog
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c. Set the “Measurement Resolution”.

"Measurement Resolution" refers to the resolution of the FFT.  The “Normal” 
setting captures 4kbytes of data and the “High” setting captures 8kbytes of data.  
The extra resolution resulting from the “High” setting enables THD+N, THD, 
SINAD, stereo separation, and stereo phase measurements to be made from 
150 Hz to 20 kHz.  At the “Normal” setting the lowest frequency these 
measurements can be made at is 300 Hz.  The "Measurement Resolution" setting 
does not have any effect on the multiple frequency level test or the frequency 
response graph.

d. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Six measurements display numeric results only, and three display graphical 
results. 

When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

e. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.

f. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.

Figure 13-8. [Limits] Tab
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g. Repeat steps (d) to (f) for each of the measurements to be run.

h. Click [OK] when complete to close the [Configure Measurements] dialog.

7. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

13-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

13-4 Viewing Test Results
Measurement results display at the right side of the BlueAudio interface.  Graphical 
measurements display at the top and all numeric results display in the [Numeric Results] 
window.

13-5 Understanding Test Results

Frequency Response and Multiple Frequency Level Test.

It is standard practice to set the reference frequency to 997 Hz for this test.  When using the 
A2DP profile the MT8855A uses the mandated SBC codec for all audio measurements.  When 
interfaced to the MT8855A Line audio connectors with cables, this test will typically show 
that other tones  within the range of 50 Hz to 15 kHz are ± 3 dB of the reference tone.

When performing this test using test microphones and speakers, the low frequency response 
is likely to be limited to >500 Hz by the small physical size of the speaker.  This frequency 
response will also be affected by the mechanical coupling between the speaker and the 
microphone.  For the best low frequency response, the headset speaker should be acoustically 
coupled with the microphone directly opposite using a custom test fixture.  If the speaker is 
radiating into open space, low frequency response will be lost.  It is common to see large 
variations in the multiple frequency level test or frequency response curves when using 
microphones and speakers in the test setup.  The flatness of the response can be modified by 
adjusting the distance between the speaker and microphone and by the mechanics of the test 
fixture used to couple the sound between speaker and microphone.

THD+N

For a standard reference tone of 997 Hz, this test will typically show a THD+N measurement 
of > 60 dB when interfaced to the MT8855A Line audio connectors with cables and using the 
SBC codec.  Actual performance depends on the performance of the audio signal path, 
amplifiers, and ADC/DAC devices.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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When using a microphone and speaker in the test configuration, the THD+N performance of a 
typical stereo headset using the SBC codec will be >30 dB. It is important to shield the test 
microphone from background noise in the test environment as this will significantly degrade 
the THD+N measurement result.

THD

For a standard reference tone of 997 Hz, when interfaced to the MT8855A Line audio 
connectors with cables, and using the SBC codec, this test will typically show a THD 
measurement result >60 dB.  Actual performance depends on the performance of the audio 
signal path including amplifiers, and ADC/DAC devices.

When using a microphone and speaker in the test configuration, the THD performance of a 
typical stereo headset using the SBC codec will be 30 to 40 dB.  It is less important to shield 
the test microphone from background noise in the test environment as noise is not included in 
the THD measurement result.

Stereo Separation

For a standard reference tone of 997 Hz, when interfaced to the MT8855A using Line audio 
connectors with cables, typical stereo separation results will be >50 dB.

If the measurement is performed on a stereo headset using two microphones to pick up the 
audio signal from the DUT speakers, typical results will be >20 dB.  The actual measured 
value for this test is dependent on the quality of the test fixture and its ability to isolate the 
acoustic signal on the left channel from leaking onto the right channel (and visa versa).

Stereo Phase

Results for the stereo phase test case should be similar regardless of whether performed 
using Line inputs or microphones and speakers.

The result of the stereo phase test case does not typically show variations between all 
products of the same design.  The phase is determined by the schematic layout of the DUT's 
audio circuits and components.  A good design will show that stereo phase between left and 
right channels is <10 degrees and typically around 5 degrees.

If the result is around 180 degrees, this indicates that one of the audio channels has been 
assembled with the cables reversed.  As this is a common assembly mistake, the test is often 
performed in production specifically to identify this assembly error.

THD+N vs Level

This test is designed for use during product design evaluation.  It graphically displays the 
usable signal level range of a DUT.  For small signal levels, the THD+N will be limited by 
system noise; for large signal levels the result will be limited by saturation of the DUT input 
stages.

The actual levels over which a device shows acceptable performance is dependent on each 
DUT design.
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THD+N vs Frequency

This test is designed for use during product design evaluation.  It graphically displays the 
distortion within the DUT across a range of audio frequencies.  The frequency range is limited 
to 250 Hz to 5 kHz so that an acceptable number of harmonics can be measured.  (Note the 
low frequency limit can be extended to 150 Hz if the FFT mode is set to "High".)  At 5 kHz, 
when testing an A2DP device, the number of harmonics measured is limited by the SBC codec 
to 3.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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Chapter 14 — Testing an A2DP 
Source

14-1 Test Overview
The test described in this chapter is used to confirm that an audio signal can be transmitted 
to the MT8855A from a device running the A2DP profile without distortion.

14-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

3. Load the music player with the audio files that will be sent over Bluetooth to the 
MT8855A.  The product CD shipped with the MT8855A includes a number of audio 
tone files that are ideal for this purpose.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 17.

Figure 14-1. Testing an A2DP Source

Note

The following points should be observed to ensure that satisfactory measurement 
results are obtained:

• The DUT should be positioned in a shielded acoustic box.

• The MT8855A should be positioned away from sources of strong magnetic 
fields, power supplies, and CRT displays.
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4. Configure the Bluetooth profile and MT8855A role.

a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” to “A2DP”.  (Refer to chapter 6 for an explanation of the Bluetooth 
profiles.)

e. Set “MT8855A Role” to “Sink”.  (Refer to chapter 6 for an explanation of the 
MT8855A role settings.) 

f. Click [OK] when complete.

Figure 14-2. [Bluetooth Profile] Dialog for A2DP Source Testing
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5. Configure a Bluetooth connection between the MT8855A and the DUT.

The connection can be initiated from either the DUT or the MT8855A.

To initiate the connection from the DUT

a. Click  to open the dialog shown below.

b. At the DUT, set the passkey to match that specified in the dialog above.

c. Select the “Allow DUT Initiated Connections” check box.

d. Refer to the DUT manufacturer’s instructions for details of how to initiate a 
connection.

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

To initiate the connection from the MT8855A.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the DUT 
manufacturer’s instructions for details.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

Figure 14-3. [Bluetooth Connection] Dialog
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c. Click  to open the dialog shown below.

d. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

e. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

f. Enter the “Passkey”.  Connection with the DUT will be rejected unless the correct 
passkey specified.  The passkey is typically “0000” but this may differ depending 
on the DUT in question.  Refer to the documentation supplied with the product.

Figure 14-4. [Bluetooth Connection] Dialog

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment.  
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g. Select or clear the "Allow DUT Initiated Connections" check box as required.  
After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

h. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5dBm; for cable connections the output 
power is nominally -40 dBm.

i. Click [OK] to close the [Connection Setup] dialog.

j. Establish the Bluetooth connection.

• If “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If “Address Source was set to a “Inquiry” or “Inquiry + Name”, the button 
beneath [Configure Connection] displays as . Click this 
button to display an [Inquiry Results] dialog, select the required DUT and 
click [Connect].

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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6. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

Figure 14-5. Testing an A2DP Source

Figure 14-6. [MT8855A] Dialog for A2DP Source Testing
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b. Set “Analogue Output” to “Off”. (As seen in the configuration diagram on the 
previous page, there are no analogue output feeds from the MT8855A.)

The CD supplied with the MT8855A includes a number of audio tones in MP3 
format.  These can be copied to the media player and used in testing.

c. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A.  Select “Received Bluetooth Audio” to 
hear the RF signal from the music player.  The other settings are not applicable 
to this test.

d. Set the monitor “Level” setting to the required volume.

7. Configure measurements.

a. Click  on the [Manual Test] tab to open the dialog shown 
below.

Note
To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.

Figure 14-7. [Measurement] Dialog
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b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

c. Set the “Measurement Resolution”.

"Measurement Resolution" refers to the resolution of the FFT.  The “Normal” 
setting captures 4kbytes of data and the “High” setting captures 8 kilobytes of 
data.  The extra resolution resulting from the “High” setting enables THD+N, 
THD, SINAD, stereo separation, and stereo phase measurements to be made 
from 
150 Hz to 20 kHz.  At the “Normal” setting the lowest frequency these 
measurements can be made at is 300 Hz.  The "Measurement Resolution" setting 
does not have any effect on the multiple frequency level test or the frequency 
response graph.

d. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Six measurements display numeric results only, and three display graphical 
results. 

When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

e. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.

Note
The multiple frequency level test cannot be performed if using the single-tone 
audio files supplied by Anritsu.
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f. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.

g. Repeat steps (d) to (f) for each of the measurements to be run.

h. Click [OK] when complete to close the [Configure Measurements] dialog.

8. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

9. Use the controls on the music player to play selected audio files.

14-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

Figure 14-8. [Limits] Tab
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14-4 Viewing Test Results
Measurement results display at the right side of the BlueAudio interface.  Graphical 
measurements display at the top and all numeric results display in the [Numeric Results] 
window.

14-5 Understanding Test Results

Frequency Response and Multiple Frequency Level Test.

It is standard practice to set the reference frequency to 997 Hz for this test.  When using the 
A2DP profile the MT8855A uses the mandated SBC codec for all audio measurements.  When 
interfaced to the MT8855A Line audio connectors with cables, this test will typically show 
that other tones  within the range of 50 Hz to 15 kHz are ± 3 dB of the reference tone.

When performing this test using test microphones and speakers, the low frequency response 
is likely to be limited to >500 Hz by the small physical size of the speaker.  This frequency 
response will also be affected by the mechanical coupling between the speaker and the 
microphone.  For the best low frequency response, the headset speaker should be acoustically 
coupled with the microphone directly opposite using a custom test fixture.  If the speaker is 
radiating into open space, low frequency response will be lost.  It is common to see large 
variations in the multiple frequency level test or frequency response curves when using 
microphones and speakers in the test setup.  The flatness of the response can be modified by 
adjusting the distance between the speaker and microphone and by the mechanics of the test 
fixture used to couple the sound between speaker and microphone.

THD+N

For a standard reference tone of 997 Hz, this test will typically show a THD+N measurement 
of > 60 dB when interfaced to the MT8855A Line audio connectors with cables and using the 
SBC codec.  Actual performance depends on the performance of the audio signal path, 
amplifiers, and ADC/DAC devices.

When using a microphone and speaker in the test configuration, the THD+N performance of a 
typical stereo headset using the SBC codec will be >30dB. It is important to shield the test 
microphone from background noise in the test environment as this will significantly degrade 
the THD+N measurement result.

THD

For a standard reference tone of 997 Hz, when interfaced to the MT8855A Line audio 
connectors with cables, and using the SBC codec, this test will typically show a THD 
measurement result >60 dB.  Actual performance depends on the performance of the audio 
signal path including amplifiers, and ADC/DAC devices.

When using a microphone and speaker in the test configuration, the THD performance of a 
typical stereo headset using the SBC codec will be 30 to 40 dB.  It is less important to shield 
the test microphone from background noise in the test environment as noise is not included in 
the THD measurement result.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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Stereo Separation

For a standard reference tone of 997 Hz, when interfaced to the MT8855A using Line audio 
connectors with cables, typical stereo separation results will be >50 dB.

If the measurement is performed on a stereo headset using two microphones to pick up the 
audio signal from the DUT speakers, typical results will be >20 dB.  The actual measured 
value for this test is dependent on the quality of the test fixture and its ability to isolate the 
acoustic signal on the left channel from leaking onto the right channel (and visa versa).

Stereo Phase

Results for the stereo phase test case should be similar regardless of whether performed 
using Line inputs or microphones and speakers.

The result of the stereo phase test case does not typically show variations between all 
products of the same design.  The phase is determined by the schematic layout of the DUT's 
audio circuits and components.  A good design will show that stereo phase between left and 
right channels is <10 degrees and typically around 5 degrees.

If the result is around 180 degrees, this indicates that one of the audio channels has been 
assembled with the cables reversed.  As this is a common assembly mistake, the test is often 
performed in production specifically to identify this assembly error.

THD+N vs Level

This test is designed for use during product design evaluation.  It graphically displays the 
usable signal level range of a DUT.  For small signal levels, the THD+N will be limited by 
system noise; for large signal levels the result will be limited by saturation of the DUT input 
stages.

The actual levels over which a device shows acceptable performance is dependent on each 
DUT design.

THD+N vs Frequency

This test is designed for use during product design evaluation.  It graphically displays the 
distortion within the DUT across a range of audio frequencies.  The frequency range is limited 
to 250 Hz to 5 kHz so that an acceptable number of harmonics can be measured.  (Note the 
low frequency limit can be extended to 150Hz if the FFT mode is set to "High".)  At 5 kHz, 
when testing an A2DP device, the number of harmonics measured is limited by the SBC codec 
to 3.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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Chapter 15 — Testing a Bluetooth 
Stereo Headset: Microphone Input

15-1 Test Overview
A Bluetooth stereo headset is the generic name given to a Bluetooth headset capable of 
automatically switching between A2DP and HSP/HFP profiles for seamless handling of music 
streams and incoming calls.

The test described in this chapter is used to confirm that an analogue signal can be sent to a 
the headset, routed through the microphone, codec, and RF, and transmitted over the Hands-
free to the MT8855A without distortion.

15-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 17.

Figure 15-1. Testing a Bluetooth Stereo Headset: Microphone Input
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3. Configure the Bluetooth profile and MT8855A role.

a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” to “HFP”.  (Refer to chapter 6 for an explanation of the Bluetooth 
profiles.)

e. Set “MT8855A Role” to “Audio Gateway”.  (Refer to chapter 6 for an explanation 
of the MT8855A role settings.) 

f. Select or clear the "Use Ring" check box as required.  If the check box is cleared 
(the default setting), the incoming call is accepted automatically without the user 
needing to press the call accept button on the headset.  If the check box is 
selected, the user will need to press the call accept button on the headset to 
accept the call.  Selecting the check box would only be required by users 
specifically wishing to test the functionality of the button on the headset.

g. Set “DUT Test Item“ to “Microphone”.  (As we are testing the analogue signal 
transmitted from the MT8855A to the headset microphone.)

h. Select the required “SCO Connection”.  The MT8855A defaults to SCO using HV3 
packets.  The packet type can be changed by clearing the “Use Defaults” check 
box, clicking [Advanced] and selecting a different setting.  All SCO packet types 
are defined in Appendix D.

i. Click [OK] when complete.

Note

The following points should be observed to ensure that satisfactory measurement 
results are obtained:

• The DUT should be positioned in a shielded acoustic box.

• The MT8855A should be positioned away from sources of strong magnetic 
fields, power supplies, and CRT displays.

Figure 15-2. [Bluetooth Profile] Dialog for Ultimate Headset Microphone Testing
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4. Configure a Bluetooth connection between the MT8855A and the DUT.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the 
documentation supplied with the product.

b. Click  to open the dialog shown below.

c. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

Note

After an initial connection has been made, many headsets attempt to reconnect to 
the same address whenever powered on.  The MT8855A is maintained in a 
permanently discoverable state to allow such connections to succeed.  

When a Bluetooth connection is successfully established, the DUT address and 
user friendly name display on the [Manual Test] tab, and the “Status” field in the 
status bar changes to “Connected”.

Figure 15-3. [Bluetooth Connection] Dialog
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• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

d. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

e. Enter the “Passkey”.  Connection with the DUT will be rejected unless the correct 
passkey specified.  The passkey is typically “0000” but this may differ depending 
on the DUT in question.  Refer to the documentation supplied with the product.

f. Select or clear the "Allow DUT Initiated Connections" check box as required.  
After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

g. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5 dBm; for cable connections the output 
power is nominally -40 dBm.

h. Click [OK] to close the [Connection Setup] dialog.

i. Establish the Bluetooth connection.

• If “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If “Address Source was set to a “Inquiry” or “Inquiry + Name”, the button 
beneath [Configure Connection] displays as . Click this 
button to display an [Inquiry Results] dialog, select the required DUT and 
click [Connect].

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment.  

Note
As the headset does not have an interface from which a Bluetooth connection can 
be established, the initial connection must always be made from the MT8855A.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

Figure 15-4. Testing a Bluetooth Stereo Headset: Microphone Input

Figure 15-5. [MT8855A] Dialog for Ultimate Headset Microphone to Audio Gateway Testing
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b. Set “Analogue Output” to “Speaker”.  (As seen in the configuration diagram, the 
left channel speaker output is in use.)

c. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A.  Select “Received Bluetooth Audio” to 
hear the RF signal from the headset.  Select “Analogue Audio Output” to hear the 
signal sent from the MT8855A to the DUT.

d. Set the monitor “Level” setting to the required volume.

e. Apply speaker correction if required by the speaker in use.  Select “Apply 
Speaker Correction” and click [Speaker Calibration] to display the dialog below.  
Correction is used to compensate for the frequency response of the speaker, 
normalized to the reference frequency.  The level result measurement accuracy 
will be improved if test speaker response calibration data is used.
Refer to sections 20-10, 20-11, and 20-16 for details.

f. Browse to an existing calibration file or create a new table by adding rows and 
values as required.

Note

When monitoring the signal from a microphone, it may be better to use a headset 
to avoid audible feedback.

To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.

Figure 15-6. Speaker Calibration
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g. Click [OK] to close the [Speaker Calibration] dialog.

h. Click [OK] close the [MT8855A] dialog.

6. Configure measurements.

a. Click  on the [Manual Test] tab to open the dialog shown 
below.

b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997 Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

Figure 15-7. [Measurement] Dialog
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c. Set the “Measurement Resolution”.

"Measurement Resolution" refers to the resolution of the FFT.  The “Normal” 
setting captures 4kbytes of data and the “High” setting captures 8kbytes of data.  
The extra resolution resulting from the “High” setting enables THD+N, THD, 
SINAD, stereo separation, and stereo phase measurements to be made from 
150 Hz to 20 kHz.  At the “Normal” setting the lowest frequency these 
measurements can be made at is 300 Hz.  The "Measurement Resolution" setting 
does not have any effect on the multiple frequency level test or the frequency 
response graph.

d. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Six measurements display numeric results only, and four display graphical 
results. 

When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

e. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.

f. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.

Figure 15-8. [Limits] Tab
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g. Repeat steps (d) to (f) for each of the measurements to be run.

h. Perform PESQ calibration if PESQ measurements are to be run.  Refer to section 
20-16 for details.

i. Click [OK] when complete to close the [Configure Measurements] dialog.

7. Click  to open the [Configuration Diagram] window.  

8. Select “Display Stereo Headset” from the drop-down list in the top left on the window 
and check that the actual configuration of the equipment matches the configuration 
shown in the figure.  If the configurations do not match, check that the MT8855A role 
and configuration settings are correct for the required application.

15-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

15-4 Viewing Test Results
Measurement results display at the right side of the BlueAudio interface.  Graphical 
measurements display at the top and all numeric results display in the [Numeric Results] 
window.

15-5 Understanding Test Results

Frequency Response and Multiple Frequency Level Test.

It is standard practice to set the reference frequency to 997 Hz for these tests.  When using 
the Headset or Hands-free profile that mandates the CVSD codec, a typical device interfaced 
to the MT8855A Line audio connectors with cables, will show that other tones within the 
range 300 Hz to 3 kHz are ± 3 dB of the reference tone.

When performing this test using test microphones and speakers, the low frequency response 
is likely to be limited to >500 Hz by the small physical size of the speaker.  This frequency 
response will also be affected by the mechanical coupling between the speaker and the 
microphone.  For the best low frequency response, the headset speaker should be acoustically 
coupled with the microphone directly opposite using a custom test fixture.  If the speaker is 
radiating into open space, low frequency response will be lost.  It is common to see large 
variations in the multiple frequency level test or frequency response curves when using 
microphones and speakers in the test setup.  The flatness of the response can be modified by 
adjusting the distance between the speaker and microphone and by the mechanics of the test 
fixture used to couple the sound between speaker and microphone.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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THD+N

For a standard reference tone of 997 Hz, this test will typically show a THD+N measurement 
of > -17 dB when interfaced to the MT8855A Line audio connectors with cables.  Actual 
performance depends on the performance of the audio signal path, amplifiers, and ADC/DAC 
devices.

When using a microphone and speaker in the test configuration, the THD+N performance of a 
typical mono headset using the CVSD codec will be -10 to -20 dB.  It is important to shield the 
test microphone from background noise in the test environment as this will significantly 
degrade the THD+N measurement result.

THD

For a standard reference tone of 997 Hz, when interfaced to the MT8855A Line audio 
connectors with cables, this test will typically show a THD measurement result of 5 dB better 
than for THD+N.  If the DUT is operating at close to maximum signal level for a CVSD codec, 
the CVSD codec exhibits non-linear behaviour.  Under these conditions THD+N and THD will 
give similar results because the 3rd harmonic distortion will dominate the measurement 
result.  Actual performance depends on the performance of the audio signal path including 
amplifiers, and ADC/DAC devices.  The result is expected to be better than THD+N as noise 
is not included in the result.  For this reason, use of the THD measurement alone should be 
treated with caution, as devices exhibiting good THD performance may still exhibit 
compromised audio performance if the noise performance is poor.

THD is degraded if the DUT has poor linearity.  Noise can be added to the audio signal path 
through noisy amplifies or poor schematic layout resulting in the pick up of unwanted signals 
on the audio paths.

When using a microphone and speaker in the test configuration, the THD performance of a 
typical mono headset using the CVSD codec will be 15 to 20 dB.  Background noise in the test 
environment will not degrade the THD measurement result as significantly as is the case for 
the THD+N measurement.

Stereo Separation

This measurement does not apply to measurements made on mono headsets.

Stereo Phase

This measurement does not apply to measurements made on mono headsets.

PESQ

PESQ scores lie in the range -0.5 (worst) to +4.5 (best).  

When testing a device using cable connections (from RF test port to RF connector, and from 
the device to the test set audio line input and output), a typical PESQ score would be >4.0. 

The score may be reduced if the digital signal level of the audio connection is set to 0 dBFS 
and the device is optimized for lower digital audio levels.  In this case, reduce the digital 
signal level of the audio sent over the Bluetooth connection and repeat the test.

When testing a device using over-the-air connections (from the MT8855A to the device 
antenna, and acoustic coupling using accessory microphones and speakers to interface to a 
fully assembled headset), a typical PESQ score would be between 2.7 to 3.7. 

The score may be reduced under any of the following conditions:
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• If interference from other RF sources results in dropped packets in the Bluetooth 
connection.

• If background noise is picked up by the device or test system microphone.

• If there is frequency response and distortions introduced by the device and test system 
microphones and speakers.

• If the digital signal level is set above the level that the test device is optimized to 
receive.

THD+N vs Level

This test is designed for use during product design evaluation.  It graphically displays the 
usable signal level range of a DUT.  For small signal levels, the THD+N will be limited by 
system noise, and for large signal levels the result will be limited by saturation of the DUT 
input stages.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.

THD+N vs Frequency

This test is designed for use during product design evaluation.  It graphically displays the 
distortion within the DUT across a range of audio frequencies.  The frequency range is limited 
to 300 Hz to 1 kHz so that an acceptable number of harmonics can be measured.  At 997 Hz, 
when testing a CVSD device, the number of harmonics measured is limited by the CVSD 
codec to 3.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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Chapter 16 — Testing a Bluetooth 
Stereo Headset: Speaker Output

16-1 Test Overview
A Bluetooth stereo headset is the generic name given to a Bluetooth headset capable of 
automatically switching between A2DP and HSP/HFP profiles for seamless handling of music 
streams and incoming calls.

The test described in this chapter is used to confirm that an audio signal, transmitted by a 
MT8855A running the Hands-free or Headset profile, can be sent to a stereo headset, routed 
through the RF, codec, and amplifier, and output from the speakers without distortion.  The 
output audio tone is picked up by two calibrated microphones and fed back to the MT8855A 
audio analyzer.

16-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 17.

Figure 16-1. Testing a Bluetooth Stereo Headset: Speaker Output



Preparing to Test Testing a Bluetooth Stereo Headset: Speaker Output

16-2 PN: 13000-00280  Rev. D MT8855A Operation Manual

3. Configure the Bluetooth profile and MT8855A role.

a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Audio Measurements”.

c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” to “HFP”.  (Refer to chapter 6 for an explanation of the Bluetooth 
profiles.)

e. Set “MT8855A Role” to “Audio Gateway”.  (Refer to chapter 6 for an explanation 
of the MT8855A role settings.) 

f. Select or clear the "Use Ring" check box as required.  If the check box is cleared 
(the default setting), the incoming call is accepted automatically without the user 
needing to press the call accept button on the headset.  If the check box is 
selected, the user will need to press the call accept button on the headset to 
accept the call.  Selecting the check box would only be required by users 
specifically wishing to test the functionality of the button on the headset.

g. Set “DUT Test Item“ to “Two Speakers”.  (As we are testing both right and left 
side speakers.)

h. Select the required “SCO Connection”.  The MT8855A defaults to SCO using HV3 
packets.  The packet type can be changed by clearing the “Use Defaults” check 
box, clicking [Advanced] and selecting a different setting.  All SCO packet types 
are defined in Appendix D.

Note

The following points should be observed to ensure that satisfactory measurement 
results are obtained:

• The DUT should be positioned in a shielded acoustic box.

• The MT8855A should be positioned away from sources of strong magnetic 
fields, power supplies, and CRT displays.

Figure 16-2. [Bluetooth Profile] Dialog for Ultimate Headset Speaker Testing
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i. Click [OK] when complete.

4. Configure a Bluetooth connection between the MT8855A and the DUT.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the 
documentation supplied with the product.

b. Click  to open the dialog shown below.

c. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

d. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

Figure 16-3. [Bluetooth Connection] Dialog

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment.  
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e. Enter the “Passkey”.  Connection with the DUT will be rejected unless the correct 
passkey specified.  The passkey is typically “0000” but this may differ depending 
on the DUT in question.  Refer to the documentation supplied with the product.

f. Select or clear the "Allow DUT Initiated Connections" check box as required.  
After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

g. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5dBm; for cable connections the output 
power is nominally -40 dBm.

h. Click [OK] to close the [Connection Setup] dialog.

i. Establish the Bluetooth connection.

• If “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If “Address Source was set to a “Inquiry” or “Inquiry + Name”, the button 
beneath [Configure Connection] displays as . Click this 
button to display an [Inquiry Results] dialog, select the required DUT and 
click [Connect].

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Note
As the headset does not have an interface from which a Bluetooth connection can 
be established, the initial connection must always be made from the MT8855A.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

Figure 16-4. Testing a Bluetooth Stereo Headset: Speaker Output
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a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

b. Set “Analogue Input” to “Mic”.  (As seen in the configuration diagram on the 
previous page, the microphone cables feed into the left and right channel 
microphone input socket.)

c. Select “Phantom Power On” if required by the microphone in use.  Phantom 
power is a 48 V DC supply used to power capacitor-based microphones.  Select 
“Phantom Power On”  whenever the external microphone connected to the 
microphone input of MT8855A requires DC power.  If selected, the phantom 
power indicator on the BlueAudio status bar changes from red to green.

d. Set “Range” to “Auto”.

Figure 16-5. [MT8855A] Dialog for Bluetooth Stereo Headset Speaker Testing

Note
Both of the Anritsu microphones available as optional accessories (2000-1607-R 
and 2000-1608-R) require the use of phantom power.
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The “Auto” setting is suitable for all normal signals under test.  If the signal 
under test has excessive noise the auto range algorithm on the MT8855A may 
fail.  In this case use of the manual range is required.  Refer to section 18-13 for a 
list of the manual range settings.

e. Set the "Bluetooth Digital Output".

Use the slider to set the Bluetooth digital output to the maximum signal level 
that the device under test is designed to receive.  This will typically be a value 
between -3 and -12 dBFS.

f. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A.  Select “Analogue Audio Input” to 
hear the signal picked up by the microphone.  Select “Transmitted Bluetooth 
Audio” to hear the signal relayed over the Bluetooth connection from the 
MT8855A to the DUT.

g. Set the monitor “Level” setting to the required volume.

Note

When monitoring the signal from a microphone, it may be better to use a headset 
to avoid audible feedback.

To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.
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h. Apply microphone correction if required by the microphone in use.  Select “Apply 
Microphone Correction” and click [Microphone Calibration] to display the dialog 
below.  Correction is used to compensate for the frequency response of the 
microphone, normalized to the reference frequency.  Anritsu microphones are 
supplied with a calibration curve (see Table 1-2 on page 1-5 for details).  

i. Browse to an existing calibration file or create a new table by adding rows and 
values as required.

j. Click [OK] to close the [Microphone Calibration] dialog.

k. Click [OK] close the [MT8855A] dialog.

Figure 16-6. Microphone Calibration
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6. Configure measurements.

a. Click  on the [Manual Test] tab to open the dialog shown 
below.

b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997 Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

Figure 16-7. [Measurement] Dialog
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c. Set the “Measurement Resolution”.

"Measurement Resolution" refers to the resolution of the FFT.  The “Normal” 
setting captures 4kbytes of data and the “High” setting captures 8kbytes of data.  
The extra resolution resulting from the “High” setting enables THD+N, THD, 
SINAD, stereo separation, and stereo phase measurements to be made from 
150 Hz to 20 kHz.  At the “Normal” setting the lowest frequency these 
measurements can be made at is 300 Hz.  The "Measurement Resolution" setting 
does not have any effect on the multiple frequency level test or the frequency 
response graph.

d. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Six measurements display numeric results only, and three display graphical 
results. 

When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

e. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.

f. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.

Figure 16-8. [Limits] Tab
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g. Repeat steps (d) to (f) for each of the measurements to be run.

h. Perform PESQ calibration if PESQ measurements are to be run.  Refer to section 
20-16 for details.

i. Click [OK] when complete to close the [Configure Measurements] dialog.

7. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

16-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

16-4 Viewing Test Results
Measurement results display at the right side of the BlueAudio interface.  Graphical 
measurements display at the top and all numeric results display in the [Numeric Results] 
window.

16-5 Understanding Test Results

Frequency Response and Multiple Frequency Level Test.

It is standard practice to set the reference frequency to 997 Hz for these tests.  When using 
the Headset or Hands-free profile that mandates the CVSD codec, a typical device interfaced 
to the MT8855A Line audio connectors with cables, will show that other tones within the 
range 300 Hz to 3 kHz are ± 3 dB of the reference tone.

When performing this test using test microphones and speakers, the low frequency response 
is likely to be limited to >500 Hz by the small physical size of the speaker.  This frequency 
response will also be affected by the mechanical coupling between the speaker and the 
microphone.  For the best low frequency response, the headset speaker should be acoustically 
coupled with the microphone directly opposite using a custom test fixture.  If the speaker is 
radiating into open space, low frequency response will be lost.  It is common to see large 
variations in the multiple frequency level test or frequency response curves when using 
microphones and speakers in the test setup.  The flatness of the response can be modified by 
adjusting the distance between the speaker and microphone and by the mechanics of the test 
fixture used to couple the sound between speaker and microphone.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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THD+N

For a standard reference tone of 997 Hz, this test will typically show a THD+N measurement 
of > -17 dB when interfaced to the MT8855A Line audio connectors with cables.  Actual 
performance depends on the performance of the audio signal path, amplifiers, and ADC/DAC 
devices.

When using a microphone and speaker in the test configuration, the THD+N performance of a 
typical mono headset using the CVSD codec will be -10 to -20 dB.  It is important to shield the 
test microphone from background noise in the test environment as this will significantly 
degrade the THD+N measurement result.

THD

For a standard reference tone of 997Hz, when interfaced to the MT8855A Line audio 
connectors with cables, this test will typically show a THD measurement result of 5 dB better 
than for THD+N.  If the DUT is operating at close to maximum signal level for a CVSD codec, 
the CVSD codec exhibits non-linear behaviour.  Under these conditions THD+N and THD will 
give similar results because the 3rd harmonic distortion will dominate the measurement 
result.  Actual performance depends on the performance of the audio signal path including 
amplifiers, and ADC/DAC devices.  The result is expected to be better than THD+N as noise 
is not included in the result.  For this reason, use of the THD measurement alone should be 
treated with caution, as devices exhibiting good THD performance may still exhibit 
compromised audio performance if the noise performance is poor.

THD is degraded if the DUT has poor linearity.  Noise can be added to the audio signal path 
through noisy amplifies or poor schematic layout resulting in the pick up of unwanted signals 
on the audio paths.

When using a microphone and speaker in the test configuration, the THD performance of a 
typical mono headset using the CVSD codec will be 15 to 20 dB.  Background noise in the test 
environment will not degrade the THD measurement result as significantly as is the case for 
the THD+N measurement.

Stereo Separation

This measurement does not apply to measurements made on mono headsets.

Stereo Phase

Results for the stereo phase test case should be similar regardless of whether performed 
using Line inputs or microphones and speakers.

The result of the stereo phase test case does not typically show variations between all 
products of the same design.  The phase is determined by the schematic layout of the DUT's 
audio circuits and components.  A good design will show that stereo phase between left and 
right channels is <10 degrees and typically around 5 degrees.

If the result is around 180 degrees, this indicates that one of the audio channels has been 
assembled with the cables reversed.  As this is a common assembly mistake, the test is often 
performed in production specifically to identify this assembly error.

PESQ

PESQ scores lie in the range -0.5 (worst) to +4.5 (best).  

When testing a device using cable connections (from RF test port to RF connector, and from 
the device to the test set audio line input and output), a typical PESQ score would be >4.0. 
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The score may be reduced if the digital signal level of the audio connection is set to 0 dBFS 
and the device is optimized for lower digital audio levels.  In this case, reduce the digital 
signal level of the audio sent over the Bluetooth connection and repeat the test.

When testing a device using over-the-air connections (from the MT8855A to the device 
antenna, and acoustic coupling using accessory microphones and speakers to interface to a 
fully assembled headset), a typical PESQ score would be between 2.7 to 3.7. 

The score may be reduced under any of the following conditions:

• If interference from other RF sources results in dropped packets in the Bluetooth 
connection.

• If background noise is picked up by the device or test system microphone.

• If there is frequency response and distortions introduced by the device and test system 
microphones and speakers.

• If the digital signal level is set above the level that the test device is optimized to 
receive.

THD+N vs Level

This test is designed for use during product design evaluation.  It graphically displays the 
usable signal level range of a DUT.  For small signal levels, the THD+N will be limited by 
system noise, and for large signal levels the result will be limited by saturation of the DUT 
input stages.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.

THD+N vs Frequency

This test is designed for use during product design evaluation.  It graphically displays the 
distortion within the DUT across a range of audio frequencies.  The frequency range is limited 
to 300 Hz to 1 kHz so that an acceptable number of harmonics can be measured.  At 997Hz, 
when testing a CVSD device, the number of harmonics measured is limited by the CVSD 
codec to 3.

The actual levels over which a device shows acceptable performance are dependent on each 
DUT design.
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Chapter 17 — Testing Bluetooth 
Audio Using Pass Through Mode

17-1 Test Overview
In pass through mode, the MT8855A acts as a Bluetooth transmitter / receiver and all 
MT8855A audio measurements are turned off.  Externally generated analogue signals are 
supplied through the line input and transmitted over Bluetooth to the DUT.  Audio 
transmitted over Bluetooth from the DUT to the MT8855A is fed through the line output to an 
external audio analyzer.

17-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

3. Configure the Bluetooth profile and MT8855A role.

a. Click the [Manual Test] tab.

b. Set “System Mode” to “Bluetooth Pass Through”.

Figure 17-1. Bluetooth Pass Through Measurements
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c. Click  to open the [Bluetooth Profile] dialog.

d. Set “Profile” as required.  (Refer to chapter 7 for an explanation of the Bluetooth 
profiles.)  

• If “Profile” is set to “HSP” or “HFP”, follow steps [e] and [f] below.

• If “Profile is set to “SCO/eSCO”, jump to step [g] below.

e. Set “MT8855A Role” to “Audio Gateway” or “Device” as required.  (Refer to 
chapter 6 for an explanation of the MT8855A role settings.) 

f. Select or clear the "Use Ring" check box as required.  If the check box is cleared 
(the default setting), the incoming call is accepted automatically without the user 
needing to press the call accept button on the headset.  If the check box is 
selected, the user will need to press the call accept button on the headset to 
accept the call.  Selecting the check box would only be required by users 
specifically wishing to test the functionality of the button on the headset.

g. Select the required “SCO Connection”.  The MT8855A defaults to SCO using HV3 
packets.  The packet type can be changed by clearing the “Use Defaults” check 
box, clicking [Advanced] and selecting a different setting.  All SCO packet types 
are defined in Appendix D.

h. Click [OK] when complete.

4. Configure a Bluetooth connection between the MT8855A and the DUT.

a. Configure the DUT to enable pairing (discoverable mode).  The procedure to 
enable pairing differs depending on the DUT in question.  Refer to the 
documentation supplied with the product.

Figure 17-2. [Bluetooth Profile] Dialog for Pass Through Mode

Note The “SCO Connection” setting is not applicable if “Profile” is set to “HSP”.
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b. Click  to open the dialog shown below.

c. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

d. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

e. Enter the “Passkey”.  Connection with the DUT will be rejected unless the correct 
passkey specified.  The passkey is typically “0000” but this may differ depending 
on the DUT in question.  Refer to the documentation supplied with the product.

Figure 17-3. [Bluetooth Connection] Dialog

Note
The “Maximum Responses”, “Inquiry Timeout”, and “Filter” settings can be used to 
control the length and extent of the inquiry to match the test environment.  
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f. Select or clear the "Allow DUT Initiated Connections" check box as required.  
After an initial connection, certain DUTs may automatically attempt to re-
establish a previous Bluetooth connection whenever powered on.  Users 
performing measurements on the same DUT over an extended period may opt to 
select the "Allow DUT Initiated Connections" check box, allowing the DUT to 
reconnect in this manner.  Alternatively, users performing tests on a number of 
varying DUTs may find it useful to clear the "Allow DUT Initiated Connections" 
check box, preventing unwanted connections from DUTs that have previously 
been connected to the test set.

g. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5dBm; for cable connections the output 
power is nominally -40 dBm.

h. Click [OK] to close the [Connection Setup] dialog.

i. Establish the Bluetooth connection.

• If “Address Source” was set to a “User Defined” Bluetooth address, the 
button beneath [Configure Connection] displays as .  
Click this button to establish a Bluetooth link with the specified DUT.

• If “Address Source was set to a “Inquiry” or “Inquiry + Name”, the button 
beneath [Configure Connection] displays as . Click this 
button to display an [Inquiry Results] dialog, select the required DUT and 
click [Connect].

When a Bluetooth connection is successfully established, the DUT address and user 
friendly name display on the [Manual Test] tab, and the “Status” field in the status bar 
changes to “Connected”.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.
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5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown again in the figure below.

a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

Figure 17-4. Bluetooth Pass Through Measurements

Figure 17-5. [MT8855A] Dialog for Pass Through Testing
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b. In the “Analogue Input” frame select the “Line” input.  The “Level” control is used 
to set the RMS (and peak) voltage that will generate 0 dBFS on the transmitted 
Bluetooth signal from the MT8855A to the DUT.

c. In the “Analogue Output” frame set the “Line” output level to the RMS (and 
peak) voltage that will result from a 0 dBFS signal being received over Bluetooth 
from the DUT.

d. Click [OK] close the [MT8855A] dialog.

6. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

7. Connect the audio analyzer to the line output of the MT8855A.

8. Click [Calibrate] to adjust the Analogue Output “Level” to match that specified in the 
“Analogue Output” of the [MT8855A] dialog.  The output level must be calibrated 
before the run button becomes available.  If the output level is changed it is necessary 
to repeat the calibration process.

17-3 Preparing for Measurements

Click  to configure the instrument as set in the procedure above.  Measurements 
must be made using external instruments.

Note
The voltage set in (c) above is only valid following the calibration procedure 
described below.
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Chapter 18 — Testing Analogue 
Audio

18-1 Test Overview
In addition to its roles as a Bluetooth audio test set, the MT8855A can also be used as a stand-
alone audio signal generator and analyzer.

There are a number of configurations that could be used when making measurements on a 
non-Bluetooth signal. A signal could be output from the MT8855A to a calibrated speaker, or 
a signal input for measurement by means of a line or calibrated microphone.

This chapter describes the procedure for routing a non-Bluetooth audio signal through a 
graphic equalizer and back to the MT8855A for audio analysis.

18-2 Preparing to Test
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment as shown in the example below.

a. Set up the equipment as shown in the figure below.

b. Turn on all equipment and start BlueAudio.

3. Click the [Manual Test] tab.

4. Set “System Mode” to “Analogue Audio Measurements”.

5. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT as shown on the previous page.

Note
This chapter describes the procedures that the user must follow to perform this 
test from the BlueAudio [Manual Test] tab.  Testing can also be performed from the 
[Auto Test] tab as explained in chapter 19.

Figure 18-1. Testing Audio without Bluetooth
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a. Click  on the [Manual Test] tab to open the [Configure 
MT8855A] dialog.

b. Set “Analogue Input” to “Line”.  (As seen in the configuration diagram on the 
previous page, the audio signal is fed back to the MT8855A through the left 
channel line connector.)

c. Set “Range” to “Auto”.

d. Set “Analogue Output” to “Line”.  (As seen in the configuration diagram, the left 
channel line out socket is occupied.)

e. Set “Analogue Type” to “Mono (One speaker)”.

f. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select whether the 
output heard from the internal speaker or headset during testing is relayed from 
the input to, or output from, the MT8855A. In this particular case, select 
“Analogue Audio Output” to hear the signal from the MT8855A, or select 
“Analogue Audio Input” to hear the signal from the graphic equalizer.

Figure 18-2. [MT8855A] Dialog for Testing Audio without Bluetooth
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g. Set the monitor “Level” setting to the required volume.

h. Click [OK] close the [MT8855A] dialog.

6. Configure measurements.

a. Click  on the [Manual Test] tab to open the dialog shown 
below.

b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997 Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

Note
To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.

Figure 18-3. [Measurement] Dialog
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c. Set the “Measurement Resolution”.

"Measurement Resolution" refers to the resolution of the FFT.  The “Normal” 
setting captures 4 kilobytes of data and the “High” setting captures 8 kilobytes of 
data.  The extra resolution resulting from the “High” setting enables THD+N, 
THD, SINAD, stereo separation, and stereo phase measurements to be made 
from 150 Hz to 20 kHz.  At the “Normal” setting the lowest frequency these 
measurements can be made at is 300 Hz.  The "Measurement Resolution" setting 
does not have any effect on the multiple frequency level test or the frequency 
response graph.

d. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. 

Six measurements display numeric results only, and three display graphical 
results. 

When the check box is selected a check mark () appears within the box to 
denote that it has been selected.

e. Configure the measurement as required by enabling and entering values on the 
[Settings] tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.

f. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.  

Figure 18-4. [Limits] Tab
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g. Click [OK] when complete to close the [Configure Measurements] dialog.

7. Click  and check that the actual configuration of the equipment 
matches the configuration shown in the figure.  If the configurations do not match, 
check that the MT8855A role and configuration settings are correct for the required 
application.

18-3 Running Tests
Click either of the run buttons to commence measurement. 

Click  to execute the specified measurements once.

Click  to execute the specified measurements in a continuous loop until the stopped 

by clicking .

18-4 Viewing Test Results
The audio signal looped back from the graphic equalizer displays in the [Frequency Response] 
window. Changes made to the controls on the graphic equalizer are immediately plotted on 
the frequency response trace.

Note Refer to chapter 20 for details of saving, printing, and manipulating data.
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Chapter 19 — Auto Testing

19-1 Auto Testing Overview

In addition to configuring measurements from the [Manual Test] tab, BlueAudio also 
provides an [Auto Test] tab from which the user can define and save a “Test Plan” of multiple 
measurements groupings.  

Each test plan comprises multiple component sections known as “Test Cases”.  Each test case 
comprises between one and six audio measurements.  Once defined, test plans can be  saved, 
recalled, and modified whenever required.

The Bluetooth profile, the MT8855A configuration, and the measurements to be executed can 
be defined independently within each of the component test cases.  Once configured, the 
entire test plan, or any of the component parts, can then be executed with no further 
interaction from the user. 

If, for example, the user were testing a multi-profile headset, a test plan could be created with 
three component test cases: a first to test the A2DP sink, a second to test the microphone 
after switching to Handsfree profile, and a third to test the headset speaker. This structure is 
shown in the figure below.

Note
Auto Testing is not available if the “System Mode” setting on the [Manual Test] tab 
is set to “Bluetooth Pass Through”.

Figure 19-1. Test Plan WIth Three Test Cases



Creating a Test Plan Auto Testing

19-2 PN: 13000-00280  Rev. D MT8855A Operation Manual

19-2 Creating a Test Plan
1. Install BlueAudio and the associated USB driver as detailed in chapter 4.

2. Configure the equipment as required.

3. Turn on the PC, MT8855A, and the DUT.

4. Start BlueAudio by double-clicking the “BlueAudio” icon generated on the desktop 
during installation, or by accessing the Windows programs directory and selecting 
[Anritsu] > [BlueAudio].

5. If multiple MT8855A test sets are connected to the PC running BlueAudio, select the 
test set from the status bar on the main [Anritsu BlueAudio] window.  Refer to page 20-
1, “Active Test Set - Selecting” for further details.

6. Click the [Auto Test] tab.  The [Auto Test] tabbed page displays as shown in the figure 
below.

Note

If, as in the figure on the previous page, the test plan includes test cases to 
measure the performance of differing aspects of the DUT, the user must ensure 
that the MT8855A and the DUT are preconfigured to enable all measurements.  In 
the example of a multi-profile stereo headset, this would necessitate setting up 
audio inputs for the microphone, and an audio outputs for the speaker.  Failure to 
have the equipment preconfigured in this manner will result in incomplete or 
erroneous results for the test case in question.

Full details of the configurations required for each specific type of audio testing are 
provided in chapters 9 to 18.

Figure 19-2. [Auto Test] Tab
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7. Right-click “Test Plan”, select [Rename] from the pop-up menu, and assign an 
appropriate name.

8. Right-click “New Test Case”, select [Rename] from the pop-up menu, and assign an 
appropriate name.

9. Configure the test case as required.  This can be performed in two ways:

• Manually, by following steps 10 to 14 below.

• Automatically, by right-clicking the test case name and selecting [Copy from 
Manual Test] from the pop-up menu.  The test case is populated with the settings 
configured at the time on the [Manual Test] tab.  Jump to step 15 in this 
procedure.

10. Select or clear the “Bluetooth” check box as required.  A check mark () displays in the 
box to indicate that Bluetooth is selected for use.

Figure 19-3. Rename Test Plan

Figure 19-4. Rename Test Case

Note
Removing the check mark is required only if wanting to define a test case within 
which the audio generator and analyzer are used to make measurements on a 
non-Bluetooth audio signal.
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11. Configure the Bluetooth profile for the new test case.

a. Double click [Profile] in the test plan tree to open the [Bluetooth Profile] dialog 
shown below.  This dialog can also be opened by right-clicking [Profile] and 
selecting [Configure] from the pop-up menu.

b. Set the “Profile” as required.  (Refer to chapter 6 for an explanation of the 
Bluetooth profiles.)

c. Set the “MT8855A Role” as required. (Refer to chapter 6 for an explanation of the 
MT8855A role settings.) 

d. If applicable, set “DUT Test Item“ (or “MT8855A Function”) as required.

e. For HFP or HSP profiles, select the required “SCO Connection”.  The MT8855A 
defaults to SCO using HV3 packets.  The packet type can be changed by clearing 
the “Use Defaults” check box, clicking [Advanced] and selecting a different 
setting.  All SCO packet types are defined in Appendix D.

f. Click [OK] when complete.

Figure 19-5. [Bluetooth Profile] Dialog

Note
Refer to chapters 9  to 18 for details of the configurations required for each specific 
type of audio testing.
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12. Configure a Bluetooth connection between the MT8855A and the DUT.

a. Double click [Connection] in the test plan tree to open the [Connection Setup] 
dialog shown below.  This dialog can also be opened by right-clicking 
[Connection] and selecting [Configure] from the pop-up menu.

b. Select the “Address Source” from the three options available.

• Select “User Defined” to enter a known Bluetooth address directly into the 
entry field, or select a previously used address from the drop-down list.

• Select “Inquiry” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices.  

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of 
discovered Bluetooth devices that may include user-friendly names when 
available.

c. Select or clear the "Test Set Initiates" check box as required. Some devices 
operate smoothly only if they initiate the pairing process. Clearing the "Test Set 
Initiates" check box prevents the tester from initiating pairing. 

Figure 19-6. [Bluetooth Connection] Dialog

Note

When testing in Auto Test mode, the "Address Source" should be set only after 
giving careful consideration to the following points:

Selecting "User Defined" will necessitate that the user change the Bluetooth 
address each time that the test case is run on a different DUT.  This will be time-
consuming when using the test case on multiple, differing products.

The "Inquiry" or "Inquiry + Name" settings are more suitable for Auto Mode, but, as 
"Maximum Responses" is limited to 1 in Auto Mode, these should only be used if 
the user is confident that the first device to respond will be the device upon which 
tests are to be conducted.  This will not be a problem if using a cable connection or 
positioning the DUT in a shielded enclosure.
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d. Enter the “Passkey” to match that of the DUT.  Connection with the DUT will be 
rejected unless the correct passkey specified.  The passkey is typically “0000” but 
this may differ depending on the DUT in question.  Refer to the documentation 
supplied with the product.

e. Clear the “Allow DUT Initiated Connections” check box.

f. Set the “RF Connection Path” between the MT8855A and the DUT.  Select either 
a cable or air connection to match the instrument configuration.  For air 
connections, connect a suitable antenna to the MT8855A Bluetooth connector 
port.  Anritsu provide a 2.4 GHz antenna and adaptor as an optional accessory 
(option number 2000-1613-R).  For air connections, the output power of the 
MT8855A transmitter is nominally -5dBm; for cable connections the output 
power is nominally -40dBm.

g. Click [OK] to close the [Connection Setup] dialog.

13. Configure the MT8855A settings within BlueAudio to match the physical configuration 
of the MT8855A and DUT.

Note Auto Test does not support DUT initiated connections.

Note
For reliable air connections the DUT should be positioned within 5 meters of the 
MT8855A.

Note
Refer to chapters 9 to 18 for details of the configurations required for each specific 
type of audio testing
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a. Double click [MT8855A] in the test plan tree to open the [MT8855A] dialog 
shown below.  This dialog can also be opened by right-clicking [MT8855A] and 
selecting [Configure] from the pop-up menu

b. Set “Analogue Input” as required to match the feeds into the MT8855A for the 
test in question.  

c. Select “Phantom Power On” if required by the microphone in use.  Phantom 
power is a 48 V DC supply used to power capacitor-based microphones.  Select 
“Phantom Power On”  whenever the external microphone connected to the 
microphone input of MT8855A requires DC power.  If selected, the phantom 
power indicator on the BlueAudio status bar changes from red to green.

d. Set “Range” to “Auto”.

Figure 19-7. [Configure MT8855A] Dialog.

Note
Both of the Anritsu microphones available as optional accessories (2000-1607-R 
and 2000-1608-R) require the use of phantom power.
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The “Auto” setting is suitable for all normal signals under test.  If the signal 
under test has excessive noise the auto range algorithm on the MT8855A may 
fail.  In this case use of the manual range is required.  Refer to section 18-13 for a 
list of the manual range settings.

e. Set “Analogue Output” as required to match the feeds out of the MT8855A for the 
test in question.

f. Set the "Bluetooth Digital Output".

Use the slider to set the Bluetooth digital output to the maximum signal level 
that the device under test is designed to receive.  This will typically be a value 
between -3 and -12 dBFS.

g. Select the required “Monitor” setting.  The monitor setting does not affect the 
outcome of the selected measurements.  It allows the user to select what, if 
anything, is heard from the internal speaker or headset during testing.

h. Set the monitor “Level” setting to the required volume.

i. Apply speaker or microphone correction if required.  Correction is used to 
compensate for gain or loss relative to the ideal reference.

j. Click [OK] close the [MT8855A] dialog.

14. Select and configure the measurements to be included in the test case.

Note

When monitoring the signal from a microphone, it may be better to use a headset 
to avoid audible feedback.

To avoid hearing damage, care should be taken if using a headset to listen to the 
monitored signal.  Set the monitor level to a low value before adjusting to a 
comfortable level for the headset in use.
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a. Double click [Measurements] in the test plan tree to open the [Measurements] 
dialog shown below.  This dialog can also be opened by right-clicking 
[Measurements] and selecting [Configure] from the pop-up menu.

Figure 19-8. [Measurement] Dialog
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b. Specify the “Reference Frequency”.  

The "Reference Frequency" is the frequency at which all the measurements are 
made.  It is also the reference frequency used for the multiple frequency level test 
and frequency response graph.  The default value is set as 997 Hz.  This is the 
frequency specified by the Audio Engineering Society in their standard AES17 
for test instruments.  997 Hz is selected in relation to the standard sampling 
frequencies (8kHz for CVSD, 44.1 kHz and 48 kHz for the SBC codec) so that 
sampling in successive cycles occurs at different phases of the audio tone.  It 
ensures that an ADC or DAC is fully exercised because it is not harmonically 
related to the sampling rates.  If, for example, a 1 kHz sine wave is sampled at 48 
kHz it will be sampled at the same 48 phases of the sine wave in each cycle.

c. Set the “Measurement Resolution”.

"Measurement Resolution" refers to the resolution of the FFT.  The “Normal” 
setting captures 4kbytes of data and the “High” setting captures 8kbytes of data.  
The extra resolution resulting from the “High” setting enables THD+N, THD, 
SINAD, stereo separation, and stereo phase measurements to be made from 
150 Hz to 20 kHz.  At the “Normal” setting the lowest frequency these 
measurements can be made at is 300 Hz.  The "Measurement Resolution" setting 
does not have any effect on the multiple frequency level test or the frequency 
response graph.

d. Select the first measurement to be run by clicking the enable check box to the 
right of the measurement name. When the check box is selected a check mark 
() appears within the box to denote that it has been selected.

e. Configure the measurement as required by entering values on the [Settings] 
tabbed page. 

The settings for the measurement in question display automatically when a 
measurement is selected.  They can also be displayed by clicking the [Configure] 
button to the left of each measurement.
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f. Click the [Limits] tab and specify the associated limits as required by the 
measurement.  The specified limits are checked when the “Limit Checking” item 
on the [Settings] tab is selected.

g. Repeat steps (d) to (f) for each of the measurements to be run.

h. Perform PESQ calibration if PESQ measurements are to be run.  Refer to section 
20-16 for details.

i. Click [OK] when complete to close the [Configure Measurements] dialog.

j. If wishing to perform each of the measurements more than once, right-click 
“Measurements” and select [Set Loop Count] from the pop-up menu.

Figure 19-9. [Limits] Tab

Figure 19-10.Set Loop Count
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k. The [Loop Count] dialog allows the user to specify the number of times that the 
measurements selected in the [Measurements] dialog will be performed on the 
current DUT.

15. Add additional test cases to the test plan as required.  Any number of test cases can be 
added and, presuming that the instrumentation is configured accordingly, each can be 
configured with differing profile, configuration, and measurement settings.  Additional 
test cases can be added using either of the methods outline below.

Method 1:

a. Right-click the test plan name and select [Add Test Case] from the pop-up menu.  
A second test case, titled “New Test Case, is added to the test plan.

b. Rename the new test case as explained earlier in this procedure.

Figure 19-11. [Loop Count] Dialog

Figure 19-12.Add Test Case
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Method 2:

a. Right-click the existing test case and select [Duplicate] from the pop-up menu.  A 
duplicate of the original test case is generated in the test plan tree with an 
incremented number in parenthesis after the test case name. 

b. Rename the new test plan as explained earlier in this procedure

16. Configure the new test case(s) as required.  This can be performed in three ways:

• By manually specifying or editing the settings as explained previously in steps 9 
to 14.

• By right-clicking the test case name and selecting [Copy from Manual Test] from 
the pop-up menu.  The test case is populated with the settings configured on the 
[Manual Test] tab.

Figure 19-13.Duplicate a Test Case
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• By right-clicking the test case name and selecting [Use Default Values] from the 
pop-up menu.  The test case is populated with the default values as defined in 
Appendix B of this manual.

17. Select all test cases to be executed when the test plan is run. The main branch of each 
test case carries a check box that must be selected as shown in the figure below.  Only 
the selected test cases are included in the test plan.

18. Select or clear the “Add Results To Database” check box as required.  If the check box is 
selected (as shown in Figure 17-15), a report of the test plan results is added to the 
database.  The results database can be viewed at any time by selecting [Report 
Database...] from the [Tools] menu. An explanation of how to use the database to filter 
and view the reports is provided in chapter 18.

Note

The following points should be noted when configuring subsequent test cases 
within the test plan:

• The “Bluetooth” check box can be selected or cleared for each test case 
independently.

• The “Connection” branch within any of the test cases can be double-clicked 
to open the [Bluetooth Connection] dialog.  Unlike the other branches of the 
test case, the Bluetooth Connection settings cannot be configured 
independently for each test case. The most recently made settings are 
applied automatically to all test cases in the test plan.

• To ensure that the status of the DUT is always clearly defined, the Bluetooth 
connection is always broken and then re-established between consecutive 
(Bluetooth configured) test cases in the test plan.

• The settings within the [MT8855A] dialog can be configured independently 
for each test case within the test plan.  It should however be noted that 
these settings must reflect the physical setup (audio inputs and outputs) of 
the MT8855A and the DUT.  When executing a test plan comprising of 
multiple test cases with different settings, the MT8855A and DUT must be 
configured to meet the requirements of each test case before executing the 
test plan.  Failure to have the equipment pre-configured in this manner will 
result in erroneous results for the test case in question.

Figure 19-14.Select Test Cases
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19. Select or clear the “Show Report On Completion” check box as required.  If the check box 
is selected (as shown in Figure 17-15), the report displays automatically when the test 
plan is complete.

20. If required, save the test plan for future use.  To do this, select [Save As...] from the 
[File] menu and specify a name and location to which the test plan will be saved.  Saved 
test plans can be imported into BlueAudio by selecting [Open Manual Test...] or [Open 
Auto Test...] from the [File] menu.  (Refer to chapter 20 for further details of saving and 
loading test settings.)

Figure 19-15.Auto Test Results and Report Options
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19-3 Running a Test Plan
1. Check that the DUT is powered on and ready to accept a connection from the MT8855A.

2. Click  to execute the test plan.

3. Status information displays in the [Auto Test Output] window as each stage of the test 
plan is commenced and completed.

Figure 19-16.  [Auto Test Output] 
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4. If the “Show Report On Completion” check box was selected, a test report displays 
automatically when the test plan is complete.

If the “Show Report On Completion” check box was not selected, a test report can be 
viewed by selecting [Report Database...] from the [Tools] menu. An explanation of how 
to use the database to filter and view the reports is provided in chapter 18.

Figure 19-17.Test Report
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Chapter 20 — Common Procedures

This chapter provides a quick reference to a number of simple procedures with which users 
will need to gain familiarity. The procedures are listed in alphabetical order based upon the 
most logical topic heading.

20-1 Active Test Set - Selecting
Multiple MT8855A units can be connected over the USB to the PC running BlueAudio.  Each 
connected test set is configured individually, the active test set being displayed in the  status 
bar of the main [Anritsu BlueAudio] window.

To change the active test set, click the status bar button as shown in the figure below and 
select the required test set from the pop-up menu.

20-2 Audio Levels - Adjusting
1. Click [Audio Levels] on the toolbar of the main [Anritsu Blue Audio] window.

2. The [Audio Levels] dialog opens as shown below.

3. Adjust the MT8855A speaker and monitor levels as required and close the dialog.

Figure 20-1. Active Test Set Selection

Figure 20-2. [Audio Levels]
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20-3 Autoscaling
1. Right-click any of the graphical trace windows and select [Y Axis Scale ] > [AutoScale] 

from the pop-up menu.

2. The Y-axis scaling is automatically adjusted so that the whole of the trace is displayed 
within the graph area.

20-4 Firmware - Updating
New versions of the MT8855A firmware can be downloaded from the Anritsu website as they 
become available.

1. Download the latest firmware from the Anritsu website (http://www.anritsu.com/
downloads/).

2. Turn on the MT8855A and start BlueAudio.

3. Connect the MT8855A to the PC using the USB cable provided.

4. Select [Firmware Update...] from the [Tools] menu to display the dialog below.

5. Click [Browse...] to locate the firmware file downloaded to the PC.

6. Click [Find Units] to display a list of all MT8855A units connected to the PC through 
the USB connection.

7. Select the check box next to the unit(s) to be upgraded.

8. Click [Load].  The current firmware is deleted and the new version installed.

Figure 20-3. [MT8855A Firmware Loader] Window

Note
Do not turn the MT8855A off or remove the USB cable until the update is 
complete.



Common Procedures Golden Trace - Displaying

MT8855A Operation Manual PN: 13000-00280  Rev. D 20-3

9. Click [Help] > [About BlueAudio] to confirm that the new firmware version is displayed.

20-5 Golden Trace - Displaying
Frequency response traces for the right or left channel can be saved and then superimposed 
in the [Frequency Response] window as required.  These saved traces are known as ‘golden’ 
traces and are useful when verifying performance against an acceptable standard or when 
monitoring the effect of modifications in the test conditions.

1. Generate a frequency response trace that is suitable to save as a golden trace for the 
right or left channel.

2. Right-click the [Frequency Response] window and select [Golden Trace] > [Save As (Left 
Channel)...] or [Save As (Right Channel)...] from the pop-up menu.  The trace data is 
saved as a .gtd file at the specified location.

3. Right-click the [Frequency Response] window and select [Golden Trace] > [Open...]. 

4. Navigate to the golden trace saved in step 2 and click [Open].

5. Right-click the [Frequency Response] window and select [Golden Trace] > [Display].

6. Make further measurements to generate a new frequency response trace.

7. The golden trace and the active trace both display in the [Frequency Response] window 
and a comparison between the traces can be made with ease.

Note

To receive automatic notification of software releases, send a blank e-mail with the 
subject heading of "MT8855A Software Notification Request" to 
bluetooth.support@anritsu.com.  You will receive an e-mail when new software is 
available to download.

Figure 20-4. Golden Trace

Note
Only one golden trace (for either the left or right channel) can be displayed at any 
one time.
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20-6 Log Data - Outputting
The BlueAudio log capture tool can be used to generate a log of messages transmitted 
between the MT8855A and the DUT.  This log data can be analyzed by Anritsu support 
personnel if Bluetooth interoperability or connectivity difficulties are experienced with the 
DUT.

1. Select [Tools] > [Log Control..] to display the [MT8855A Internal Log Capture] dialog..

2. Select “Enable Logging” to enable the capture of log data during Bluetooth 
communication.

3. Click [Clear Log] to clear any previously generated log content before saving a new log.

4. Click [OK] to close the dialog.

5. Replicate the events that resulted in the error.

6. When the error has been replicated, display the [MT8855A Internal Log Capture] dialog 
again and click [Save Log] to save the log data as a text file.

7. Send the file to Anritsu in line with the instructions given in chapter 19.

Figure 20-5. [MT8855A Internal Log Capture] Dialog

Note

If submitting multiple error occurrences to Anritsu, users should always use [Clear 
Log] at the end of each error capture sequence.

The generated log data (.adl) file is not intended for analysis by the user.  Users 
should send the file to Anritsu and not try to open it.
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20-7 Markers - Positioning By Drag and Drop
1. Position the mouse pointer directly above the marker to be moved. The pointer changes 

to a double headed arrow as shown below.

2. Drag the marker to the required position.  The marker positions (A, B, and Delta) 
display in the area of the window immediately above the trace itself.

20-8 Markers - Positioning by Numeric Input
1. Right-click any of the graphical trace windows and select [Configure Markers] from the 

pop-up menu to display the dialog below.

2. Select the “Enable Markers” check box.

3. Enter positions for the markers as required.  

4. Click [OK] to close the dialog and display the markers at the specified position.

Figure 20-6. Dragging Markers

Figure 20-7.
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20-9 Measurement Results - Exporting to XML
1. Select [Export to XML] from the [File] menu or right-click any of the four graphical 

results windows and select [Export Data As...] from the pop-up menu.

2. Specify a file name and location in the normal manner and click [Save].

3. Start Microsoft Excel and select [File] > [Open..] to import the .xml file generated above.

4. Select “Use the XML Source task pane” in the [Open XML] dialog that displays.

5. A second dialog displays stating that the specified XML source does not refer to a 
schema.  Click [OK].

6. Drag and drop the required measurement files from the tree on the right to the blank 
Excel sheet.

7. When the files are dropped, a drop-down menu is accessible from the cell furthest to the 
right.  Open the drop-down menu and select “Place XML Heading Above”.  The 
headings appear in the row directly above.

8. Right-click any of the cells within the row and select [XML] > [Refresh XML Data] from 
the pop-up menu.  The cells are now populated with the appropriate data.

20-10 Microphone or Speaker Calibration Data - Creating
The steps below explain how to create microphone or speaker calibration data. Calibration is 
used to compensate for gain or loss introduced by the speaker or microphone relative to the 
ideal reference.

1. Click [Configure MT8855A] to open the [MT8855A] dialog.

2. Select the appropriate calibration setting.

• To create microphone calibration data, select “Apply Microphone Correction” and 
click [Microphone Calibration] to open the [Microphone Calibration] dialog.

• To create speaker calibration data, select “Apply Speaker Correction” and click 
[Speaker Calibration] to open the [Speaker Calibration] dialog.

3. Click [Add Row] to create a line in the frequency table to the right.

4. Click in the “Frequency” cell and enter an appropriate frequency value.

5. Select the required units of frequency.

6. Click in the “Response” cell and enter an appropriate response.

Note
Do not drop the files in the top row of the Excel sheet as this will not allow room for 
the associated headings.

Note

The “Apply Microphone Correction” selection box is not available unless 
“Analogue Input” is set to “Mic”.

The “Apply Speaker Correction” selection box is not available unless “Analogue 
Output” is set to “Speaker” 



Common Procedures Microphone or Speaker Calibration Data - Creating

MT8855A Operation Manual PN: 13000-00280  Rev. D 20-7

7. Add additional lines to the table as required and click [Update Graph] when complete.  
The data entered into the table appears in the graph as shown in the example below.

8. Once created, the calibration data can be saved for use again in the future.  Click [New] 
and browse to a location to which the data will be saved.  The file path displays in the 
“Calibration File” frame.

9. Click [Save Changes] to save the calibration data to the specified location.  Once saved, 
the calibration data can be imported at any time as explained in the procedure below.

10. Click [OK] to close the calibration dialog.

Figure 20-8. Microphone Calibration
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20-11 Microphone or Speaker Calibration Data - Importing
The steps below explain how to import microphone or speaker calibration data.  Calibration is 
used to compensate for gain or loss introduced by the speaker or microphone relative to the 
ideal reference.

1. Click [Configure MT8855A] to open the [MT8855A] dialog.

2. Select the appropriate calibration setting.

• To import microphone calibration data, select “Apply Microphone Correction” and 
click [Microphone Calibration] to open the [Microphone Calibration] dialog.

• To import speaker calibration data, select “Apply Speaker Correction” and click 
[Speaker Calibration] to open the [Speaker Calibration] dialog.

3. Click [Browse Existing], navigate to the calibration data file, and click [Open].  Refer to 
section 20-16 for details.  The data is imported to the table and graph as shown in the 
example below.       

4. Once imported, the data can be used as is, or can be edited as required by simply 
changing the frequency or response values, or by using the buttons to the right of the 
table.  Click [Update Graph] to reflect the changes in the graph.

5. Click [OK] to close the calibration dialog.

Note
The “Apply Microphone Correction” selection box is not available unless 
“Analogue Input” is set to “Mic”.  The “Apply Speaker Correction” selection box 
is not available unless “Analogue Output” is set to “Speaker” 

Figure 20-9. Microphone Calibration
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20-12 MT8855A Display Contrast - Adjusting
1. Select [MT8855A LCD Settings] from the [Tools] menu to display the dialog below.

2. Use the slider to adjust the contrast level as required and click [OK].  As the slider is 
moved, the text on the MT8855A display changes to match the setting.

20-13 MT8855A - Presetting
An instrument preset can be performed to return all settings for the selected instrument to 
their default settings.

1. Select the unit to be preset from the pop-up menu on the BlueAudio status bar (as 
shown in figure 18-1).

2. Select [Tools] > [Preset Instrument].

20-14 Multitone Measurement Mode - Using
In the multiple frequency level test, the MT8855A measures the relative audio level of the 
DUT at five user-defined frequencies.  Follow the procedure below to have these tones played 
simultaneously.

1. Click [Configure Measurements] to open the [Measurements] dialog.

2. Click “Multiple Frequency Level Test” to display the settings on the right side of the 
dialog.

3. Select “Multitone” from the drop-down selection box that displays in the uppermost cell 
of the “Value” column.

Figure 20-10.[MT8855A Display Settings] Dialog

Note
Presetting the instrument terminates all measurements being executed and drops 
the Bluetooth connection.

Note
If multitone frequency mode is selected, the maximum tone value is reduced from 
1 V to 1V / number of tones.
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20-15 Options - Enabling
1. Select [Tools] > [Options] > [Enable Option...].

2. Enter the two-digit option number and the supplied enable code.  For options 332 and 
333, enter option numbers 32 and 33 respectively.

3.  Click [Enable].

4. Click [Close] to close the dialog.

20-16 PESQ Measurements
PESQ (Perceptual Evaluation of Speech Quality) is an automated method of performing an 
end-to-end speech quality assessment for a network.  Follow the procedure below to perform 
PESQ measurements.

1. Click [Configure Profile] and check that BlueAudio is correctly configured to enable 
PESQ measurements.  The settings must match one of the following combinations:

• Profile = HSP, MT8855A Role = Audio Gateway

• Profile = HFP, MT8855A Role = Audio Gateway

• Profile = SCO/eSCO Only, MT8855A Role = Analyzer or Generator

2. Establish a Bluetooth connection with the EUT.  A Bluetooth connection is required in 
order to perform automatic calibration as detailed in step 7.

3. Click [Configure MT8855A] and select the appropriate “Analogue Input” or “Analogue 
Output” settings to match the configuration.  PESQ measurements are not available if  
“Analogue Input” or “Analogue Output” is set to “Off”.

4. Check that the line input and output cables are correctly connected.

5. Click [Configure Measurements] and select the PESQ "Enable" check box. 

Note
PESQ measurements cannot be performed on Audio Gateways as it would not be 
possible to isolate the Bluetooth connection from the performance of the 
gateway’s cellular network and the codecs.
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6. Click [PESQ Calibration] to display the dialog below.

Calibration must be performed before a PESQ measurement can be made.  Calibration 
optimizes the audio signal path gain such that the level of the recovered signal is 
similar to that of the original.  The PESQ cal dialogue can also be accessed at any time 
by clicking [PESQ Cal] on the toolbar.

7. Select the appropriate mode.

• The "Automatic" calibration mode is recommended.  Automatic mode is available 
only when the DUT is in a Bluetooth connection with the MT8855A. 

• “Manual” calibration can be used if a Bluetooth connection is not available but 
the required signal level (into the DUT microphone input or test speaker input, 
or the DUT output) is known.  

If the MT8855A is configured for line out or speaker, manual calibration adjusts 
the output of the MT8855A such that the signal level is set to the value specified 
in the “Full Scale Voltage” field, regardless of the impedance of the EUT 
connection.

If the MT8855A is configured for line in or microphone, manual calibration 
selects the appropriate input range for the value set at “Full Scale Voltage”.

8. Click [Run] to calibrate the analog signal range to minimize digital loss.

9. Click [Save] and specify a file name and location in the normal manner.  

10. Click [Exit] to close the [PESQ Calibration] dialog.  It is not necessary to repeat PESQ 
calibrations unless the test system configuration is changed.

11. Click [Reference File] and select the reference test signal from one of the three default 
folders: ASTS, USER and ITU.  The PESQ algorithm compares the reference signal to 
the degraded signal and outputs a PESQ score of between -0.5 and 4.5.

12. Click [Calibration File] and select the calibration file saved earlier. 

Figure 20-11.PESQ Calibration
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13. Click [OK] to close the [Measurements] dialog.  If PESQ measurements are selected, the 
[Measurements] dialogue cannot be closed unless a Reference File and Calibration File 
are selected.

14. Click  to run measurements once, or click  to run measurements in a 
continuous loop.   

20-17 Range Input - Using Manual Range
Follow the procedure below if excessive noise necessitates the use of a manual input range for 
microphone or line.

1. Click [Configure MT8855A] to open the [MT8855A] dialog.

2. Set the “Range” field to “Manual” and select the appropriate range from the drop-down 
list.  The ranges are detailed in the table below.

Users should select the lowest range that adequately covers the expected voltage of the 
test signal.  If, for example, the expected line input test signal was 1000 mV, it would be 
necessary to select input Range 3 (1024 mV).          

Note

If making PESQ and non-PESQ measurements together, consideration should 
always be given to the monitor volume setting.  Users may find it necessary to 
raise the monitor volume for the PESQ audio signals, but this higher setting may 
make non-PESQ tones uncomfortably loud especially when using headphones.

Table 20-1. Line Input Ranges

Range Maximum Input

Range 1 4096 mV

Range 2 1880 mV

Range 3 1024 mV

Range 4 512 mV

Range 5 256 mV

Range 6 128 mV

Range 7 64 mV

Range 8 32 mV

Range 9 16 mV

Table 20-2. Mic Input Ranges

Range Maximum Input

Range 1 200 mV

Range 2 93 mV

Range 3 50 mV

Range 4 25 mV

Range 5 12.5 mV
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20-18 Speaker Calibration Data - Saving from Trace
A speaker calibration data file can be saved from the frequency response and imported as 
described in procedure 20-11.  

1. Configure the equipment as shown in the figure below.  The distance between the 
speaker and the microphone should match the actual distance between the speaker and 
the DUT, typically around 10 cm.   

2. Start BlueAudio and set “System Mode” to “Analogue Audio Measurement”.

3. Click [Configure MT8855A].

4. Set “Analogue Input” to “Mic”, select “Phantom Power On”, and set “Analogue Output” 
to “Speaker”.

5. Click [Configure Measurements] and select the “Frequency Response” measurement.

6. On the [Settings] tab for the “Frequency Response” measurement, set “Start Frequency” 
and “Stop Frequency” as required.  Typically this is from 100 Hz to 4 kHz for HSP, 
HFP, SCO/eSCO applications.  When using speakers such as the accessory Anritsu 
speaker, the small cone size means that the speaker cannot function efficiently below 
around 100 Hz. 

7. Click [OK] to close the [Configure Measurements] dialog.

8. Click  to execute the specified measurements once.

9. When the measurements are complete, right-click anywhere within the [Frequency 
Response] window and select [Speaker Calibration] > [Save As (Left Channel)..].

10. Specify a name and location for file and click [Save].

11. The calibration data file generated above can be imported for use when making 
Bluetooth audio measurements.  Refer to section 20-11 for details.

Range 6 6.25 mV

Range 7 3.13 mV

Range 8 1.56 mV

Figure 20-12.Configuration for Acquiring Speaker Calibration Data File

Table 20-2. Mic Input Ranges

Range Maximum Input
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20-19 Test Case - Adding
1. Click the [Auto Test] tab.

2. Right-click the test plan name in the test plan tree and select [Add Test Case] from the 
pop-up menu.

3.  The test case displays in the test plan tree as shown below.

Figure 20-13.[Add Test Case]

Figure 20-14.Test Plan with New Test Case
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20-20 Test Case - Deleting
1. Click the [Auto Test] tab.

2. Right-click the test case to be deleted and select [Delete] from the pop-up menu.

20-21 Test Case - Duplicating
1. Click the [Auto Test] tab.

2. Right-click the test case to be duplicated.

3. Select [Duplicate] from the pop-up menu.

20-22 Test Case - Renaming
1. Click the [Auto Test] tab.

2. Right-click the test case to be renamed.

3. Select [Rename] and enter a new name.

20-23 Test Case Settings - Copying from Manual Test
Test cases on the [Auto Test] tab can be populated automatically by copying configuration 
and measurement settings from the [Manual Test] tab.

1. Click the [Auto Test] tab and add a new test case to the test plan.

2. Right-click the test case name and select [Copy from Manual Test] from the pop-up 
menu.

20-24 Test Case Settings - Copying To Manual Test
The setting dialogs on the [Manual Test] tab can be populated automatically by copying test 
case settings from the [Auto Test] tab.

1. Click the [Auto Test] tab.

2. Right-click the test case name from which settings will be copied and select [Copy to 
Manual Test] from the pop-up menu.

Figure 20-15. Delete Test Case
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20-25 Test Case Settings - Setting to Default
1. Click the [Auto Test] tab.

2. Right-click the name of the test case. 

3. Select [Use Default Values] from the pop-up menu. All settings for the test case in 
question revert to the default settings.  

20-26 Test Plan - Renaming
1. Click the [Auto Test] tab.

2. Right-click “New Test Plan” to display a pop-up dialog.

3. Select [Rename] and rename the test plan as required.

Figure 20-16.Rename Test Plan
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20-27 Test Plan Reports - Viewing
Test plan results display automatically if “Show Report On Completion” is selected when the 
test plan is executed.  

If “Add Results to Database” is selected, a test plan report is added to the reports database. 
The reports within the database can be filtered and displayed as outline below.

1. Select [Tools] > [Report Database] to open the window below.

2. Enter the “From” and “To” dates within which the reports in the database will be 
filtered.

3. Use the “Status” and “Measurement Filter” check boxes to filter the displayed results as 
required.  

4. If required, filter the displayed results to those of a specific device by selecting or 
entering the associated Bluetooth address in “DUT Bluetooth Address” entry field.  If 
the address entry field is left blank, all results that match the filtering requirements 
are displayed regardless of device type.

5. Click [Refresh] to display the filtered results.

6. Double click any of the rows within the results table to display the associated report.

Figure 20-17.[Report Database] Window
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20-28 Test Plan Report Database - Changing
By default, test plan results are written to the “BlueAudio Database 1.bdb” file whenever 
“Add Results To Database” is selected on the [Auto Test] tab.  This file can be duplicated, 
deleted, or moved as required to meet needs for separation of measurement results by product 
type.  Follow the procedure below to create and specify use of a new database file.

1. Select [File] > [Database...] to open the [Select or create a database file] dialog.

2. Specify a name for the new database in “File name” and click [Open].

The new file is created at the same location as the original and immediately adopted as 
the selected database.

3. Select [Tools] > [Report Database] to display the [Report Database] dialog.  The name of 
the newly generated database file is shown in the title bar. 

20-29 Test Settings - Loading
BlueAudio settings saved using the [Save As...] command can be loaded at any time.

1. Select [Open Manual Test...] or [Open Auto Test...] from the [File] menu.

2. Select the .sfm or .tpm file and click [Open] to populate the configuration dialogs with 
the settings from the selected file.

20-30 Test Settings - Saving
1. Select [Save As...] from the [File] menu.

2. Specify a file name and location in the normal manner and click [Save].

20-31 Traces - Printing
1. Right-click the required trace window and select [Print] from the pop-up menu.

2. Click [OK].

20-32 Trace Image - Saving as Image File
1. Right-click the required trace window and select [Save Image As...] from the pop-up 

menu.

2. Specify a file name and location in the normal manner and click [Save].
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20-33 Version Information - Viewing
1. Select [About BlueAudio...] from the [Help] menu on the toolbar of the main [Anritsu 

Blue Audio] window 

2. The [About BlueAudio] dialog opens displaying the version information for application, 
user interface, class library, and USB driver.

20-34 X-axis Scale - Changing
1. Right-click any of the four trace windows.

2. Select [X Axis Scale] from the pop-up menu.

3. Select either [Linear] or [Logarithmic].

20-35 Y-axis Scale - Auto-scaling
1. Right-click any of the four trace windows.

2. Select [Y Axis Scale] from the pop-up menu.

3. Select [Autoscale].

Figure 20-18.[About BlueAudio] Dialog
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20-36 Y-axis Scale - Configuring
1. Right-click any of the four trace windows.

2. Select [Y Axis Scale] from the pop-up menu.

3. Select [Configure] to display the dialog shown below.

Figure 20-19.[Y Axis Scale Configuration]
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Chapter 21 — Technical Assistance

21-1 Troubleshooting
This chapter provides a list of problems that may be experienced during testing.  If 
operational difficulties are experienced, check the listed items and suggested actions before 
contacting Anritsu for technical assistance.

1. I cannot establish a Bluetooth connection between the DUT and the 
MT8855A.

• Check whether the correct Bluetooth profile has been selected.  (Anritsu BlueAudio > 
[Manual Test] > [Configure Profile])

• Check whether the correct Bluetooth address has been selected. (Anritsu BlueAudio > 
[Manual Test] > [Configure Connection])

• Check whether pairing is enabled.  (Anritsu BlueAudio > [Manual Test] > [Configure 
Connection])

• Check whether the correct RF connection path is selected.  (Anritsu BlueAudio > 
[Manual Test] > [Configure Connection])

• Check whether the connection must be initiated from the DUT.

• Check whether the DUT is in a discoverable state.  (Refer to the manufacturer’s 
documentation for details of how to enable pairing.)

• Check whether authentication is required and/or set.

• Check whether the DUT is positioned too far away from the MT8855A.

• Check whether the DUT is already paired to another device.

2. The frequency response of my A2DP DUT is very poor and/or has 
resonances when using microphones / speakers

• Check whether microphone/speaker frequency response has been calibrated out.

• Check the coupling between test microphone/speaker and the DUT microphone/
speaker.

• Use an shielded enclosure to remove resonances.

3. The THD+N measurement is unstable

• Use an shielded enclosure to remove resonances.

• Check whether there are other sources of RF that may be causing instability.

4. There are clicks in the recovered audio

• The RF link quality may be poor.

• Check whether there are other sources of RF that may be causing instability.

• Use the Anritsu MT8852B to confirm radio BER/FER.
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5. The audio tone is not stable (wow or flutter)

• The DUT may take time to stabilize the audio when profiles are changed.

6. The FFT shows different response for left and right channels even with 
cable / line audio connections.

• This is quite possible due to internal architecture or layout of DUT.

7. The BlueAudio interface shows that I have established a connection, but 
I am not getting any audio measurement results

• Check that the MT8855A and DUT inputs/outputs are correctly configured.

• Check that the audio levels are set appropriately.  (Anritsu BlueAudio > Tool Bar > 
[Audio Levels])

• Check that the required measurements are selected in the [Measurements] dialog.

• Check the volume control settings on the DUT.

8. I cannot hear the audio tone on the MT8855A monitor speakers.

• Check whether the correct audio source has been selected for the MT8855A monitor 
speakers.

• Check that the audio levels are set appropriately.  (Anritsu BlueAudio > Tool Bar > 
[Audio Levels])

9. I want to use the audio generator or analyzer without making a 
Bluetooth connection.

• Set “System Mode” to “Analogue Audio Measurements”.  (Anritsu BlueAudio > [Manual 
Test] tab > “System Mode” = “Analogue Audio Measurements”)

10. When I do an inquiry, I get lots of responses and don’t know which to 
connect to.

• Use a shielded acoustic box.

• Select “Inquiry + Name” to run an inquiry and select the DUT from a list of discovered 
Bluetooth devices that may include user-friendly names when available.  (Anritsu 
BlueAudio > [Manual Test] tab > [Configure Connection])

11. I am unable to initiate a Bluetooth connection with the MT8855A from 
the DUT.

• Check whether the passkey specified at the DUT matches that within BlueAudio. 
(Anritsu BlueAudio > [Manual Test] tab > [Configure Connection])

• Check that the “Allow DUT Initiated Connections” check box is selected.  (Anritsu 
BlueAudio > [Manual Test] tab > [Configure Connection])
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12. I get spikes in my frequency response, THD+N vs level, or THD+N vs 
frequency traces.

• Audio distortion may be experienced if testing in an environment with other 
transmissions on 2.4 GHz (e.g., wireless LAN or other Bluetooth devices).

• Use a shielded acoustic box to remove resonances.

• Turn off potential sources of interference.

• If testing over-air, move the DUT as close to the antenna as possible.

21-2 Contacting Anritsu for Technical Assistance
If you have read the troubleshooting information above and still require technical support, 
send an e-mail with the information listed below to our technical support team at 
bluetooth.support@anritsu.com.

• A debug log (refer to the procedure below)

• MT8855A serial number

• BlueAudio version

• Description of the problem

• List of error messages displayed (BlueAudio and/or MT8855A)

• Description of procedure required to replicate the problem

• Details of steps already taken to correct the problem

Every effort will be made to investigate the problem and reply within one working day.

Full details of Anritsu contact information can be accessed at www.anritsu.com/Contact.asp

21-3 Outputting Log Data
The BlueAudio log capture tool can be used to generate a log of messages transmitted 
between the MT8855A and the DUT.  This log data can be analysed by Anritsu support 
personnel if Bluetooth interoperability or connectivity difficulties are experienced with the 
DUT.

1. Select [Tools] > [Log Control..] to display the [MT8855A Internal Log Capture] dialog..

Figure 21-1. [MT8855A Internal Log Capture] Dialog
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2. Select “Enable Logging” to enable the capture of log data during Bluetooth 
communication.

3. Click [Clear Log] to clear any previously generated log content before saving a new log.

4. Click [OK] to close the dialog.

5. Replicate the events that resulted in the error.

6. When the error has been replicated, display the [MT8855A Internal Log Capture] dialog 
again and click [Save Log] to save the log data as a text file.

7. Send the file to Anritsu in line with the instructions given in chapter 19.

Notes

If submitting multiple error occurrences to Anritsu, users should always use [Clear 
Log] at the end of each error capture sequence.

The generated log data (.adl) file is not intended for analysis by the user.  Users 
should send the file to Anritsu and not try to open it.

The user is required to re-pair with the DUT if the state of “Enable Logging” is 
changed or if the log is saved.
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Chapter 22 — BlueStart

22-1 What is BlueStart?
BlueStart is a simple application designed to help familiarize developers with the use of the 
MT8855 class library.  

This chapter describes the installation process and explains how to prepare the Visual Studio 
project installed with the source files so that BlueStart can be compiled successfully.

22-2 Installing BlueStart
1. Insert the product CD into the drive on the PC.  The [MT8855A Bluetooth Audio Test 

Set] window displays automatically.

2. Click "BlueStart" in the contents list.

3. The BlueStart setup wizard displays as shown below.  Click [Next>].

Figure 22-1. BlueStart Setup Wizard
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The "Licence Agreement" dialog displays.  Read the agreement and if you agree to the 
conditions, select "I Agree" and click [Next>].

A dialog displays asking the user to select whether to install the source files.  Click “Include 
source files” and click [Next>].

Figure 22-2. License Agreement

Figure 22-3. Source File Installation Options
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A dialog displays asking the user to specify the folder to which BlueStart will be installed.  By 
default, BlueStart is installed to C:\Program Files\BlueStart.  Click [Next>] to install to the 
default directory, or click [Browse...] to specify a different location for installation.

Click [Next>] at the "Confirm Installation" dialog to start the installation.

Figure 22-4. Select Installation Folder

Figure 22-5. Confirm Installation
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The progress of the installation is shown in the dialog below.

The dialog shown below displays when the installation is complete. 

Figure 22-6. Installing BlueStart

Figure 22-7. Installation Complete
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22-3 Using the BlueStart Source Files
The following sections of the document explain how to use the source files to adapt and 
rebuild BlueStart as required.

The BlueStart source files are installed to [c:\Program Files\BlueStart\BlueStart Source 
Files].

1. Open [c:\Program Files\BlueStart\BlueStart Source Files].

2. Double-click “BlueStart.vbproj” to open the project in Visual Studio.

3. Double-click “My Project” in the Solution Explorer and select the “References” tab. 

4. Locate the “MT8855” reference in [c:\Program Files\BlueStart].          

Note

Before running BlueStart:

• Connect the MT8855A to a USB port on the PC.

• Turn on the MT8855A.

• Connect an A2DP headset, or similar device, to the line-in sockets on the 
MT8855A.

• Configure the headset to be discoverable by a Bluetooth inquiry.

The operation of BlueStart is intended to be self-explanatory.  There is a 
description of how it was put together in the MT8855 class library help file which 
can be accessed by double-clicking the icon on the desktop.

Note It is assumed that the user has a copy of Visual Studio 2005 (or later) installed.

Figure 22-8. Reference File
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5. Assuming that BlueStart will initially be run with the Visual Studio debugger, ensure 
that Debug mode is selected.

6. Build and execute the project.

The project will not execute correctly (as shown above) because an essential file, 
“UsbDriver.dll”, is not handled automatically by Visual Studio.  This file must now be 
copied into the project manually.

7. Copy the “UsbDriver.dll” from [c:\Program Files\BlueStart] to 
[c:\Program Files\BlueStart\BlueStart Source Files\bin\Debug].

8. Check that the equipment is correctly configured:

• Connect the MT8855A to a USB port on the PC.

• Turn on the MT8855A.

• Connect an A2DP headset, or similar device, to the line-in sockets on the 
MT8855A.

• Configure the headset to be discoverable by a Bluetooth inquiry.

9. Build and run the project.

Note

If BlueStart was installed to a location other than [c:\Program Files], the reference 
to the class library will not be valid and there will be errors in the error list.  In this 
case, remove the reference to MT8855, click “Add…” and create a reference to the 
correct location.

Figure 22-9. Missing Module

Note
If the project is subsequently built in “Release” mode, a release folder is created in 
BlueStart Source Files\bin.  “UsbDriver.dll” must also be copied to that folder.
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When the program is built and executed, it connects to the MT8855A, establishes a 
Bluetooth connection to the DUT and performs measurements.  Typical output is shown 
below.       

Figure 22-10.BlueStart Output

Note
Further information on using the MT8855 class library to control the MT8855A can 
be found in the Help file.
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22-4 Viewing the Help File
The help file, “MT8855A Class Library Help.chm”, is installed in the BlueStart folder.  It can 
be opened by double-clicking the desktop icon or selecting Start > Anritsu > MT8855A Class 
Library Help.  

When viewed on the “Contents” tab, the Help is divided into two sections:

• “Introduction to the MT8855 Class Library”.  

The section is a basic introduction to controlling the test set using the class library.  It 
includes BlueStart programming examples.

• “Anritsu.MMD.MT8855x.TestSet Namespace”.  

This section contains detailed information on the class library.

22-5 Help File Troubleshooting
If the right-side Help frame states that “Navigation to the website was canceled”, the Help 
file content is being blocked.  The most likely reason for this is that the help file was opened 
from a network drive.

Following a security update by Microsoft in 2005 it may not be possible to view the content of 
CHM help files from a network drive.

Figure 22-11.Class Library Help
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Appendix A — Specifications

A-1 MT8855A Specification
     

Parameter Specification

RF

RF connections Type N (f), Impedance 50 Ohms

RF level Support for both cable connections and over-air connections.

Setting 1: Nominally -5 dBm for over-air connections

Setting 2: Nominally -40 dBm for cable connections

Radio RF performance Compliant with requirements of core specification 1.2, 2.0, 2.1 
+EDR for initial frequency, modulation, drift, and sensitivity test 
cases.

System Modes

Bluetooth Audio 
Measurements

Creates a Bluetooth connection to DUT and uses internal audio 
generator and analyzer for measurements

Bluetooth Pass Through Creates a Bluetooth connection to the DUT, external audio source 
and analyzer routed through instrument line input and output.

Analogue Audio 
Measurements

Audio measurements using internal audio generator and analyzer 
with no Bluetooth connection.

Profiles

Profiles Headset, Hands-Free (Gateway and Device), A2DP (sink and 
source), AVRCP

For DUTs that do not support HSP, HFP, A2DP profiles, a basic 
SCO/eSCO connection can be established for audio testing.

Supported codecs CVSD, SBC, μ-Law, A-Law

Audio Generators

Audio generators 2 linked for left and right channels

Freq range 20 Hz to 20 kHz

Freq resolution 1 Hz

Freq accuracy 0.1 Hz at 997 Hz. 100 ppm across full frequency range

Line Output 

Line output connectors XLR, one each for left and right (usable for both balanced and 
unbalanced)
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Line output level Voltage range: 1 mV to 2V RMS into 600 Ohms or greater

Plus tone off mode

Line output resolution 1mV

Line output level 
accuracy

±0.1 dB at 997 Hz into 600 Ohms or greater for voltage range 100 
mV to 2V

±0.5 dB at 997 Hz into 600 Ohms or greater for voltages <100 mV

Line output flatness ±0.5 dB at 20 Hz to 20 kHz relative to 997 Hz for voltage range 100 
mV to 2V

±1 dB from 20 Hz to 20 kHz relative to 997 Hz for voltages <100 mV 

Line output distortion ≤-87 dB THD+N at 997 Hz at 200 mV to 2V output into 600 Ohm 
load

Output impedance Impedance: <120 Ohm

Speaker Output

Speaker output 
connector

4 mm socket left and right outputs

Speaker output level 2 x 1 Watt into 8 Ohm

Suitable for speakers with impedance in range 4 Ohm to 32 Ohm

Speaker output 
resolution

10 mV

Speaker output 
accuracy

±0.2dB at 997 Hz into 8 Ohms, 100 uW to 1 W

Speaker output flatness ±1.0 dB from 20 Hz to 20 kHz at 100 mW relative to 997 Hz

Speaker output 
distortion

<-50 dB THD+N at 997 Hz at 100 mW

Speaker output 
impedance

<1 Ohm (nominal value 0.1 Ohm at room temperature)

Audio Analyzer

Audio analyzer For left and right channels

Freq range 20 Hz to 20 kHz

Line Input

Line input connection BNC

Impedance: 100k Ohms

Input level: 10 mV to 4 V

Measurement resolution: 1 mV
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Measurements for line 
input

Level:

Input levels 20 mV to 4 V:

±0.5 dB over 20 Hz to 20 kHz

±0.1 dB at 997 Hz

Input levels 10 mV to 19 mV:

±1 dB over 20 Hz to 20 kHz

±0.2dB at 997 Hz

THD+N:

Input level 1 V at 997 Hz:

±0.5 dB over range -80 dB to -20 dB

Input levels 100 mV to 4 V at 997 Hz:

±1.0 dB over range -80 dB to -20 dB

THD:

Input levels 100 mV to 4 V at 997 Hz:

±0.5 dB over range -80 dB to -20 dB

Stereo Separation:

±1.0 dB at input level 1 V at 997 Hz over dynamic range of 80 dB

Stereo Phase:

Mic input -90 to +270 ±1 degree ±1 sample at 997 Hz for input of 
10 mV or greater, with signal to noise ratio of 30 dB or greater

Microphone Input

Microphone input 
connection

XLR

Impedance: 2k Ohms nominal

Input level: 1 mV to 200 mV

Measurement resolution: 0.1 mV

Balanced

Internal 48 V phantom power supply for accessory microphone. 

Compliant with EN61938: 1997.
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Measurements for 
microphone input

Level accuracy: 

Input levels 10 mV to 200 mV:

±0.2dB at 997 Hz

±0.5 dB, 100 Hz to 20 kHz

-3 dB at 20 Hz

Level accuracy: 

Input levels 2mV to 9.9 mV:

±0.5 dB at 997 Hz

±1 dB, 100 Hz to 20 kHz

-3 dB at 20 Hz

THD+N:

For input levels 10 mV to 100 mV: 

±0.5 dB, -65 dB to -20 dB

THD:

For input levels 10 mV to 100 mV:

±0.5 dB, -65 dB to -20 dB

Stereo Separation:

Accuracy: Å}1 dB at input level 10 mV at 997 Hz and 20 kHz over 
dynamic range of 60 dB

Stereo Phase:

Mic input -90 to +270 ±1 degree ±1 sample at 997 Hz for input of 
10 mV or greater, having signal to noise ratio of 30 dB or greater

Other Audio Outputs

Built-in speakers 2 integrated speakers

Headphone connector 3.5 mm stereo output for connection of standard headphones. 
Connection of a headset automatically mutes the internal speakers.

Bluetooth Digital Output Level

Level of sinusoidal test 
signal relative to 
maximum peak 
sinusoid

0 dBFS to -40 dBFS
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BlueAudio PC Application

BlueAudio 
software

PC GUI application in VB.NET.

Configures MT8855A hardware and displays results graphically and 
numerically.

BlueAudio contains a Manual Mode in which individual tests are configured 
and run, and an Auto Test mode in which a test plan is generated and 
executed, with results automatically displayed in a report and saved to a 
database.

BlueAudio 
display windows

Measurement control:

Bluetooth profile

Bluetooth connection

Input/Output configuration

Measurement configuration

Results:

Left / Right channel results displayed simultaneously.

Numeric

Level (5 frequency level measurements)

THD+N 

THD (up to max 20 harmonics for 1 kHz tone, or less)

SINAD

Stereo separation

Stereo phase

PESQ/MOS (requires option)

Graphical

Freq response

FFT

THD+N vs level

THD+N vs Freq

PC requirements The BlueAudio application runs on Windows XP and Vista operating 
systems. The application supports English, Chinese, Japanese operating 
systems.

BlueAudio runs through a USB connection to the MT8855A.
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PESQ and MOS option

Option -032 
PESQ/MOS

Performs PESQ (Perceptual Evaluation of Speech Quality) and MOS 
(Mean Opinion Score) measurements on reference audio signals.

Reference audio signals can be user created, downloaded from the ITU 
website, or MT8855A-033 ASTS files.

PESQ/MOS measurements are supported on HSP/HFP and SCO/eSCO 
connections.

Anritsu license the PESQ measurement algorithm from Psytechnics 
Limited.  The PESQ measurement is fully compliant with ITU-T P.862.

Option -033 
ASTS reference 
audio signals

Artificial Speech-like Test Signal (ASTS) are audio files that have been 
specially formulated for use in PESQ measurements.  They contain a full 
range of British English and American English phonetic sounds in ten 
second files.  Male and female voices supplied.

User programming interface

API interface to 
MT8855A class 
library

Documentation and programming examples that explain how to use the 
MT8855A Class Library to create user test programs.

BlueStart A sample open source program developed in Visual Basic 2005 with 
comprehensive comments.

General

General Power supply: 85 to 264 V AC

Frequency: 47 to 63 Hz

Power: 50 Watt max, 25 Watt typical

Dimensions: W:230 mm, H:110 mm, D:387 mm

Weight: 3.5 Kg

Operating temperature range: +5° C to +40° C

Operating humidity: <75% non condensing

Safety: Complies with BS EN 61010-1 (Equivalent to IEC 61010-1).

EMC: Conforms to the protection requirements of EEC Council Directive 
EN61326: 2006.
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Appendix B — Default Values

B-1 MT8855A Default Values 

Table B-1. Audio Test Set Status Monitoring

DESCRIPTION RANGE DEFAULT

Analogue Audio Input Type Microphone | Line In Microphone

Phantom Power Supply State On | Off Off

Analogue Audio Input Ranging 
Type

Auto | Manual Auto

Analogue Audio Input Range 1 to 8 8

Analogue Audio Output Type Speaker | Line out | Off Speaker

’Line out’ Output Level 1 mV to 2 V RMS 1 V

Tx Bluetooth Signal Level Over air | Cable connection Over air

Internal Monitor Volume 
(Audio Input)

0 to 100 30

Internal Monitor Volume 
(Audio Output)

0 to 100 30

Internal Monitor Volume 
(Bluetooth)

0 to 100 30

Audio Test Set LCD Contrast 1 to 10 5

Table B-2. Bluetooth Protocol and DUT Configuration

DESCRIPTION RANGE DEFAULT

DUT Address Source Manual | Inquiry | Inquiry + 
name

Inquiry

Max. Inquiry Responses 1 to 10 1

Inquiry Timeout 5 to 60 seconds 20 seconds

Inquiry Filter All | Audio / Video | Telephony All

Profile A2DP | HSP | HFP A2DP

A2DP Role Source | Sink Source

A2DP Sample Rate 48 kHz | 44.1 kHz 44.1 kHz

HSP/HFP Role Audio gateway | Hands-Free 
Unit

Audio gateway

Use Default SCO Values Yes | No Yes

SCO Connection Type SCO | eSCO SCO
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Packet Type HV1 | HV2 | HV3 | EV3 | EV4 | 
EV5 | 2EV3 | 2EV5 | 3EV3 | 
3EV5

HV3

Voice Setting CVSD | µ-Law | A-Law CVSD

DUT Test Item Microphone | Speaker Speaker

Audio Test Set Function Generator | Analyser Generator

Pairing PIN Length 1 to 16 4

Pairing PIN [0-9]|[A-Z] for each character 0000

Pairing State Paired | Unpaired Unpaired

Paging Timeout Default values used 5 seconds

Connection Timeout Default values used 20 seconds

Test Set Initiates Yes | No No

Table B-3. Exporting Results

DESCRIPTION RANGE DEFAULT

Export Format CSV | XML CSV

Date Filter State On | Off Off

Start Date 01/01/08 to current date Start of current month

End Date 01/01/08 to current date Current date

DUT Bluetooth Address Filter 
State

On | Off Off

DUT Bluetooth Address Valid Bluetooth address 0x000000000000

Audio Test Set Bluetooth 
Address Filter State

On | Off Off

Audio Test Set Bluetooth 
Address

Valid Bluetooth address 0x000000000000

Audio Test Set Serial Number 
Filter State

On | Off Off

Pass/Fail Filter State On | Off Off

Pass/Fail Value Pass | Fail Fail

Table B-4. Test Set Configuration

DESCRIPTION RANGE DEFAULT

Analogue Audio Input Type Microphone | Line In Microphone

Table B-2. Bluetooth Protocol and DUT Configuration

DESCRIPTION RANGE DEFAULT



MT8855A Default Values

MT8855A Operation Manual PN: 13000-00280  Rev. D B-3

Phantom Power Supply State On | Off Off

System Mode Bluetooth audio | Pass 
Through | Analogue audio

Bluetooth audio

Analogue Audio Input Ranging 
Type

Auto | Manual Auto

Analogue Audio Input Range 1 to 9 9

Analogue Audio Output Type Speaker | Line out Speaker

‘Speaker’ Output Level 0 to 2.83 V 1 V

‘Line out’ Output Level 1 mV to 2 V RMS 1 V

Tx Bluetooth Signal Level Over air | Cable connection Over air

Internal Monitor Source Off | Audio In | Audio Out | Rx 
Bluetooth | Tx Bluetooth

Off

LCD Contrast 1 to 10 5

Table B-5. Bluetooth System

DESCRIPTION RANGE DEFAULT

Connected Device Address Valid Bluetooth address 0x000000000000

Connected Device Friendly 
Name

20 characters N/A

Inquiry Address ‘n’

(n = 1 to 10) Valid Bluetooth address N/A

Inquiry Friendly Name ‘n’

(n = 1 to 10) 20 characters N/A

Inquiry Filter All | Audio & Telephony All

Pairing PIN [0-9]|[A-Z] for each character 0000

Connection Timeout 2 to 30 seconds 20 seconds

A2DP Profile Supported Yes | No Yes

HSP Profile Supported Yes | No Yes

HFP Profile Supported Yes | No Yes

Profile A2DP | HSP | HFP A2DP

A2DP Role Source | Sink Source

A2DP Sample Rate 48 kHz | 44.1 kHz 44.1 kHz

HSP/HFP Role Audio gateway | Device Audio gateway

SCO Connection Type SCO | eSCO | Any Any

DUT Test Item Microphone | Speaker Speaker

Table B-4. Test Set Configuration

DESCRIPTION RANGE DEFAULT
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Appendix C — MT8855A LCD 
Messages

C-1 MT8855A Messages 

Table C-1. LCD Messages

LCD Message Description

Analogue Audio Displayed when “System Mode” is set to “Analogue Audio”.

Anritsu MT8855A Audio 
Test Set

Displayed when the MT8855A does not have a USB connection 
to a PC.

Anritsu MT8855A M.mm Displayed after self test message.  Indicates the version of the 
firmware installed in the MT8855A.

Answer The Call The MT8855A has sent a RING command to the DUT. The call 
must be answered on the DUT.

Bluetooth Audio Displayed when “System Mode” is set to “Bluetooth Audio”.

Bluetooth Pass Through Displayed when “System Mode” is set to “Bluetooth Pass 
Through”.

Call Answered The DUT has answered the call from the MT8855A.

Connected The MT8855A has successfully connected to the DUT.

Connecting The MT8855A is currently trying to connect to the DUT.

Connection Failed 
Authentication

The attempt to connect to the DUT failed due to an authentication 
error.  Conform that the Passkey Length and Passkey are set 
correctly in BlueAudio.

Connection Failed Page 
Timeout

The attempt to connect to the DUT failed due to a page timeout.  
Confirm that the DUT is in range, confirm that it is configured to 
accept connections, and confirm that the MT8855A RF 
connection path is set to Cable Connection or Over Air as 
appropriate for the test method. 

Connection Failed 
Unsupported Air Code

The attempt to connect to the DUT failed due to the DUT not 
supporting the air code being used by the MT8855A.  If using the 
HSP or HFP, check that the Voice Settings selected in [Bluetooth 
Profile] > [Advanced Configuration] match the requirements of 
the DUT.

Connection Failed 
Unsupported Pkt Type

The attempt to connect to the DUT failed due to the DUT not 
supporting the packet type being used by the MT8855A.  If using 
the HSP or HFP, check that the settings in the [Bluetooth Profile], 
“SCO Connections” frame are supported by the DUT.

Connection Failed 
Unsupported Profile

The attempt to connect to the DUT failed due to the DUT not 
supporting the profile being used by the MT8855A.  Check that 
the Profile and MT8855A Role are set correctly.
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Connection Timeout The Bluetooth connection has been lost as no communication 
has been received from the DUT within the timeout period.

Disconnected The disconnection attempt has been successfully completed.

Disconnecting The MT8855A is attempting to break the Bluetooth connection 
with the DUT.

Disconnection Failed 
Timeout

The disconnection attempt did not succeed within the specified 
time.

Encryption Not Accepted The encryption request from the MT8855A was rejected by the 
DUT. 

Host Timeout The DUT has not responded to a connection request.

Inquiry Cancelled The Bluetooth inquiry was cancelled by the user.

Inquiry Complete The MT8855A has completed the Bluetooth inquiry.

Inquiry in Progress The MT8855A is performing a Bluetooth inquiry.

Inquiry Timeout The Bluetooth inquiry timed out without finding a device.

Measuring The MT8855A is currently performing measurements.

Name Discovery Complete The MT8855A has finished retrieving the Bluetooth friendly 
names.

Name Discovery In 
Progress

The MT8855A is retrieving the friendly names of the devices 
found during the Bluetooth inquiry.

Output Load Low The device attached to the MT8855A’s line output has an 
impedance of less than 600 Ohms.

Output Unlevelled The signal being output from the MT8855A’s line or speaker 
outputs is unlevelled.

Self Test – Fail XXXXXXX Initial message displayed after power on, indicating that the 
MT8855A has failed one or more of the power on self tests.  ‘X’ 
can either be ‘P’ – pass, or ‘F’ – fail.

The order of the tests are (from left to right):

Checksum not set in the flash memory

Main application code cannot be found

Flash memory failed its checksum test

RAM read/write failure

RAM read/write failure

LCD read/write failure

LCD read/write failure.

Self Test – Pass Initial message displayed after power on, indicating that the 
MT8855A has passed the power on self tests.

Unsupported Features The MT8855A has attempted to use a feature that the DUT 
cannot support.

Table C-1. LCD Messages

LCD Message Description
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Update Complete 
Restarting Test Set

The MT8855A’s firmware has been successfully updated and the 
MT8855A is about to restart itself.

Updating Firmware The MT8855A’s firmware is currently being updated.

USB Connected The MT8855A has been connected to a PC via the USB.

USB Disconnected The USB connection to the PC has been removed.

USB Error Command Rx An error was detected in the data received from the PC.

USB Error Command Tx An error was detected when attempting to send data to the PC.

USB Error Event Tx An error was detected when attempting to send data to the PC.

Table C-1. LCD Messages

LCD Message Description
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Appendix D — Packet Types

The achievable audio performance of the device is not affected by the packet type. The 
selection between different packet types, and between SCO and eSCO, is determined by the 
link Master and based upon the capabilities of the device and upon the demands on the 
Bluetooth piconet for data bandwidth.  For example, a PC may be connected to a Bluetooth 
headset, phone, and printer at the same time. The bandwidth available for a Handsfree 
connection to the headset may be limited if the PC is also sending a large file to the printer at 
the same time.  A simple SCO connection does not implement retries if a packet is lost or not 
Acknowledged.  An eSCO connection does attempt retries if a packet is lost, and this can 
result in better audio quality, typically audible as fewer "clicks".

Where the RF link quality is good between two Bluetooth devices, and the FER is zero or close 
to zero, the audio performance is determined by other aspects of the Bluetooth specification 
such as codec selection and sampling rates.

Table D-1. Packet Type Definitions

User payload 
(bytes) FEC CRC SCO / eSCO

EDR 
compatible

HV1 10 1/3 No SCO NO

HV2 20 2/3 No SCO NO

HV3 30 No No SCO NO

EV3 1-30 No Yes eSCO NO

EV4 1-120 2/3 Yes eSCO NO

EV5 1-180 No Yes eSCO NO

2EV3 1-60 No Yes eSCO YES

3EV3 1-90 No Yes eSCO YES

2EV5 1-360 No Yes eSCO YES

3EV5 1-540 No Yes eSCO YES
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Appendix E — Rack Mounting
The MT8855A can be ordered with rack mounting hardware that allows it to be mounted into 
a standard 48 cm equipment rack.  There are two rack mount option kits available:

The MT8855A-001 Rack Mount option allows the installation of a single MT8855A in either 
the left or right side rack position.

The MT8855A-003 Rack Mount option allows side-by-side mounting of two MT8855A test 
sets.

E-1 Single Unit Rack Mounting (Option MT8855A-001)
This section describes the assembly procedure for fitting a single MT8855A into an 
instrument rack.  The MT8855A universal top and bottom covers have removable feet to 
allow the rack mount kit to be fitted.  The procedure involves fitting a support bracket, front 
plate, base panel, and a rear support bracket to the MT8855A.  The MT8855A can then be 
loaded and secured in the rack position.

Tools Required 

• 1 small Phillips screwdriver

• 1 large Phillips screwdriver

• 1 small Phillips torque screwdriver 10 cNm to 120 cNm.

• 1 torque socket driver 6 cNm to 406 cNm.

Assembly Procedure

1. Remove the four plastic feet from the front of the MT8855A.

2. Remove the four plastic feet from the rear of the MT8855A.  When the feet have been 
removed, re-insert the four screws removed from the rear panel and torque them to 8 

Table E-1. Parts List

Anritsu No. Description Quantity

50077 Front face plate 1

900-848 M4, kep nut 2

790-319 Speed nut 4

900-821 Decorative screw 4

3-788-575 Snap rivet, plastic 6

C37276 Rack mount, side, bracket 1

C41449 Rear support, bracket, rack 
mount

1

D41473 Rack mount, support bracket 1

49361 Bracket support, base panel 1

1-2796931 Screw, 4NPS18S7 + SW+ WB 8
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in-lbs (90 cNm).  Refitting the rear panel screws in this manner provides extra strength 
to the outer casing.

3. Lay the large support bracket D41473 next to the MT8855A as per the assembly 
drawing.  If the MT8855A is to be mounted on the left side of the rack, lay the bracket 
on the MT8855A's right side to show a mirror image of the assembly drawing.

4. Install the support bracket onto the MT8855A with 4 screws 1-2796931.  Leave the two 
rear screws loose to allow alignment and securing of the 6 base plate snap rivets 3-788-
575.  Torque the two front screws to 4in-lbs (45cNm).

5. Install the front rack mounting bracket C37276 at the front of the MT8855A on the 
other side of the large support bracket with two screws 1-2796931.  Torque the screws 
to 4in-lbs (45cNm).

6. Install the rear rack bracket C41449 at the back of the MT8855A on the other side to the 
large support bracket with two screws 1-2796931.  Torque the screws to 4in-lbs 
(45cNm).

7. Install the front face plate 50077 with 2 kep nuts 900-848.  Torque the nuts to 14in-lbs 
(158cNm).

8. Position the base panel 49361 as shown in the drawing, and secure with 6 snap rivets 
3-788-575.

9. Torque the two rear screws installed in step 3 to 4in-lbs (45cNm).

10. Install the four speed nuts 790-319 to the rack in the correct place to allow mounting of 
the MT8855A into the rack.

11. Slide the MT8855A into the rack and secure with 4 decorative screws 900-821.
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Figure E-1. Single Unit Rack Mounting

Fit completed
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as shown.
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kep nut
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Press down centre pin
using a flat edge

D41473
support
bracket

49361
base
panel

905-2674P (x8)

900-345 (x8)

C41449
rackmount
bracket (rear
support)

C37276 rackmount side bracket

50077 front face plate
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E-2 Side-by-Side Rack Mounting (Option MT8855A-003)
This section describes the assembly procedure for fitting two MT8855A units into a 
instrument rack.  The universal top and bottom covers have removable feet to allow the rack 
mount kit to be fitted.  The procedure involves fitting support brackets and two rear support 
brackets, one on each unit.  Once locked together, the two MT8855As can then be loaded and 
secured into the rack.

Tools Required

• 1 small Phillips screwdriver

• 1 large Phillips screwdriver

• 1 small Phillips torque screwdriver 10 cNm to 120 cNm.

• 1 foot removal tool (supplied).

Assembly Procedure 

1. Remove the four plastic feet from the front of both units.

2. Remove the four plastic feet from the rear of both units.  When the feet have been 
removed, re-insert the screws removed from the rear panel (four on each unit) and 

Table E-2. Parts List

Anritsu No Description Quantity

790-319 Speed nut 4

1-2796931 Screw, 4NPS18S7 + SW + 
WB

16

900-821 Decorative screw 4

3-905-2640P M3X6, POS, SST, Patchlock, 
screw, metric, FLT HD

4

49415 Rack mount side bracket 1

49413 Rack mount center rear 
bracket

1

C37275 Rack mount center, front 
bracket

1

C37276 Rack mount side bracket 1

C37277 Rack mount center, bracket 1

C37279 Rack mount center, bracket 1

C41449 Rear support, bracket 
rackmount 

2

50210 Foot removal tool 1

3-905-2674P M3 X 8, POS, SST, patchlock, 
screw, metric, PAN HD

8

900-345 Washer, 6-32UNC, oversize 8
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torque them to 8 in-lbs (90 cNm).  Refitting the rear panel screws in this manner 
provides extra strength to the outer casing.

3. On the two sides of the MT8855A to be joined together, fit the two rear brackets 49413, 
C37279, and two front brackets C37275, C37277 using 8 screws 1-2796931.  Torque the 
screws to 4in-lbs (45cNm).

4. Slide the two MT8855As together and secure using 4 counter sink screws 3-905-2640P.

5. Install the two front rack brackets C37276 and 49415 at the front of each of MT8855A, 
one on each side with four screws 1-2796931.  Torque the screws to 4in-lbs (45cNm).

6. Install the two rear rack brackets C41449 at the back of each MT8855A, one on each 
side with four screws 1-2796931.  Torque the screws to 4in-lbs (45cNm).

7. Fit the four speed nuts 790-319 to the rack in the correct place to allow mounting of the 
two MT8855As in the rack.

8. Slide the two MT8855As into the rack and secure with 4 decorative screws 900-821.

Figure E-2. Side by Side Rack Mounting
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to support
second
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rackmount
bracket rear
support.  Use
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ML2400x or
MT8852B

C37276
rackmount
side bracket

49415 rackmount side bracket
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support second instrument

49439 (x2)
spacer plate.
May be required
to support
second
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Fit complete assembly to rack
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speed nut 790-319, x4 in four
corner positions as shown
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905-69 (x4)
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bracket (centre
inner front)
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Appendix F — Terminology Glossary
Table F-1. Commonly Used Acronyms and Terminology

Term Meaning

A2DP Advanced Audio Distribution Profile

API Application Programming Interface

AVRCP Audio Visual Remote Control Profile

BlueAudio PC application providing the user interface for Mozart

CRC Cyclical Redundancy Check

CSV Comma Separated Variables

dBFS dB Full Scale

DUT Device Under Test

eSCO Bluetooth extended Synchronous Connection Oriented (logical transport)

FEC Forward Error Correction

FFT Fast Fourier Transform

HFP Bluetooth Hands-Free profile

HSP Bluetooth Headset profile

HTML Hyper Text Mark-up Language

MOS Mean Opinion Score

PESQ Perceptual Evaluation of Speech Quality 

PIN Personal Identification Number

RMS Root Mean Square

SCO Bluetooth Synchronous Connection Oriented (logical transport)

SIG Bluetooth Special Interest Group

SINAD Signal-to-Noise and Distortion

THD Total Harmonic Distortion

THD+N Total Harmonic Distortion plus Noise

XML Extensible Mark-up Language
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Appendix G — Connector Care and 
Handling
Follow the precautions listed below when handling or connecting cables. Complying with 
these precautions will guarantee longer component life and less equipment down time due to 
connector or device failure. 

G-1 Pin Depth Mating Connectors
Destructive pin depth of mating connectors is the major cause of failure in the field. When an 
RF component is mated with a connector having a destructive pin depth, damage will usually 
occur to the RF component connector. A destructive pin depth is one that is too long in respect 
to the reference plane of the connector (see figure below).

Figure G-1. N Connector Pin Depth Definition
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The center pin of a precision RF component connector has a precision tolerance. The mating 
connectors of various RF components may not be precision types. Consequently, the center 
pins of these devices may not have the proper pin depth.  The pin depth of DUT connectors 
should be measured to assure compatibility before attempting to mate them with Power 
Sensor connectors. An Anritsu Pin Depth Gaugeor equivalent can be used for this purpose.

If the measured connector is out of tolerance in the "+" region, the center pin is too long (see 
Allowable DUT connector pin depth table below). Mating under this condition will likely 
damage the precision RF component connector. If the test device connector measures out of 
tolerance in the "-" region, the center pin is too short. This should not cause damage, but it 
will result in a poor connection and a consequent degradation in performance.

G-2 Torquing Connectors
Over torquing connectors is destructive; it may damage the connector center pin. Finger-tight 
is usually sufficient for Type N connectors. Always use a connector torque wrench (8 inch-
pounds) when tightening WSMA, K or V type connectors. Never use pliers to tighten 
connectors.

G-3 Mechanical Shock
Precision connectors are designed to withstand years of normal bench handling. However, do 
not drop or otherwise treat them roughly. Mechanical shock will significantly reduce their 
service life.

Figure G-2. Pin Depth Gauge

DUT Connector Type
Anritsu Gauging Set 
Model Pin Depth (inches)

Pin Depth Gauge 
Reading

N - Male

N - Female

01-163 207 -0.000

    +0.030

207 +0.000

    -0.030

WSMA - Male

WSMA - Female 01-162 -0.000

-0.010

Same as pin depth

3.5 mm - Male

3.5 mm - Female
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G-4 Cleaning Connectors
The precise geometry that makes possible the RF component's high performance can easily be 
disturbed by dirt and other contamination adhering to the connector interfaces. When not in 
use, keep the connectors covered.

To clean the connector interfaces, use a clean cotton swab that has been dampened with 
denatured alcohol. 

The following are some important tips on cleaning connectors:

• Use only denatured alcohol as a cleaning solvent

• Do not use excessive amounts of alcohol as prolonged drying of the connector may be 
required

• Never put lateral pressure on the center pin of the connector

• If installed, do not disturb the Teflon washer on the center conductor pin

• Verify that no cotton or other foreign material remains in the connector after cleaning 
it

• If available, use compressed air to remove foreign particles and to dry the connector

• After cleaning, verify that the center pin has not been bent or damaged. 

Note

Most cotton swabs are too large to fit in the smaller connector types. In these 
cases, it is necessary to peel off most of the cotton and then twist the remaining 
cotton tight. Be sure that the remaining cotton does not get stuck in the connector. 
Cotton swabs of the appropriate size can be purchased through a medical 
laboratory-type supply center.
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Appendix H — PC Regional Settings
The BlueAudio software is designed to operate on Windows XP or Windows Vista (32-bit) in 
an English, Japanese, or Chinese language environment.  Performance cannot be guaranteed 
when installed on any other system.   

Operation difficulties may be experienced if BlueAudio is operated on a PC running in a 
language environment, such as Swedish and German, where a comma is used as the decimal 
symbol (e.g., 3,6), instead of a point (e.g., 3.6).

Follow the appropriate procedure below to change the decimal symbol to a point (.).

H-1 Windows XP
1. Open the [Control Panel] from the Windows [Start] menu.

2. Open [Regional and Language Options].

3. Click the [Customize...] button.

4. Select the point (.) setting from the "Decimal Symbol" drop-down field.

H-2 Windows Vista
1. Open the [Control Panel] from the Windows [Start] menu.

2. Open [Regional and Language Options].

3. Click the [Formats] tab.

4. Click [Customize this format...].

5. Click the [Numbers] tab.

6. Select the point (.) setting from the "Decimal symbol" drop-down field. 
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